
 

МИНИСТЕРСТВО ОБРАЗОВАНИЯ И НАУКИ УКРАИНЫ 

Харьковский национальный автомобильно-дорожный университет  

 

 

В.Г. Солодов 

 

 

ПРИМЕНЕНИЕ ПАКЕТА ПРИКЛАДНЫХ ПРОГРАММ ANSYS  

ДЛЯ РЕШЕНИЯ ЗАДАЧ ГИДРОГАЗОДИНАМИКИ  

 

 

 

 

 

Учебное пособие 

 

 

 

 

 

 

Харьков 2017 



2 

 

УДК 551.551.21.5  

ББК 32.844-04 

С60 

УТВЕРДЖЕНО 

Ученым советом Харковского национального автомобильно-дорожного 

университета (протокол №12 от 27.05.2017 г.) 

 

Рецензенты: 

 

ГАЕВ Е.А. - доктор физико-математических наук, професор, ведущий научный 

сотрудник Института гидромеханики НАН Украины 

ПОДРИГАЛО М.А. - доктор технических наук, профессор, заведующий кафедрой 

«Технология машиностроения и ремонта машин» ХНАДУ  

 

Солодов В.Г.  
С60 Применение пакета прикладных программ ANSYS для решения задач гидро-

газодинамики: учебное пособие / В.Г. Солодов. Харьков: ХНАДУ, 2017.- 168с.  

 

ISBN  

 

Пособие предназначено для начинающего пользователя и посвящено описанию 

применения программного обеспечения ANSYS для расчетов течений в элементах 

гидравлических машин. Для студентов и магистров отрасли знаний «Механічна 

інженерія».  

 

Посібник призначений для початкового користувача і присвячений опису 

застосування програмного забезпечення ANSYS для розрахунків течій в елементах 

гідравлічних машин. Для студентів і магістрів галузі знань «Механічна інженерія».  

 

ISBN         УДК 551.551.21.5  

ББК 32.844-04 

 

© В.Г.Солодов, 2017 

  



3 

 

Предисловие 

 

Данное учебное пособие составлено для обеспечения читаемых курсов для 

студентов и магистров отрасли знаний «Механічна інженерія» специальностей 

«Галузеве машинобудування», «Енергетичне машинобудування», «Прикладна 

механіка», которые освоили основы работы в CAD программах.  

Пособие предназначено для начинающего пользователя и посвящено 

описанию процесса и приемов создания геометрических и сеточных моделей 

исследуемых областей, а также для знакомства с основными и наиболее часто 

используемыми функциями в ANSYS ICEM CFD. Также применительно к солверу 

ANSYS CFX описываются процедуры формирования задания на расчет течения, 

сопровождение расчета и постпроцессинг, который заключается в обработке 

результатов расчетов.  

В Приложениях 1,2 даны примеры построения сеток в трубах, а также пример 

выполнения расчетной работы в ANSYS CFX. В Приложении 3 дано краткое 

описание рабочей среды ANSYS Workbench, актуальное в связи с появлением 

бесплатной студенческой лицензии для работы в этой среде. 

Учебное пособие составлено на основе фирменных учебных пособий Help 

Tutorials ANSYS ICEM CFD (версии 12-17 - ресурсы Интернет), а также с 

использованием некоторых материалов учебных пособий А.М. Молчанова и др., 

«Построение сеток в задачах авиационной и космической техники»[2], В.А. Бруяка и 

др., «Инженерный анализ в ANSYS Workbench» [24].  

Составитель также опирался на собственный многолетний опыт в области 

разработки сеточных генераторов и решателей, а также в области CFD анализа в 

проектах для компаний Украины, Польши, России, США. 

Более полную информацию по построению моделей и решению задач в 

ANSYS CFD можно найти: - Help Tutorial ANSYS ICEM CFD, Help Tutorial 

ANSYS CFX (версии 12-17 - ресурсы Интернет). 
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Основные обозначения и сокращения 
 

PLM - Product Lifecycle Management 

CAM - Computer Aided Manufacturing 

CAD - Computer Aided Design 

CAE  - Computer Aided Engineering 

ЛК - Левая кнопка мыши 

ПК - Правая кнопка мыши 

СК - Средняя кнопка мыши 

ANSYS ICEM CFD - Геометрический и сеточный генератор 

ANSYS CFX-Launcher - Запускатель программного комплекса 

ANSYS CFX-Pre - Препроцессор 

ANSYS CFX-Solver Manager - Решатель (солвер) 

ANSYS CFX-Post - Постпроцессор 

CCL - CFX Command Language 

NSE - Уравнения Навье-Стокса(Navier-Stokes Equations) 

SST - Модель переноса сдвиговых напряжений  

  (Shear Stress Transport) 

LES  - Моделирование крупных вихрей  

  (Large Eddy Simulation) 
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Введение 

Современные информационные технологии развивают направление 

автоматизации жизненного цикла изделий. Подготовка инженера к формализации 

объектов и процессов является необходимым условием информационной поддержки 

изделий. Ведущие фирмы Северной Америки, Европы и Азии стандартизировали 

программное обеспечение промышленного бизнеса на основе технологии PLM 

(Product Lifeсycle Management), которая в настоящее время является одной из 

основных характеристик технотронной эры развития нашей цивилизации. 

Исторически предпосылки к этому процессу появились в аэрокосмической 

промышленности [2].  

Основной идеей технологии PLM является эффективная автоматизация всех 

процессов на протяжении всего жизненного цикла изделия в едином 

информационном пространстве. Данный подход обеспечивает интеграцию 

информационных основ предприятия, включает управление всеми электронными 

данными, информацией и знаниями, созданными на протяжении всего жизненного 

цикла изделия.  

Для реализации данной концепции на разных этапах жизненного цикла 

применяются различные по своим качествам, свойствам, стоимости, 

функциональным характеристикам системы геометрического и имитационного 

моделирования. 

Процессы разработки, подготовки производства, изготовления, маркетинга и 

продажи, эксплуатации и поддержки реализуются в среде однородных 

информационных технологий. Например, на стадиях проектирования и выполнения 

проектно-конструкторских работ разработаны системы твердотельного 

параметрического моделирования. Для проведения численного анализа необходимы 

специальные проблемно-ориентированные приложения с соответствующим 

математическим аппаратом. Для планирования производства созданы симуляторы 

производственных процессов, программное обеспечение для имитационного 

моделирования станков с ЧПУ, роботизированных линий и 3D принтеров. Для задач 

маркетинга используются системы фотореалистической компьютерной графики и 

моделирования виртуальной реальности (рис. 1). 
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Рис. 1. Средства автоматизации жизненного цикла изделий 
 

 

Рис. 2. Конкуренция систем автоматизированного проектирования [2] 
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Таким образом, для достижения тотальной автоматизации всего жизненного 

цикла изделия необходимо наличие полного спектра систем геометрического и 

имитационного моделирования в едином информационном пространстве (рис. 1). 

Для автоматизации этапа проектно-конструкторских работ используются 

CAD/CAM пакеты (Computer Aided Design/Computer Aided Manufacturing). Для 

численного анализа прочности, вибраций, гидро-аэромеханики и т.д., используются 

CAE (Computer Aided Engineering) системы и приложения (рис. 2,3).  

Организация управления жизненным циклом изделия состоит в согласованном 

эффективном функционировании рассмотренных программных компонентов в 

рамках единого программного комплекса. Весь процесс от проектирования изделия 

до его утилизации представляет собой единый взаимосвязанный информационный 

комплекс.  

Мировой рынок систем геометрического моделирования можно условно 

разделить на три уровня: 

- системы высокого уровня (CATIA, NX (Unigraphics и др..) 

- системы среднего уровня, (SolidWorks, Solid Edge и др.) 

- системы нижнего уровня (AutoCAD и др.) 

Данное деление (рис. 2) условно и обусловлено функциональностью и 

стоимостью этих систем. 

Важную роль в информационном сопровождении жизненного цикла играют 

технологии инженерного компьютерного моделирования (технологии CAE). 

CAE — общее название для программ и программных пакетов, 

предназначенных для решения различных инженерных задач: расчётов, анализа и 

симуляции физических процессов (рис. 3,4). Расчётная часть пакетов основана на 

численных методах решения дифференциальных уравнений, и позволяет с высокой 

точностью определять характеристики будущих изделий, оценивать ресурс и 

долговечность деталей и узлов конструкций задолго до натурных испытаний, что 

значительно снижает расходы производителей высокотехнологичной продукции на 

отработку изделий путём замены натурных испытаний численным моделированием. 
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Рис. 3. Взаимодействие систем автоматизированного проектирования 
 

 

Рис. 4. Основания и особенности моделирования физических процессов 
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Каждую из CAE-систем можно охарактеризовать в основном лишь по 

физической природе решаемых задач и точности моделирования процессов.  

Наиболее развитыми продуктами на рынке CAE-систем в настоящее время 

являются: ABAQUS – система прочностного и теплового анализа; Star-CD – система 

расчёта течений от компании CD-Adapco; OpenFOAM – система 

гидродинамического, теплового и прочностного анализа с открытым исходным 

кодом от компании OpenCFD Ltd.; ANSYS – вычислительный комплекс, 

объединяющий все возможные направления инженерного анализа (вычислительная 

гидродинамика, статическая и динамическая прочность, анализ тепловых процессов, 

расчёт электромагнетизма). Владелец и разработчик программного комплекса 

ANSYS – компания Ansys Inc. в настоящее время одна из наиболее крупных и 

быстро развивающихся компаний на рынке CAE-систем.  

Программный комплекс ANSYS сопрягается форматами передачи данных с 

известными CAD-системами: NX (Unigraphics), CATIA, Pro/ENGINEER, 

SolidEdge, SolidWorks, Autodesk Inventor и др.  

Подавляющее большинство современных CAE-систем основывается на 

сеточных методах. Поэтому сеточные генераторы являются неотъемлемой частью 

практически любого серьёзного расчётного пакета.  

Настоящее учебное пособие ставит задачу дать читателю представление о 

теоретических и практических аспектах генерации сеток, познакомить с основными 

аспектами постановки и решения задач CFD-анализа в программном комплексе 

ANSYS CFX.  

Программный комплекс ANSYS CFX распространяется на лицензионной 

основе. С 2015 года компания Ansys Inc. предоставляет бесплатную лицензию на 

использование основных модулей комплекса для студентов и магистров. 
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1. ОБЩИЕ ПОДХОДЫ К ЧИСЛЕННОМУ РЕШЕНИЮ УРАВНЕНИЙ 

МАТЕМАТИЧЕСКОЙ ФИЗИКИ [5] 

В настоящее время с интенсивным развитием компьютерных технологий особое 

значение приобретает математическое моделирование различных физических 

процессов. Многие физические процессы могут быть описаны уравнениями 

математической физики в частных производных. 

Аналитические решения таких уравнений получить не удается в виду 

нелинейности самих уравнений и сложной геометрической конфигурации области, 

для которой данные уравнения интегрируются. Численные методы решения 

уравнений в частных производных довольно хорошо развиты, и на сегодняшний 

день нашли широкое применение в различных областях науки и техники. Численное 

моделирование является неотъемлемой частью процесса проектирования 

летательных аппаратов, турбомашин, двигательных установок, автомобилей и т.д. 

В настоящее время развиты три основных подхода [5] к численному решению 

уравнений в частных производных. Первый из них - Метод Конечных Разностей 

(FDM - Finite Differences Method). Его суть заключается в прямой замене 

производных, входящих в исходные уравнения, их дискретными (разностными) 

аналогами в узлах сетки, на которую разбивается расчётная область. При этом 

законы сохранения массы, количества движения и энергии выполняются для всей 

расчетной области. 

Второй подход - Метод Конечных Объёмов (FVM – Finite Volumes Method). 

Основа метода заключается в том, что расчётная область с помощью сетки 

разбивается на совокупность конечных объёмов. Узлы, в которых ищется решение, 

находятся в центрах этих объёмов. Для каждого объёма должны выполняться законы 

сохранения основных величин. Метод конечных объёмов применяется во многих 

вычислительных гидродинамических CFD (Computational Fluid Dynamics) пакетах, 

таких как Ansys CFX, Ansys Fluent, Star CD, Star CCM+, Flow Vision, Flow3d, 

PHOENICS и др. 

Третий подход к решению – Метод Конечных Элементов (МКЭ или FEM - 

Finite Elements Method). Область, в которой ищется решение дифференциальных 

уравнений, разбивается на конечное количество подобластей (элементов). В каждом 

из элементов подходящим образом выбирается вид аппроксимирующей функции. 
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Вне своего элемента аппроксимирующая функция равна нулю. Значения функций на 

границах элементов (узлах) являются решением задачи.  

 

 

 

Рис. 1.1. Пример конечно-объемной структурированной сетки около цилиндра в 

трубе; вариант слева дает неудовлетворительные результаты [7-8]. 

 

В настоящее время МКЭ нашёл широкое применение для интегрирования 

дифференциальных уравнений в частных производных эллиптического и 

параболического типов, возникающих при решении задач теплопроводности в 

твёрдых телах, а также при расчётах напряженно-деформированного состояния 

твердого тела. МКЭ применяется в отдельных подпрограммах вычислительного 

комплекса ANSYS (Ansys Structural, Ansys Thermal и т.д.), вычислительном 

комплексе Abaqus, вычислительных пакетах Nastran, COSMOS и др. 

Как видно из описаний каждого из методов, все они основаны на 

аппроксимации расчётной области с помощью сеток. Подобная аппроксимация для 

реальных областей, как правило, является сложной задачей, требует привлечения 

специального математического аппарата и вычислительных ресурсов. На рисунках 

1.1, 1.2 показаны примеры мульти-доменных структурированных сеток для задач 

CFD-анализа. Сгущение сеток вблизи твердых границ вызвано существованием 

областей пристенного пограничного слоя вследствие  прилипания потока, в которых 

уравнения гидродинамики меняют тип и требуют специальной аппроксимации. 

Ниже излагаются основные принципы, лежащие в основе сеточной 

аппроксимации расчетной области. Заинтересованных читателей отсылаем к 



14 

 

многочисленным специализированным книгам по численным методам 

математической физики, например [5]. 

 

 

 

Рис. 1.2. Пример фрагмента конечно-объемной мульти-доменной структурированной 

сетки в проточной части переходного диффузора ГТД [10]. 
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 2. ЭЛЕМЕНТЫ ОБЩЕЙ ТЕОРИИ ПОСТРОЕНИЯ СЕТОК [2,3] 

В данном разделе кратко рассматриваются подходы к построению сеток, их 

классификация и критерии качества. 

 

2.1. Регулярные или структурированные сетки 

2.1.1. Общие положения 

Задача построения расчетной сетки заключается в нахождении отображения, 

которое переводит узлы сетки из физической области в вычислительную область. 

Данное отображение должно удовлетворять следующим требованиям: 

- отображение должно быть взаимно однозначным; - сетка должна иметь 

сгущения в областях, где возможно появление больших градиентов решения; 

 - сеточные линии должны быть гладкими для обеспечения непрерывности 

производных и максимально близки к ортогональным; 

 - отношение сторон элемента сетки не должно быть слишком большим. 

Если множество сеточных узлов расчетной сетки является упорядоченным, то 

такая сетка называется регулярной или структурированной (Рис. 2.1).  

 

 

Рис. 2.1. Пример структурированной сетки с отображением в вычислительную 

область [6] 

Использование структурированных сеток (в сравнении с 

неструктурированными сетками) позволяет уменьшить продолжительность расчета 

и необходимый объём оперативной памяти компьютера. В то же время, процедура 

построения криволинейной регулярной сетки в общем случае представляет собой 
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сложную операцию, требующую больших ресурсов в сравнении с процедурой 

построения нерегулярной сетки, и не всегда возможна. Как правило, 

структурированность сеточного описания достигается применением гексагональных 

элементов (гексаэдров), неструктурированные сетки обеспечиваются набором 

тетраэдров, призм, гексаэдров. Кроме того, известен подход к описанию областей на 

основе неструктурированного набора доменов со структурированной сеткой в 

каждом из них [9]. Неструктурированность набора доменов определяется 

пользователем в ручном режиме и требует специализации решателя или солвера. 

Можно также встретить частные случаи структурированного описания расчетной 

области набором тетраэдров (треугольников).  

При выборе способа построения сеток (структурированных или 

неструктурированных) необходимо учитывать следующие факторы.  

1. Гексагональные сетки при одинаковых требуемых ресурсах допускают более 

высокий порядок аппроксимации, чем тетраэдральные сетки (см., например, [5]). 

Поэтому течения с ударными волнами лучше моделируются на гексагональных 

сетках, чем на тетраэдральных сетках.  

2. Программы, использующие структурированные сетки, организованы проще, 

т.к. не требуют хранения и обработки информации о соседних ячейках, ребрах, 

гранях, необходимой при расчете на неструктурированных сетках. 

3. Построение регулярных сеток для тел сложной геометрии является весьма 

трудоемкой задачей и не всегда является возможным; не поддается автоматизации. 

4. Существенным преимуществом неструктурированного подхода является 

гибкая структура сетки, позволяющая эффективно отобразить конфигурацию 

расчетной области, особенно для областей сложной геометрии (рис. 2.2). 

5. Адаптация сетки к геометрии задачи, к решению в случае 

неструктурированного подхода производится сравнительно проще, чем при 

регулярных методах построения сетки. 
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Рис. 2.2. Пример трехмерной неструктурированной сетки вокруг экомобиля в 

плоскости симметрии [19]. 

 

2.2. Построение неструктурированных сеток 

Неструктурированной сеткой называют произвольное разбиение заданной 

области пространства на простые фигуры, такие как параллелограммы, тетраэдры, 

пирамиды, призмы. Неструктурированную сетку можно построить для любой, сколь 

угодно сложной геометрии.  

Структурированная сетка по своей сути описывается математическим 

выражением, которое определяет координаты всех узлов. Неструктурированная 

сетка – это массив данных, содержащий информацию о всех узлах, элементах и 

взаимосвязях между ними. Формат представления этих данных зависит от 

конкретного программного обеспечения, но в целом, в любом файле 

неструктурированной сетки представлены данные, которые условно разделяются на 

три блока: а) массив, в котором последовательно перечисляются координаты всех 

узлов сетки; б) массив, содержащий информацию о типе каждого элемента и 

номерах узлов, входящих в данный элемент; в) массив, с информацией о 

принадлежностях каждого элемента к какой-либо границе, либо внутреннему объёму 

сетки: 

Ниже рассматриваются основные подходы к построению неструктурированных 

сеток. Процесс построения неструктурированных сеток итеративен. Имея некоторую 

начальную сетку, её последовательно сглаживают, пока не будут удовлетворены 

требуемые критерии качества и будет достигнут заданный уровень аппроксимации 

геометрии. 
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2.2.1. Типы элементов и критерии их качества (табл.1) 

Существует многочисленная группа критериев качества сетки. Например, в 

сеточном генераторе ANSYS ICEM CFD их насчитывается более 70. 

Таблица 1. Критерии качества элементов 

 Схема  Критерий качества 

Треугольник   

 

Отношение стороны к 

опущенной на нее высоте, 

нормированное на аналог для 

правильного треугольника -2 / 3  

Четырехугольник  

 

Отношение минимального 

значения детерминанта матрицы 

Якоби, вычисляемого для каждого 

узла элемента к максимальному 

значению (Determinant) 

Тетраэдр   

  

Коэффициент формы (Aspect 

Ratio), вычисляемый, как отношение 

радиусов вписанной и описанной 

вокруг элемента сферы, 

нормированный на 13 (аналог для 

правильного тетраэдра). 

Пирамида  

  

Determinant 

Гексаэдр  
 

  

Determinant 

Призма  
 

 

 

Determinant 
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Как правило, критерии основаны на сравнении анализируемого элемента с 

топологически эквивалентным каноническим элементом: правильным 

треугольником, квадратом, правильным тетраэдром, кубом. Под качеством для 

элементов разного типа можно понимать следующие основные характеристики. 

Детерминант. Как уже упоминалось в предыдущем разделе, для некоторой 

области можно ввести такую систему координат, в которой данная область 

преобразуется к единичному квадрату. 

В ходе решения задач с помощью методов, использующих 

неструктурированные сетки, вводится локальная система координат для каждого 

отдельного элемента сетки. На рисунке 2.3 демонстрируется переход к локальной 

единичной системе координат для четырехугольного элемента. 

 

Рисунок 2.3 Локальные координаты для четырехугольного элемента 
 

 

Рисунок 2.4 Локальные координаты для гексаэдра [6] 
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Координаты ξ  и η можно выразить через координаты x и y и наоборот. Можно 

также вычислить производные типа ,
x

x





 

 
 и т.д. 

Матрица, составленная из этих производных, называется матрицей Якоби или 

якобианом: 

 

Детерминант этой матрицы характеризует площадь элемента S  

 

Детерминант матрицы Якоби используется для определения качества элементов 

сетки. Именно, для определения качества элемента, показанного на рисунке 2.3, 

необходимо вычислить определитель якобиана в узлах 1,2,3,4, выбрать из 

полученных значений минимальное и максимальное и соотнести их. Аналогичным 

образом определяется качество трёхмерных элементов (рис. 2.4). 

Скошенность. Ещё одной важной характеристикой качества элементов сетки 

является скошенность (Skewness). Для произвольного двумерного элемента сетки, 

например, она вычисляется как: 

 
 

где max  – максимальный угол в элементе (см. рис. 2.5); min  – минимальный угол в 

элементе; e  – угол соответствующего правильного многоугольника (для 

треугольного элемента 60o, для четырёхугольного – 90o). 
 
 

 

Рис. 2.5 К определению показателя скошенности 
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Показатель Skew изменяется от 0 до 1. Идеальный элемент, для которого 

показатель скошенности равен 0, является прямоугольником; уменьшение угла min  

приближает параметр Skew к 1. 

 

2.2.2. Триангуляция 

Рассмотрим основные методы получения сетки на начальном этапе построения. 

Остановимся на треугольных и тетраэдральных элементах.  

Различаются следующие основные техники триангуляции: триангуляция 

Делоне; метод квадро- и октодерева; метод движущегося фронта. В настоящее время 

разработаны методы, объединяющие использование указанных приемов 

триангуляции (см. раздел 5).  

Триангуляция Делоне. Основой данного метода является предложенный 

Б.Н.Делоне критерий размещения узлов. Неструктурированная сетка из 

треугольников (тетраэдров) удовлетворяет критерию, если окружность (сфера) 

описанная вокруг любого треугольника (тетраэдра), не содержит внутри других 

узлов сетки, кроме узлов, принадлежащих данному треугольнику (тетраэдру). 

Например, случай на рис 2.6а не удовлетворяет критерию Делоне, на рис 2.6б – 

удовлетворяет. 

а) б)   

Рис. 2.6. Иллюстрация критерия Делоне 

 

В качестве начального шага вначале строят сетку для границы области, затем 

точки на границе используются для построения начальной сетки внутри области, 

далее сетка измельчается путём вставки новых точек и образования новых 

элементов. При этом на каждом шаге проверяется соответствие каждого вновь 

образуемого элемента критерию Делоне.  
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Рис. 2.7 Тетраэдральная сетка вокруг самолета со сгущением в погранслое 

(триангуляция Делоне) 

 

Метод квадро- и октодерева (quadtree/octree). Метод квадро- (двумерный 

случай) и окто- (трёхмерный случай) деревьев подразумевает наложение на область 

равномерной квадратной (в трёхмерном случае – гексагональной) сетки. После чего 

эта сетка обрезается границей области, каждый квадрат (гексаэдр) разделяется на два 

треугольника (несколько тетраэдров) (рис. 2.8). 

 

Рис. 2.8 Построение сетки методом квадродерева [2] 
 

В дальнейшем данная сетка сглаживается и измельчается, если это необходимо. 

В целом метод более успешно справляется со сложными трёхмерными геометриями, 

однако полученная с помощью этого метода сетка не всегда соответствует 

начальным границам области, либо элементы вблизи границы могут оказаться 

ненадлежащего качества. 
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Метод движущегося фронта. Метод движущегося фронта заключается в 

построении сетки последовательно, начиная от границы внутрь области.  

Положительной стороной данного метода является его относительная простота 

и чёткое соблюдение границы области. Однако для некоторых сложных геометрий 

(особенно в трёхмерном случае) данный метод может быть неприменим. 

 

2.2.3. Сеточная аппроксимация в пограничном слое 

В задачах расчёта гидрогазодинамики и теплообмена возникает необходимость 

построения сетки в области пограничного слоя. Требования к такой сетке 

заключается в том, что её ячейки должны сгущаться к стенке слоями, 

ортогональными границе (см. рис. 2.7, 2.9). В двухмерном случае ячейки сетки 

пограничного слоя представляют собой четырёхугольники,  в трёхмерном случае – 

шестигранники и призмы (в зависимости от вида сетки в ядре потока). 

 

Рис. 2.9 Призматическая сетка для пограничного слоя внутри трубы 

 

Метод построения сетки для пограничного слоя заключается в построении 

набора кривых (поверхностей), эквидистантных кривой (поверхности) стенки 

(рис.2.9). 

 



24 

 

 

2.2.4. Сетки, получаемые вытягиванием двумерных сеточных разбиений 
 

Аналогичным методу построения сеток для призматических слоёв, является 

метод построения вытянутых сеток (SweptMesh). В данном методе строится сетка 

для поверхности источника, после чего эта сетка вытягивается вдоль границ тела до 

поверхности-цели (см. рис. .2.10). 

 

Рис. 2.10 Вытянутая сетка [6] 

 

2.2.5.Составные сетки с несогласующимися границами 

Численные алгоритмы решения позволяют решать задачи на сетках, 

составленных из нескольких областей путем интерполяции сеточных параметров на 

стыках. При этом не обязательно, чтобы на границе этих областей узлы сеток 

совпадали. Такой интерфейс применяется для расчёта течений в сложных областях и 

взаимно движущихся областях (например, расчёт течения в турбине [11,15] или 

двигателе внутреннего сгорания) [20,22]. 

 

Рис. 2.11 Пример области с составной сеткой с несовпадающими узлами на границе 

контакта [22] 
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Устройство интерфейсов на внутренних границах областей позволяет также 

строить эффективные гекса-сетки в областях весьма сложной геометрии путем ее 

разбиения на относительно простые домены, в которых сетка строится достаточно 

просто. Например, на рис. 2.12 представлено сеточное описание выхлопного 

патрубка ГТД с 13 стойками разной формы с экспоненциальным сгущением сеток 

вблизи всех твердых стенок [13]. Для успеха описания потребовалось разбиение 

проточной части патрубка на 555 доменов. В дальнейшем к патрубку на 

специальном интерфейсе подключалась группа ступеней [14], и таким образом 

выполнялся расчет течения в проточной части всего двигателя. 

 

 
 

Рис. 2.12 Пример области с составной сеткой с несовпадающими узлами на границе 

контакта [13] 
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3. СЕТОЧНЫЙ ГЕНЕРАТОР ANSYS ICEM CFD 
 

Все развитые продукты на рынке CAE-систем в настоящее время располагают 

развитыми сеточными генераторами. Вычислительный комплекс ANSYS  компании 

Ansys Inc. несколько лет назад приобрел и адаптировал развитый сеточный 

генератор ICEM CFD, который также содержит элементы CAD построителя.  

 

3.1 Знакомство с ICEM CFD  
 

Сеточный генератор ANSYS ICEM CFD, как и весь программный комплекс 

ANSYS, не русифицирован, и использует (и понимает) только латинский алфавит. 

Запуск программы осуществляется из меню «Start» операционной системы 

или при помощи ярлыка, созданного на рабочем столе. Перед запуском программы 

при помощи ярлыка, необходимо кликнуть по нему правой кнопкой мыши (ПК) и в 

выпадающем меню выбрать строку «Open». 

Для запуска программы предварительно в строке «NewFolder» указывается 

рабочая папка и путь к ней. Например, назначим File>D:\Project\Tube. Теперь все 

файлы, созданные в ходе работы над данным проектом, будут сохраняться в папке 

D:\Project\Tube. Нажимаем OK и запускаем программу.  

Для изменения размера иконок набираем команду: Settings>Display и в строке 

SelectIconSize выбираем необходимый размер. Изменение настроек вступит в силу 

после перезапуска программы. Для настройки цвета фона рабочей области задаем 

следующим образом: Settings > Background Style. 

Рекомендуется использовать следующие настройки: Background Style (тип 

заливки) – Solid (сплошная заливка, без переходов), Background Color – серый цвет 

(второй или третий квадрат от белого цвета в палитре цветов). Для небольших 

мониторов невысокого качества более удобна градиентная заливка. 

 

3.2. Вид рабочей области и основные функции 
 

На рисунке 3.1 представлено окно программы с основными 

функциональными и информационными окнами.  
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Основные функции программы размещены в «Меню утилит». Эти команды 

определяют открытие и закрытие файлов, проектов, сохранение файлов, проектов, 

возвращение состояния проекта на шаг назад или вперёд и ряд других функций. 

Более подробно «Меню утилит» обсуждается ниже (как и другие меню и окна). 

Частично команды «Меню утилит» дублируются значками панели «Значки 

утилит». 

На Функциональной панели имеются закладки, соответствующие этапам 

работы с моделью. Основные из них перечисляются ниже:  

Geometry – работа с геометрией;  

Mesh - создание неструктурированной сетки;  

Blocking – создание блочной топологии и структурированной гексагональной сетки 

на ее основе;  

EditMesh – закладка с функциями редактирования неструктурированной сетки;  

Output – закладка с командами для подготовки к экспорту полученной сетки в 

выбранный солвер.  

Другие закладки можно изучить в документации (Help>Documentation for 

ANSYS ICEM CFD>Help Manual). 

Панель Дерево модели показывает, какие модельные элементы имеются в 

данном проекте: Geometry – геометрические элементы; Mesh – элементы 

неструктурированной сетки; Blocking – элементы блочной топологии; Part – набор 

имен доменов (частей), используемых в данном проекте. Если какого-либо 

модельного элемента нет в Дереве модели, то его нет и в проекте. Ветвь дерева - 

Part существует всегда, если есть какой-либо модельный элемент.  

При вызове различных функций с помощью утилит в рамках работы с 

проектом всегда появляется Панель ввода данных. Она содержит значки 

дополнительных функций в рамках данной утилиты, а также меню настройки 

функции, которая активирована. 

Активация той или иной функции вызывает появление подсказки описания 

необходимых действий в рабочем окне в виде полосы текста на чёрном фоне, кратко 

описывающая действия, которые необходимо выполнить, и кнопок, при помощи 

которых этот выбор осуществляется: выбрать тот или иной элемент модели, 

подтвердить выбор, либо отказаться от выбора этого элемента. 
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В правом нижнем углу рабочего окна расположены оси координат, которые 

показывают ориентацию модели в пространстве, а также помогают получить 

проекцию на одну из координатных плоскостей (для этого надо нажать на одну из 

стрелок значка) или изометрию (нажать на сферу в центре значка). 

 

 
 

Рис. 3.1 Рабочее окно ANSYS ICEM CFD 

 

Панель выбора действий в рабочей области возникает при выборе любого 

элемента модели (геометрическая кривая, ребро блочной топологии и т.д.). 
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Используя её, можно установить способ выбора элементов, тип выбираемых 

элементов и т.д. Нажатие на крайнюю левую кнопку Панели (с вопросом) дает 

возможность временного выхода из режима выбора, например, для необходимого 

поворота или смещения модели. 

Окно гистограммы возникает при проверке качества сетки. По оси абсцисс 

откладывается значение параметра, по которому осуществляется проверка. По оси 

ординат – число элементов, обладающих данным качеством.  

В Окне сообщений регистрируются и выводятся в виде текста все действия, 

выполняемые в ходе работы с проектом. 

 

3.3. Работа с клавиатурой  
 

Основным средством ввода информации в программу ICEM CFD является 

манипулятор типа «мышь». С клавиатуры вводятся имена при создании семейств и 

цифровые значения координат, длин, различных коэффициентов и т.д. При помощи 

мыши, помимо вызова и настроек функций, выбираются элементы модели и выбор 

вида отображения модели на экране. Какой-либо элемент модели выбирается 

следующим образом: подводим курсор мыши к выбираемому объекту и нажимаем 

левую кнопку мыши (ЛК), при необходимости отказа от выбора нажимаем правую 

кнопку мыши (ПК). При необходимости подтверждения выбора нажимаем среднее 

колесо (среднюю кнопку) (СК) мыши (аналог команды Apply). Подсказки в виде 

красного текста на черном фоне появляются в Окне возможных действий (низ 

Рабочего окна, рис. 3.1).  

Для управления отображением модели на экране обыкновенно используются 

следующие команды: нажатая левая кнопка мыши (ЛК) – вращение модели; 

вращение колеса – приближение или удаление вида; нажатое колесо мыши – 

параллельный перенос модели; нажатая правая кнопка мыши (ПК) – также 

увеличение/уменьшение вида модели.  

Возможно использование и графического манипулятора, который 

настраивается при помощи встроенного программного обеспечения.  

Кнопки мыши и манипулятора можно также перенастроить в меню 

Settings>Mouse>Bindings/Spaceball. При активировании функции работы с моделью 



30 

 

ее движение требует выхода из выбранной функции. Управление этим процессом 

происходит при нажатии клавиши F9.  

В ICEM CFD часть выполняемых действий привязана к определённым 

клавишам клавиатуры – горячим клавишам (Hotkeys). Эти клавиши позволяют 

ускорить работу, а самое главное – уменьшить число нажатий на кнопки мыши и 

движений кистью руки. Горячие клавиши существуют для вкладок Geometry, Edit 

Mesh, Blocking. Также существуют горячие клавиши, которые являются общими для 

всех вкладок. Более подробно информацию о горячих клавишах можно найти в 

документации (Help>UserManual>Documentation for ANSYS ICEM CFD> 

HelpManual>SelectionOptions>Hotkeys).  

 

3.4. Структура Меню утилит  
 

Меню утилит представлено командами и функциями, объединёнными в 

группы: Файловое Меню (File) – содержит команды открытия, сохранения и 

закрытия проектов, и отдельных элементов (геометрия, сетка, блочная топология) 

проекта. Также в этом меню существуют команды, которые позволяют 

экспортировать и импортировать элементы модели. Часть команд этого меню 

вынесена на панель Значков Утилит. Например:  открытие проекта OpenProject 

, сохранение проекта SaveProject .  

Команды, связанные с открытием, сохранением и закрытием геометрии 

модели, неструктурированной сетки и блочной топологии модели собраны под 

значками в выпадающих меню (чёрный уголок в нижнем правом углу кнопки) 

Некоторые значки выпадающего меню показаны на рисунке 3.2. 

Структура Меню Редактирования (Edit). В нем наиболее часто 

используемые команды – это команды Возврат на шаг назад (Undo) и 

Перемещение на шаг вперёд (Redo); эти команды также удобно вызывать из 

панели Значки утилит . 

Меню Вид модели (View). Основные команды этого меню продублированы на 

панели Значки меню.  
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а) б) в) г) 

Рис. 3.2 Меню работы: с геометрией (а); с неструктурированной сеткой (б); с 

блочной топологией (в); оси координат и перемена направления оси ОХ (г). 

Команды: Fit  (или клавиша X на клавиатуре) – отображает все видимые 

части модели в рабочем окне программы; BoxZoom  (или клавиша Z на 

клавиатуре)  –  увеличивает вид выбранной области обводом выделенной области в 

прямоугольнике. Виды справа (Right) и слева (Left) - команды из меню View 

соответствуют выбору положительного или отрицательного положения (появляется 

при подводе курсора) выбранной оси (рис. 3.2 г – ось ОХ). 

Меню информации Info. Команда MeshInfo – показывает количество 

элементов неструктурированной сеточной модели в Окне сообщений. Меню 

Настроек Settings используется для задания различных установок при работе с 

программой. Команда General задает количество используемых ядер или 

процессоров компьютера (строка Number of Processors). Командой Product можно 

загрузить оформление интерфейса аналогично Workbench или ICEM CFD (раздел 

GUI Style). Команда Display устанавливает размер значков (SelectIconSize). 

Команда BackgroundStyle настраивает цвет и способ заливки фона рабочего 

окна. Команда MouseBindings/Spaceball настраивает функциональные возможности 

кнопок мыши и манипулятора. Команда Model задает точность геометрической 

модели: TopoTolerance – точность построения модели; Tolerance – точность 

описания кривых и поверхностей. Подробно возможности меню можно изучить в 

документации (Help>Documentation for ANSYS ICEM CFD>Help Manual).  

Меню вспомогательной документации (Help) содержит описание всех 

функций программы (UserManual), несколько примеров (TutorialManual), а также 

описание используемой версии продукта (About ICEM CFD).  
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Вход в руководство к программе (Help) по поводу описания конкретной 

функции можно осуществить нажатием кнопки  на Панели ввода данных. 

Кроме этого, при подводе курсора к основным кнопкам появляется ярлык с 

названием данной команды. 

Помимо кнопок, дублирующих команды Меню Утилит, на панели Утилит 

существуют и другие кнопки. Опишем некоторые из них.  

Команда на панели Значков утилит MeasureDistance  – измеряет 

дистанцию между указанными точками. Расстояние выводится в выбранной системе 

единиц в рабочем окне и в Окне сообщений. Рядом с рулеткой в выпадающем меню 

существует также MeasureAngle  – транспортир. 

Значки  объединяют группу команд для вариантов визуализации 

каркаса и геометрии модели. Геометрия модели отображается в виде различных 

вариантов проволочного каркаса (WireFrame…) , либо в виде вариантов 

сплошной заливки поверхностей (Solid…)  . 

 

3.5. Функциональные закладки 
 

Функциональные закладки объединяют ряд функций, необходимых для работы 

с элементами модели. Расположение соответствует порядку работы с моделью: 

вначале выполняются действия с геометрией модели (Geometry), далее создается 

неструктурированная сетка (Mesh), либо создается блочная топология и 

гексагональная предварительная сетка (Blocking). При необходимости полученная 

сетка редактируется для достижения максимального качества (EditMesh). Закладки 

Properties, Constraints, Loads, SolveOptions определяют свойства материалов, 

граничные условия (ограничения, нагрузки) на элементах расчетной области и 

используются в задачах структурного анализа. Экспорт сетки для используемого 

солвера выполняется при помощи команд закладки Output. Перечисленные закладки 

представлены на рисунке 3.3.  
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Рис 3.3 Основные функциональные закладки ANSYS ICEM CFD 

 

Предназначение части функций следует из приведённых ниже примеров, либо 

находится в документации (Help>Documentation for ANSYS ICEM CFD>Help 

Manual) 
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4. ПОСТРОЕНИЕ ГЕОМЕТРИЧЕСКИХ МОДЕЛЕЙ В ANSYS ICEM CFD 

 

Раздел посвящён описанию возможностей и приемов построения 

геометрических моделей, используемых в комплексе ANSYS ICEM CFD, для 

дальнейшего создания сеточных моделей рассчитываемых областей. Целью раздела 

является знакомство с основными и наиболее часто используемыми функциями 3D 

моделирования в ANSYS ICEM CFD. 

 

4.1. Основные функции рабочей области 
 

На Функциональной панели имеются закладки, соответствующие этапам 

работы с моделью. Этап CAD - построение геометрических моделей - 

осуществляется по закладке: Geometry – работа с геометрией. В общем случае 

доступны значки для 13 наборов команд:  

 

На старте создания геометрической модели доступны значки только для первых 5 

наборов команд: 

. 

Под каждым значком при нажатии ЛК на нем появляется панель ввода данных, 

где приведены команды на выбор и отдельно знак вопроса, который при нажатии ЛК 

вызывает помощь (Help) по данному значку. 

Закладка функциональной панели Create Point (рис. 4.1а) содержит команды 

создания точки.  

Первая команда Create Point>ScreenSelect создает точку по выбору на экране 

в рабочей области левой клавишей (ЛК) и подтверждает это средней клавишей (СК).  

Вторая команда Create Point>ExplicitCoordinates создает точку по заданным 

явно декартовым координатам. При неудачном выборе единиц измерения и 

масштаба точки могут исчезать с поля Рабочего окна и их можно возвратить 

командой Fit . 
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Третья команда CreatePoint>BasePoint&Delta создает точку при выборе 

базовой точки по заданным декартовым приращениям координат. При этом для 

геометрии необходимо выбрать единицы измерения командой Settings>Model/Units.  

Четвертая команда Create Point>Center of 3 Points/Arcs строит точку, как  

а) центр окружности, лежащей на 3-х точках (которые необходимо пометить);  

б) центр дуги окружности (которую необходимо пометить).  

Пятая команда Create Point>Based on 2 Locations помещает точку между двух 

точек в соответствии с заданием параметра пропорциональности, либо разбивает 

расстояние между точками на N+1 равных частей.  

Нижняя группа команд закладки задает точки, лежащие на заранее 

построенных кривых и поверхности. Именно: 

Шестая команда Create Point>CurveEnds ставит точку в конце отрезка 

кривой.  

Седьмая команда CreatePoint>CurvesIntersection задает точку пересечения 

кривых.  

Восьмая команда CreatePoint>ParameterAlongCurve ставит точку на кривой в 

зависимости от значения параметра.  

Девятая и десятая команды CreatePoint>ProjectPointToCurve/Surface находят 

проекции точки на кривую и поверхность соответственно. 
 

     

а)                                           б)                                      в) 

Рис. 4.1 Команды для работы с геометрией 
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Закладка функциональной панели Create/ModifyCurve (рис.4.1б) содержит 

набор команд создания кривой.  

Первая команда Create/ModifyCurve>FromPoints строит кривую с помощью 

сплайна по точкам.  

Вторая команда Create/ModifyCurve>Arc строит фрагмент окружности по 

трем точкам.  

Третья команда Create/ModifyCurve>CircleOrArc строит окружность по 

центру и двум точкам.  

Четвертая команда Create/ModifyCurve>SurfaceParameter строит изолинии 

на имеющейся поверхности геометрического тела с применением выбираемого 

параметра.  

Пятая команда Create/ModifyCurve>SurfacesIntersection строит линию на 

пересечении двух поверхностей.  

Шестая команда Create/ModifyCurve>ProjectCurveOnSurface проектирует 

линию на поверхности либо часть.  

Седьмая и восьмая команды Create/ModifyCurve> 

SegmentCurve/ConcatenateCurve сегментируют кривую, либо объединяют кривые.  

Девятая команда семейства Create/ModifyCurve> ExtractCurveFromSurfaces 

выделяет кривую из поверхности.  

Десятая команда Create/ModifyCurve>ModifyCurve меняет направление 

кривой (только для В-сплайна), распространяет кривую до заданной точки или 

кривой, на заданную длину; соединяет кривые разными способами, создает кривую, 

которая соединяет существующие кривые на основе касательных (см. подробнее 

документацию в Help).  

Одиннадцатая команда Create/ModifyCurve>CreateMidline строит среднюю 

кривую между двумя кривыми.  

Двенадцатая команда Create/ModifyCurve>CreateSectionCurves создает 

новые кривые на пересечении выбранных поверхностей одной или несколькими 

плоскостями.  

Закладка функциональной панели Create/ModifySurface (рис.4.1в) содержит 

набор команд создания поверхности.  
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Первая команда Create/ModifySurface>FromCurves создает поверхность по 2-

4 кривым с заданным допуском Tolerance , либо по 4 точкам.  

Вторая команда Create/ModifySurface>CurveDriven создает поверхность 

протягиванием одной или более кривых CurveDriven вдоль образующей кривой 

Curve Driving.  

Третья команда Create/ModifySurface>SweepSurface создает поверхность 

вытягиванием заданной кривой вдоль вектора (или Curve Driving).  

Четвертая команда Create/ModifySurface>SurfaceOfRevolution создает 

поверхность вращения по заданной оси и диапазону углов.  

Пятая команда Create/ModifySurface>LoftSurface создает поверхность, 

интерполируя ее по двум или нескольким кривым.  

Шестая команда Create/ModifySurface>OffsetSurface создает новую 

поверхность смещением или переносом исходной поверхности через задание 

дистанции.  

Седьмая команда Create/ModifySurface>MidSurface создает срединную 

поверхность между двумя исходными поверхностями, в общем случае 

принадлежащим двум различным частям (детали см. Help).  

Восьмая команда Create/ModifySurface>Segment/TrimSurface позволяет 

сегментировать выделенную поверхность В-сплайн кривой, лежащей на поверхности 

четырьмя разными способами (детали см. Help).  

Девятая команда Merge/ReapproximateSurfaces позволяет слить две 

поверхности по их шву, переаппроксимировать поверхности (ограниченные 

кривыми, телами).  

Десятая команда UntrimSurface убирает любую предыдущую сегментацию 

выбранной поверхности.  

Одиннадцатая команда Create/ModifySurface>CreateCurtainSurface создает 

поверхность, вытянутую из выбранной кривой и спроецированную на избранную 

поверхность по нормали к ней.  

Двенадцатая команда Create/ModifySurface>ExtendSurface позволяет 

расширять поверхность различными способами (детали см. Help).  
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Тринадцатая команда Create/ModifySurface>GeometrySimplification создает 

набор фасеточных поверхностей, обернутых вокруг выбранной геометрии, которая 

сохраняется.  

Четырнадцатая команда Create/ModifySurface>StandardShapes создает 

стандартные геометрические формы: куб, сферу, цилиндр, дыру в поверхности, 

плоскость (в том числе обрезанную) или диск по нормали к кривой.  
  

 

 

 

а), б) в) г) 

Рис. 4.2 Команды для работы с геометрией 

 



39 

 

Значок функциональной панели CreateBody (рис.4.2а) содержит 2 команды 

создания тела.  

Первая команда CreateBody>ByTopology создает (идентифицирует) модель 

целиком, либо из выбранных поверхностей. По умолчанию тело или его часть 

приобретает имя BODY либо его синоним. Если в объеме объединены два тела, они 

приобретают два имени, и в этих частях строятся отдельные сетки.  

Вторая команда CreateBody>ByMaterialPoint идентифицирует тело заданием 

MaterialPoint, т.е. материальной точки в замкнутом объеме, как центроиды двух 

заданных точек. 

Закладка функциональной панели CreateFaceted (рис.4.2б) предоставляет 

возможности преобразования фасеточных кривых, поверхностей, а также подчистку 

поверхностей, ремонт дыр, обрезание бахромы и т.д. Фасеточные, иначе граненые 

объекты в отличие от поверхностей свободной формы (обычно NURBS - Non-

UniformRational B-Splines) формируются кривыми и плоскостями, образующими 

грани, и создают в общем случае граненый объект. (Детали см. в Help).  

Закладка функциональной панели RepairGeometry (рис.4.2в) становится 

активной только при работе с какой-либо имеющейся 3D моделью. Главная цель 

ремонта геометрии модели – определение и устранение щелей между соседними 

поверхностями и гранями.  

Первая команда RepairGeometry>BuildTopology создает ряд кривых и точек 

из ребер и углов поверхностей в зависимости от близости их расположения. Статус 

кривых отображается цветом и помогает определить щели или дыры в геометрии. 

Значение конкретного цвета описывается детально в Help. 

Вторая команда RepairGeometry>CheckGeometry проверяет все видимые 

части, помеченные части, либо поверхности. При проверке геометрии поверхностей 

проверяется наличие краев (Edges), выявляются поверхности с кривизной, 

отличающейся от кривизны базового угла на 5 град. Также проходит проверку 

отличие по площадям в сравнении с заданной площадью. 

Третья команда RepairGeometry>CloseHoles закрывает дыры в поверхности 

посредством выделения кривой, формирующей края дыры. При этом создается новая 

поверхность.  
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Четвертая команда RepairGeometry>RemoveHoles удаляет дыру, 

составленную из кривых, формирующих непрерывную петлю. При этом новая 

поверхность не создается, а исправляется старая поверхность. 

Пятая команда RepairGeometry>Stitch/MatchEdges сшивает или соединяет 

края щели. После выделения кривых, образующих щель, выделяется один из 

методов. Здесь же применяется подравнивание двух поверхностей по краю щели, 

либо демонстрируется слияние щели для Y-соединений. (см. детали в Help). 

Шестая команда RepairGeometry>SplitFoldedSurfaces расщепляет сложенные 

поверхности.  

Седьмая команда RepairGeometry>AdjustVaryingThickness позволяет 

настроить толщину выбранной поверхности. Используются три метода достижения 

этой цели (см. детали в Help). 

Восьмая команда RepairGeometry>MakeNormalsConsistent позволяет создать 

совместимые нормали к поверхности в направлении заданной нормали, либо в 

обратном направлении. 

Девятая команда RepairGeometry>FeatureDetectBoltHoles обнаруживает 

односвязные дыры, норы.  

Десятая команда RepairGeometry>FeatureDetectButtons обнаруживает 

образования типа кнопок или впадин, выпуклостей и помещает их в подгруппы 

общей геометрии для индивидуальной обработки. Рассматривается работа с тремя 

типами кнопок (см. детали  в Help).  

   

Одиннадцатая команда подгруппы общей геометрии FeatureDetectFillets 

выявляет области желобков, ободков и размещает их подгруппы общей геометрии. 

Выявление основано на заданной минимальной длине желобков, минимальной 

кривизне.  

Закладка функциональной панели TransformGeometry (Рис.4.2г) преобразует 

выделенную геометрию. Доступны трансляция, вращение, зеркальное отражение, 

масштабирование, трансляция и вращение. По умолчанию все вновь созданные 

объекты сохраняются на родительском месте. 



41 

 

Первая команда TransformGeometry>Translation дает параллельный перенос 

по заданному вектору. Подкоманда Copy может быть повторена несколько раз. 

Подкоманда IncrementParts создает новую копию в новую часть геометрии. 

Вторая команда TransformGeometry>Rotation вращает геометрию на 

заданный угол вокруг заданной оси. Подкоманда IncrementParts создает новую 

копию в новую часть геометрии. Может быть задан центр вращения. 

Третья команда TransformGeometry>MirrorGeometry отражает геометрию 

относительно заданной плоскости. Подкоманда IncrementParts создает новую 

копию в новую часть геометрии. Плоскость задается нормалью.  

Четвертая команда TransformGeometry>ScaleGeometry позволяет 

масштабирование геометрии. Подкоманда IncrementParts создает новую копию в 

новую часть геометрии. Возможно задание X, Y, Z масштабных множителей по осям 

координат.  

Пятая команда TransformGeometry>TranslateАndRotate позволяет 

одновременно вращать и транслировать геометрию. Подкоманда IncrementParts 

создает новую копию в новую часть геометрии. 

Закладка функциональной панели RestoreDormantEntities содержит только 

одну команду, которая сохраняет скрытые или бездействующие кривые и точки. 

Следующий ряд значков уничтожает объекты (см. рис. на стр. 33). 

Закладка функциональной панели DeletePoint содержит одну команду, 

которая уничтожает точку; опционально возможно уничтожение с удалением из 

базы данных, а также уничтожает скрытые или бездействующие точки. При 

уничтожении точки пересечения кривых последние объединяются. 

Закладка функциональной панели DeleteCurve содержит одну команду, 

которая уничтожает кривую; опционально возможно уничтожение с удалением из 

базы данных,  также уничтожает скрытые или бездействующие кривые.  

Закладка функциональной панели DeleteSurface содержит одну команду, 

которая уничтожает поверхность с удалением из базы данных.  

Закладка функциональной панели DeleteBody содержит одну команду, 

которая уничтожает тело с удалением из базы данных. 

Закладка функциональной панели DeleteAnyEntity содержит одну команду, 

которая уничтожает объект с удалением из базы данных. 
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4.2 Описание инструментов визуализации и построения сеточных моделей 

 

4.2.1. Общая структура дерева модели 

 

Дерево модели отображает элементы и семейства элементов, входящие в 

состав модели. При появлении элемента, относящегося к геометрии (точка, кривая, 

поверхность), появляется ветвь Geometry со всеми возможными структурами 

(например, элемент Surface существует даже в случае отсутствия поверхностей в 

модели).  

При появлении в модели элементов блочной топологии появляется ветвь 

Blocking, при создании элементов неструктурированной сетки - ветвь Mesh. В ветви 

Parts содержатся имена семейств элементов, которые, в свою очередь, содержат те 

или иные элементы модели. Если снять флажок с ветви или с элемента, то все 

элементы данного типа станут невидимыми. 

 

Рис. 4.3 Структура дерева модели и меню настроек 
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При подведении курсора мыши к названию какой-нибудь ветви или к элементу 

в Дереве модели и нажатии ПК появляется меню дополнительных настроек и 

функций данной ветви или элемента. Чтобы данная настройка или функция 

активировалась, необходимо нажать на ней ЛК (рядом с именем появится флажок, 

рисунок 4.3). Некоторые функции следуют из названия функций и настроек. Ниже 

перечисляются основные из них.  

Geometry>Curves>ПК>ShowDouble – если снять галочку, то невидимыми 

станут кривые, принадлежащие только двум поверхностям. Эта функция удобна при 

уточнении геометрии. 

Geometry>Curves>ПК>ShowWide и Color byCount – при включённых этих 

функциях кривые становятся толще и окрашиваются в цвета кодировки 

принадлежности кривых.  

Geometry>GeometryCurves>ПК>CurveTetraSizes - показывает размер 

элемента неструктурированной сетки, заданный на данной кривой.  

Geometry>Surfaces>ПК>TetraSizes - показывает размер элемента, заданный 

на поверхности. Иногда, при работе с геометрией полезно включать функции 

отображения имён геометрических элементов. Это позволяет понять, сколько 

элементов находится в данном месте модели.  

Mesh>ПК>CutPlane... - позволяет настроить секущую плоскость 

визуализации (ManageCutPlane) и отобразить элементы неструктурированной сетки 

в сечении (ShowCutPlane).  

Примечание: а) при выключении отображаемого сечения необходимо вначале снять 

галочку с Volumes, иначе программа будет пытаться отобразить все контрольные 

объёмы модели, что может привести к "зависанию" программы; в этой связи 

рекомендуется периодическое сохранение проекта; б) при включённом отображении 

элементов в сечении вращение колеса мыши воспринимается как перемещение 

сечения.  
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Mesh>ПК>Periodicity - отображает при помощи линий периодичность 

элементов неструктурированной сетки (если таковая использовалась при создании 

сетки). Используется для проверки.  

Mesh>Shells>ПК>Solid&Wire - функция отображения элементов поверхности, 

которые окрашиваются в соответствии с цветом семейства, контуры элементов 

сохраняются.  

Mesh>Volumes - отображает все контрольные объёмы модели. Можно 

отобразить некоторые из контрольных объёмов, например призматические (Prism) 

или элементы в сечении для визуальной оценки качества сетки.  

Blocking>ПК>IndexControl - вызывает таблицу номеров блоков, 

позволяющую манипулировать вариантами отображения блоков блочной топологии 

модели. Функция удобна для построения или модификации блочной структуры. 

Blocking>Vertices>ПК>Periodic - отображает при помощи красных стрелок 

периодичные вершины блоков (если периодичность задана).  

Blocking>Vertices>ПК>Numbers - включает отображение номеров вершин. 

Используется редко. 

Blocking>Edges >ПК >ShowАssociation - при помощи стрелок показывает, к 

какому геометрическому объекту привязано ребро блока, а также вершины на 

концах выбранного ребра.  

Blocking>Faces>ПК>FaceProjection - показывает при помощи заливки 

цветом, к какому семейству данная поверхность блока была привязана вручную. В 

случае автоматической привязки поверхности блока отображаются в виде контура. 

Blocking>Blocks>ПК>Solid - отображает блоки сплошной заливкой. 

Способствует визуализации блоков.  

Blocking>Pre-Mesh>ПК>Solid&Wire – отображает поверхностные элементы: 

заливку и контуры элементов.  
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Blocking>Pre-Mesh>ПК>Recompute - перестраивает пре-сетку 

(предварительную сетку) блочной структуры после внесения изменений в 

перемещении вершин, в задании нового числа узлов на рёбрах и т.д.  

Blocking>Pre-Mesh>ПК>ShowSizeInfo - показывает в Окне сообщений 

количество элементов пре-сетки.  

Blocking>Pre-Mesh>ПК>ConvertТoUnstructMesh – преобразует созданную 

пре-сетку в неструктурированную гекса-сетку для применения в соответствующем 

солвере, например CFX.  

Blocking>Pre-Mesh>ПК>ScanРlanes и CutРlane - функции, позволяющие 

отобразить сеточные элементы в пространстве модели. Scan Planes - показывает 

сеточные элементы на поверхности границ контрольных объёмов c одинаковым 

порядковым номером. Элементы отображаются как поверхностные. CutPlane - 

показывает объёмные элементы, попавшие в секущую плоскость.  

Parts>ПК>CreatePart - функция создает семейства элементов, содержащие 

различные области модели и различные типы элементов. Функция необходима для 

создания доменов, на которых будут задаваться граничные условия. Функция также 

удобна для работы с моделью – позволяет отображать, либо отключать некоторые 

наборы элементов в зависимости от необходимости.  

Parts>ПК>DeleteEmptyParts - удаляет пустые наборы элементов.  

Parts>Name>ПК>ChangeColor - изменяет цвет окраски элементов данного 

набора.  

Parts>Name>ПК>Rename - переименовывает набор элементов.  

Parts>Name>ПК>Delete - удаляет элемент или семейство вместе со всеми 

входящими элементами. 
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4.2.2. Меню выбора элементов модели 

 

В работе с моделью при вызове команд в рабочем окне будет появляться меню 

выбора элементов (рис. 4.4 а-в). По умолчанию при выборе элементов модели 

активна основная функция – выбор курсором мыши по ЛК. В качестве 

дополнительного способа по умолчанию включён также выбор элементов при 

помощи прямоугольной области охвата (ToggleВetweenАll&PartialEnclosure) . 

Способ создания области охвата заключается в растягивании с помощью ЛК 

прямоугольной области по углам. 

Ниже перечислены основные способы выбора различных элементов и 

команды.  

SelectItems in PolygonalRegion  – команда выбора элементов при помощи 

многоугольного региона.  

 

а)  

б)  

в)  

 

Рис. 4.4 Панели меню выбора элементов для вкладок: а) Geometry; б) Mesh; 

в)Blocking; Edit Mesh 

 

Select All Appropriate Objects (Visible or Blanked)  – выбираются все 

допустимые элементы (видимые, и скрытые).  
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Select All Appropriate Visible Objects - выбираются только все видимые 

элементы.  

Select All Appropriate Blanked Objects – выбираются только все скрытые 

элементы. 

Select Items  attached to current selection up to angle; up to curve; up to one attached 

layer   - выбираются элементы, принадлежащие текущему выбору в 

пределах угла; до кривой; ограниченные текущим слоем.  

SelectItem in Subset  - выбираются элементы, принадлежащие определенному 

подмножеству. 

Select Items in Part  – выбираются элементы, принадлежащие определенной 

существующей части.  

При работе на вкладках Mesh, Edit Mesh в панели выбора появляются 

дополнительные возможности выбора:  

Select All Node Elements  – выбор всех сеточных элементов узла;  

Select All Line Elements  – выбор всех сеточных элементов вдоль линии;  

Select All Surface Elements  –выбор всех поверхностных сеточных элементов;  

Select All Volume Elements  - выбор всех объёмных сеточных элементов. 

 

4.2.3. Содержание и структура рабочей папки  

 

Папка (директория) проекта создается пользователем. В процессе работы над 

проектом, программа создаёт файлы с расширениями:  

*.prj – файл проекта появляется при первом сохранении проекта с информацией о 

подгружаемых файлах; 
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*.tin – tetin(tetra-input)-файл, содержащий геометрическую модель, а также 

настройки неструктурированной сетки; появляется вместе с файлом проекта;  

*.uns – файл, содержащий неструктурированную сетку; создаётся при генерации 

неструктурированной сетки; 

*.blk – файл, содержащий блочную топологию и пре-(предварительную) сетку, а 

также все настройки связанные с блочной топологией; появляется при создании 

блочной топологии модели; 

*.fbc, *.atr – файлы, содержащие граничные условия (при использовании ICEM 

CFD в качестве препроцессора); 

*.par -- - настройки решателя (при использовании ICEM CFD как препроцессора); 

*.jrf, *.rpl – файлы-журналы, в которых записываются все действия, выполняемые в 

ходе работы с проектом, если это было предусмотрено. 

Основными файлами сеточного проекта являются  

*.tin – файл, содержащий геометрию, по нему можно восстановить 

неструктурированную сетку;  

*.uns – файл, содержащий неструктурированную сетку, если есть tin-файл или в 

проекте использовалась блочная топология, то это файл необязателен;  

*.blk – файл, содержащий блочную топологию, если в проекте использовалась 

блочная топология. 

Остальные файлы при активировании проекта создаются заново. 
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5. ПОСТРОЕНИЕ НЕСТРУКТУРИРОВАННОЙ СЕТКИ ТРЕХМЕРНЫХ 

ЭЛЕМЕНТОВ 

 

Построению сетки в расчетной области предшествует подготовка этой области. 

Предполагается, что трехмерная область существует, будучи созданной в какой-либо 

CAD программе, в том числе, средствами ICEM.  Именно, специальным образом 

выделяются части (Partitions) всей области как подобласти, командой CreateParts. 

Подобласти могут быть трехмерными частями общей области, а также двумерными 

внутренними и внешними границами трехмерных областей (вход, выход, стенки и 

т.д.).   

Автоматическое заполнение области обычно называется неструктурированной 

сеткой трехмерных элементов. При этом область заполняется в основном сеткой из 

тетраэдров.  

При создании простейшей неструктурированной сетки, например, внутри 

канала необходимо задать поверхности входа потока (Inlet), выхода (Outlet) и стенок 

(Wall). Поверхности предварительно визуализируется командой Geometry>Surfaces. 

Далее нажатием ПК Parts>Create Part(by selection) получаем окно ввода имени 

(Inlet), нажимаем ЛК на стрелку активируя ввод. На чертеже ЛК помечаем 

поверхность торца канала (Inlet), соглашаемся с выбором, нажимая на среднюю 

кнопку мыши (СК), и далее аналогично продолжаем ввод Outlet и Wall. Последнюю 

удобно помечать, предварительно отключив флажки частей входа и выхода канала.  

Для определения объемной области как места для построения сетки задается 

материальная точка, принадлежащая области, либо определяется тело (объем) 

серией команд. В частности для 3D тела команды 

Geometry>CreateBody>Centroid2Points/SpecifiedPoint, (рис.5.1б) или 

Geometry>CreateBody>ByTopology определяют объемную область через набор 

замкнутых поверхностей. 

Например, нажимаем ЛК Geometry>Create Body, в окне ввода именуем Body, 

или, например, Fluid, и вводим ЛК две реперные точки на границах области так, 

чтобы их средняя оказалась во внутренней области канала. После подтверждения их 
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ввода СК получаем точку Fluid. Соглашаемся с выбором нажатием ЛК кнопки 

Apply, либо отменяем выбор нажатием ПК и повторяем процедуру более точно. В 

целом, определение области объёма выполняется пользователем для сложных либо 

несвязных объемов, для простых областей материальная точка определяется 

автоматически.  

Далее на частях Inlet, Outlet и Wall последовательно определяем базовые 

размеры тетраэдров, ориентируясь на размеры трубы и визуализацию тетраэдров. 

Для визуализации нажимаем ПК Surfaces и ставим флажок Tetra Size. 

Для определения базовых размеров тетраэдров нажимаем ЛК Mesh>Surface 

MeshSetup, в панели нажимаем ЛК SelectSurface, выделяем с помощью ЛК 

выбранную часть, (например, INLET), подтверждаем СК и задаем максимальный 

размер MaximumSize, далее подтверждаем ЛК Apply. Остальные позиции панели 

оставляем нулями. Аналогично поступаем с частями OUTLET и WALL.   

Далее определяем предельное значение тетраэдров в области. Для этого 

нажимаем ЛК Mesh>Global Mesh Setup, в панели выбираем ЛК Global Mesh 

Parameters, в разделе Global Element Seed Size выбираем Max Element и ставим 

флажок Display, сохраняем Scale factor =1 и ставим флажок Display. Завершаем все 

командой ЛК Apply. Таким образом, в простейшем случае параметры сетки 

сформированы. При необходимости мы можем изменить выбранные параметры, 

повторяя процедуру с частями в произвольном порядке. 

Меширование (построение сетки) применяет стандартные процедуры Octree 

Tetra, Delauney/T-grid, Advancing Front.  

Процедура OctreeTetra стартует с геометрического описания области, 

робастна, требует задания размера ячейки. 

Процедура Delauney/T-grid отличается высокой скоростью. 

Процедура AdvancingFront сглаживает градиенты геометрических 

характеристик, допускает гексагональное сеточное ядро с доминированием. 

Общий подход к мешированию состоит в определении параметров сетки. При 

этом выполняется цепочка действий: нажимаем GlobalMesh 

Setup>VolumeMeshingParameters>MeshType>MeshMethod. 
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Размер сетки может быть задан глобально (GlobalMeshSetup) (рис.5.1а) и 

локально (Part/Surface/Curve/MeshSetup), далее опционально (при необходимости) 

определяются области густой сетки (DensityRegions). 

Расчет 3D сетки выполняется по серии команд 

Mesh>ComputeMesh>VolumeMesh, опционально вычисляется слой призматических 

ячеек серией команд Mesh>ComputeMesh>PrismMesh.  

 

 

а) 

 

б) 

 

в) 

Рис. 5.1 

 

Tetra/Mixed в разделе VolumeMeshingParameters - наиболее часто 

применяемый тип сетки. Может использоваться как исключительно тетра-сетка 

(PureTetra), с призматическими слоями, с гексагональным ядром (HexCore), в 

гибридной конструкции путем слияния со структурированной гекса-сеткой 

(HybridMesh). 

Hexa-Dominant - сетка, как правило, используется для структурного анализа, но 

не для CFD анализа. 

Cartesian - ортогональная сетка, используемая в декартовой системе координат. 
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5.1 Методы и процедуры построения тетраэдральных сеток. 

 

Тип сетки - Tetra/Mixed, метод Octree (Robust) (рис.5.1в)  является хорошим 

выбором для сложной геометрии области, либо для геометрии с дефектами. 

Процесс OctreeTetra создает начальную сетку с заданным максимальным 

размером, которая заполняет внутренность области внутри и внешнюю часть, 

охватывающую область. Область заливки ячейками, охватывающая геометрию, 

называется ORFN region, используется в процессе построения и затем 

уничтожается. После построения опционально применяется процесс сглаживания с 

помощью набора команд EditMesh>SmoothMeshGlobally. 

Требования к геометрии области для процесса OctreeTetra. Перед построением 

сетки по геометрии области рекомендуется проводить BuildDiagnosticTopology для 

поиска дыр или щелей между ребрами.  

OctreeTetra допускает щели меньше десятой доли от размера элемента. Кривые 

и точки могут быть, как включены в состав геометрии области, так и исключены из 

состава. В первом случае при построении сетки будут описываться все детали 

области, и это может вызвать излишнее измельчение элементов сетки.  

Во втором случае упомянутые особенности области примут «оплывший» вид, 

т.е. произойдет потеря точности в сеточном описании геометрических особенностей. 

При постановке задачи о построении сетки по команде GlobalMeshSetup> 

VolumeMeshingParameters выделяются следующие опции: 

FastTransition – допускает менее плавный переход от мелких ячеек к крупным; но 

уменьшает мощность сетки; 

EdgeCriterion – расщепляет элементы более заданного размера для лучшего 

описания геометрии; 

DefineThinCuts – инструмент для описания тонких щелей, острых углов; 

Smooth/Coarsen – автоматически сглаживает/загрубляет процесс генерации сетки. 

Расчет сетки выполняется командой - ComputeMesh>OctreeTetra. 

Команда CreatePrismLayers – создает слой призм, помеченный в PartMeshSetup 

после расчета тетраэдральной сетки.  

Команда CreateHexa-Core – создает ядро из гексагональной сетки (см. детали в 

Help). 
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Команда Input – выделяет геометрические части для построения сетки; меширует 

каждую часть отдельно. 

Команда UseExistingMeshParts – использует поверхности с уже построенной 

поверхностной сеткой для последующего построения объемной сетки. 

Команда Curvature/ProximityBasedRefinement – выполняет измельчение сетки, 

основанное на кривизне линий, близости границ. Функционирует только для Octree 

процесса; автоматически делит элементы, меньшие заданного размера сетки для 

описания тонких деталей. Удобно для геометрии с фасками различной кривизны. 

Управляется заданием минимального размера ячейки - MinSizeLimit (см. детали в 

Help).  

Сеточное описание пространств в зазорах управляется числом ячеек в зазорах с  

помощью команды – ElementsInGap. Здесь ThinCuts – это тонкие 

зазоры/щели/тела, размер которых много меньше заданного размера сетки. Их 

задание определяется выделением двух частей, образующих ThinCuts, и их 

отнесением в список ThinCuts (см. дополнительные детали в Help).  

Метод построения Quick(Delaunay). Построение стартует с замкнутых 

поверхностных сеток хорошего качества, четырехугольных и треугольных, а также с 

импортированных поверхностных сеток. 

Команда Standard – стандартная схема разбиения по Делоне.  

Команда TGlib – опирается на алгоритм, использующий более плавный переход в 

размерах сетки, чем стандартная схема.  

Команда AF – Tgrid AdvancingFront Delaunay – алгоритм, позволяющий еще более 

плавный переход в размерах сетки. 

Метод построения Smooth(AdvancingFront) близок к Quick(Delaunay), 

использует фронтальное продвижение от поверхности (границы) во внутреннюю 

часть области, создает постепенный переход в размерах сетки, требует большего 

сеточного массива в сравнении с Quick(Delaunay) (см. детали в Help). 

Метод построения ANSYS TGrid. Запускается командой Tetra/Mixed> ANSYS 

TGrid, дает высокое качество при быстрой генерации сетки; плохо работает со 

сгущением сеток по команде Densities. Не работает с четырехугольниками 

(переводит в треугольники). Метод по качеству близок к методу AdvancingFront. 
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Метод MultiZone.  Данный метод может быть использован в ситуациях, где 

требуется создание высококачественной сетки около стенки, однако топология 

объекта не позволяет быстро построить структурную сетку 

Метод MultiZone работает следующим образом.  

Сначала создаются поверхностные блоки, затем на их базе строятся объемные 

блоки (операции вытягивания или заметания). Далее внутренний объем заполняется 

неструктурированной сеткой.  

Метод MutliZone формирует блоки типа Mapped, Swept и Free. Блоки типа 

Free могут быть заполнены тетраэдрами, гексаэдрами, совмещенными с тетраэдрами 

(Hexa Core и Hexa Dominant). 

 

5.2 Некоторые опциональные особенности алгоритмов построения 

 

Некоторые методы построения, например, Octree, не мешируют сетки в частях 

объекта (UseЕxistingМeshРarts). Создание призматических слоев доступно для всех 

построителей. Создание Hexa-Core недоступно для методов AdvancingFront и 

ANSYS TGrid. (см. дополнительные детали в Help). 

Работа с оператором создания плотности сетки DensityRegion  

Команда CreateMeshDensity – определяет область объема для создания более 

мелкой сетки вне геометрии обтекаемого твердого тела, например, в канале, за 

обтекаемым телом. Данная команда может создавать густые сетки внутри уже 

созданной области плотности, с последующим прогрессивным измельчением. 

Может пересекать границы геометрии, выходить за пределы всей расчетной области. 

Опишем параметры оператора DensityRegion (рис.5.2а). 

Size - максимальный размер ячейки внутри области Density, умноженный на 

глобальный масштабный множитель GlobalScaleFactor;  

Ratio – отношение последовательного увеличения объемов от объекта плотности; 

Width – количество слоев от объекта плотности до предельного значения размера 

ячейки; 

Points - набор точек (1-3), формирует толщину объема Density; набор точек (4-8) 

создает полигональный объем. 
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Команда EntityBounds - определяет область ограничивающего объема выделенных 

элементов. 

Задание свойства периодичности сетки. Работа с оператором DefinePeriodicity 

(рис.5.2б). Команда применяется при построении сеток в периодически 

симметричных областях. Принуждает сетки на границах периодичности к 

совпадению. Применяется для меширования и использования сетки для решения 

только в одной секции симметрически повторяемой геометрии.  

При выборе команды RotationalPeriodicity необходимо задание секции Base, 

оси Axis, и угла периодичности Angle. 

При выборе команды TranslationalPeriodicity необходимо задание компонент 

вектора сдвига секции DX,DY,DZ. 

Размещение MaterialPoint в секции рекомендуется реализовывать ближе к 

средней плоскости для облегчения процесса реализации периодичности. 

Конвертирование ячеек. Работа с оператором ConvertMeshType преобразуют 

один тип элемента в другой (рис.5.2в).  

 

 

а) 

 

б) 

 

в) 

Рис. 5.2 Некоторые опциональные особенности  сеточного контроля 
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5.3 Особенности построения призматических сеточных слоев 

 

Призматические сеточные слои применяются вблизи твердых стенок для 

моделирования гидродинамических эффектов в пограничных слоях (рис. 5.3). Сетка 

в призматических слоях должна быть ортогональна обтекаемой поверхности, и для 

случая тетраэдрального ядра должна состоять из призм с треугольным основанием. 

При построении применяется сгущение сеточного массива с измельчением в 

направлении нормали к границе. 

 

  

а) б) 

Рис. 5.3 а) структура пограничного слоя (эксперимент F.X. Wortmann); б) схема 

призматического сеточного слоя вблизи стенки  

 

Процедура построения начинается с установления набора параметров 

призматического слоя GlobalPrismParameters.  

Выделяются части Parts для роста слоев (как правило, стенки), задаются 

локальные параметры для каждой части, которые имеют приоритет над глобальными 

установками. При этом пустые или нулевые позиции определяются глобальными 

установками. Расчет слоев возможен а) от существующей сетки выдавливанием 

внутрь существующей гекса/тетра-сетки; б) вытягиванием сеточного пограничного 

слоя от поверхностной треугольной сетки и последующим заполнением объема; в) 

автоматический расчет во время создания объемной сетки. 
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Глобальные параметры призматического слоя GlobalPrismParameters 

(рис.5.4а) определяются законом роста высоты призмы в зависимости от номера 

слоя: 

Exponential - height=h(r)(n-1) ; 

Линейный - height=h{1+(n-1)(r+1)} ; 

Wb-exponential - height=h*exp{n-1)(r+1)}; 

 h - высота первого от стенки слоя (InitialHeightLayer); 

 n – количество слоев (NumLayers); 

 r – отношение высот соседних слоев (HeightRatio); 

 H (TotalHeight) –суммарная высота всех слоев.  

 

 

а) 

 

 

 

б) 

 

 

 

в) 

Рис. 5.4 
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При построении обыкновенно задаются первые три параметра. Команда 

ComputeParams запускает процесс вычисления остальных параметров и слоев 

сетки. Скорость роста Exponential занимает промежуточное значение между Linear 

и Wb-exponential. 

Сглаживание Tetra/Prism перехода. Оставляем нулевое значение параметра 

InitialHeight. Это приведет высоту первого слоя к «плаванию» с целью уменьшения 

изменений объема между последней призмой и смежной тетра-ячейкой, однако это 

же приведет к увеличению высоты пристеночной призмы и заставит применить 

операцию перераспределения высот призм. 

Установление параметров призм в частях (Parts) задается командой 

Mesh>PartMeshSetup. В данной таблице ставим флажок на Prism для частей 

(Parts). Этой командой параметры Height, Height Ratio, NumLayers задаются 

индивидуально для каждой из частей (Parts). Команда 

ApplyInflationParamsToCurves применяет эти параметры к каждой кривой внутри 

каждой части. 

Задание параметров призм на кривых происходит по команде 

Mesh>CurveMeshSetup. Применяется при переходе вдоль поверхности без задания 

высоты первой ячейки, однако с заданием разных высот на каждой кривой, 

ограничивающей противоположные стороны той поверхности, на которой строится 

слой призм. Параметры NumLayers, HeightRatio не влияют на установки 

CurveMeshSetup.  

Расчет призматической сетки идет по команде Mesh> 

ComputeMesh>PrismMesh. Кнопка SelectPartsForPrismLayer вызывает таблицу 

меню аналогично PartMeshSetup для выбора установок. Далее опционально 

выбирается команда ExistingMesh/FromFile, либо идет автоматический расчет, 

связанный с объемной сеткой.  

Опции контроля качества призматического слоя детализированы в Help. 

Команда FixMarchingDirection удерживает нормаль к поверхности; команда 

OrthoWeight устанавливает множитель веса (0-1) для движения узла. Параметр 

RatioMultiplier (m) используется для изменения закона экспоненциального роста 

высоты слоя height= h(r)(n-1) m(n-1) 
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При большом количестве призматических слоев иногда бывает удобно создать 

толстый слой, затем разделить его на набор тонких слоев с помощью команды 

EditMesh>SplitMesh>SplitPrisms (рис.5.4б). При этом задается отношение высот 

призм командой FixRatio, либо фиксируется высота первого слоя командой 

FixInitialHeight. Также задается количество слоев и возможно разбиение 

специфицированных, либо всех существующих слоев. 

Перераспределение разбиения призматических слоев. Перераспределение 

достигается командой EditMesh>MoveNodes> RedistributePrismEdge (рис.5.4в). 

При этом также задается отношение высот призм командой  FixRatio для 

обеспечения роста высот, либо фиксируется высота первого слоя командой FixInitial 

Height. 

 

5.4 Проверка качества сетки  

 

Инструментарий закладки EditMesh (см. рис.5.5, 5.6а) используется для 

проверки и улучшения качества сетки, для манипулирования сеточными элементами 

(преобразования типов элементов, измельчения, либо укрупнения сетки), для 

создания специальных подмножеств элементов с особенностями, либо проблемами.  

  

 

 

Рис. 5.5 Команды проверки качества 

 

Правая часть закладки CheckMesh>PossibleProblems рассматривает варианты 

возникающих проблем, в частности, выявление некорректных элементов, дыр и 

зазоров между поверхностями. 

Проверка качества сетки (EditMesh>CheckMesh) доступна в разделе Errors. 

Игнорирование проверки ошибок может привести к ошибкам солвера, расходимости 

решения.  

Основные команды - опции закладки CheckMesh>PossibleProblems. 
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DuplicateElements (рис. 5.6а) – дублированные элементы, это элементы, которые 

используют все узлы других элементов того же типа. 

Uncovered Faces – грани объемных элементов, которые не привязаны к грани 

другого объемного элемента, или ни к одному элементу поверхности (граничная 

грань). 

Missing Internal Faces - объемные элементы, смежные с другой частью без элемента 

поверхности между ними. 

Periodic Problems - проблемы с периодичностью означают несоответствие в 

структуре «узлы/грани» между периодическими сторонами (проверяется 

опционально). 

Volume Orientation – появление элементов «левой ориентации» из-за неправильной 

нумерации узлов ячейки. 

Surface Orientation - то же для граней 

HangingElements - висячие элементы, это элементы со свободным узлом.  

PenetratingElements - проникающие элементы, это элементы поверхности, которые 

проникают через другие поверхностные элементы 

Disconnected Bar Elements - отсоединенные элементы панели, это элементы панели, 

в которых оба узла не привязаны к другим элементам. 

Multiple Edges - поверхностные элементы с ребром, которое разделяет три или 

более элементов, может включать разрешенные Т-соединения. 

Triangle Boxes - группы из 4-х треугольников, образующие тетраэдр без 

фактического элемента объема внутри.  

2 - Single Edges – поверхностные элементы с двумя свободными ребрами (не 

разделяющиеся другим поверхностным элементом). 

Single-Multiple Edges - элементы поверхности со свободными и множественными 

ребрами. 

Stand-Alone Surface Mesh - элементы поверхности, не имеющие общей грани с 

объемным элементом. 

Single Edges - одиночные ребра, это поверхностные элементы со свободным краем 

могут включать в себя разрешенные висячие перегородки - 2D-только границы сетки 

являются одиночными. 
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Delaunay Violation - Нарушение правила Делоне означает наличие трех элементов с 

узлами, находящимися в пределах окружности соседних трех элементов  

 

   
а) б) в) 

 

Рис. 5.6 Команды для проверки качества сетки 
 

Overlapping Elements - Перекрывающиеся элементы, это непрерывный набор 

элементов поверхности, которые занимают одну и ту же площадь поверхности 

(поверхностная сетка, складывающаяся на себя под небольшим углом). 

Non-manifold Vertices - Не-многообразие вершин (ограниченное автоматическое 

исправление), означает вершины, внешние поверхности которых не образуют 

замкнутого контура. Обычно встречаются в тенто-подобных конструкциях, где 

поверхностные элементы перескакивают с одной поверхности на другую через 

узкую щель или острый угол 

Unconnected Vertices - Неподключенные вершины, вершины, которые не 

подключены к каким-либо элементам (всегда можно удалить). 



62 

 

Если выбирается параметр CreateSubsets, будут проходить все проверенные 

критерии без прерывания. При этом элементы, которые имеют определенную 

ошибку/проблему, помещаются в подмножество Subsets с тем же именем 

диагностического типа. Подмножества Subsets, активируются в Дереве моделей 

ModelTree. При этом необходимо отключать все части или оболочки для просмотра 

подмножеств.  

При выборе команды Check/FixEach (Проверить/Исправить) будут 

предложены варианты по одному критерию за проверку. Автоматически исправлять 

ошибку/проблему рекомендуется только для дублированных элементов, незакрытых 

граней, отсутствующих внутренних граней, ориентации объемов, неприсоединенных 

вершин. 
 

5.5 Отображение качества сетки с применением гистограммы 
 

При этом выполняется диагностическая проверка качества отдельных 

элементов, и выбираются типы сетки для проверки.  

Процедура позволяет выбрать следующие типы сетки для проверки: 

1D (линейные элементы); 2D (Tri и/или Quad); 3D (Tetra, Penta, Hexa и/или 

Pyramid). Элементы для проверки выбираются по частям и подмножествам. 

Опционально могут быть выбраны 1) все; 2) только активные части; 3) видимые 

подмножества; 4) видимые подмножества и активные части. 

Тип качества указывает критерий качества элемента для отображения на 

гистограмме. 

Mesh Smoothing - сглаживание сетки, означает автоматическое улучшение 

качества для всех типов элементов. Для активирования необходимо загрузить 

геометрию. В процессе сглаживания узлы перемещаются для улучшения качества 

элемента, автоматическое перемещение узла ограничивается проекцией узла. 

Пользователь выбирает параметры: критерий, предельное значение, плавность сетки, 

и опции. 

Smooth - типы элементов активно сглаживаются; качество типа появляется как 

часть гистограммы. 

Freeze – замораживание; узлы удерживаются на месте во время сглаживания и 

обработки. Эти элементы не показываются в гистограмме. 
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Float - узлы освобождаются для перемещения вместе с соседними узлами. 

Например, выполняется замораживание призм и пирамид при сглаживании.  

Tetra -  Элементы поверхности с плавающей точкой. 

 

5.6 Некоторые расширенные опции по сглаживанию сетки 
 

Сглаживание по Лапласу - обеспечивает более равномерный размер ячейки по 

сравнению с соседними элементами и равными углами; рекомендуется только для 

тетра-сеток, рекомендуется до генерации призм. Может улучшить качество, но 

требует больше времени работы процессора, может нарушать геометрию. При этом 

возможно нарушение геометрии в пределах заданных пользователем допусков - 

абсолютного или относительного. Ограничение на минимальную длину ребра не 

допускает слияния узлов, которые делают любое ребро меньше этой длины. 

Mesh Subsets (подмножества сеток). Подмножество сетки является частью 

сетки, сгруппированной для целей просмотра, диагностики и специальных действий. 

Необходимо для диагностики элементов с проблемами и редактирования элементов. 

Следует иметь в виду, что операции с сеточным подмножеством выполняются 

существенно быстрее, чем при включении всей сетки. При анализе подмножеств 

также можно видеть внутренние сеточные проблемы, которые не видны при 

отображении всей сетки.  

Процедура выполняется через клик ПК на Mesh>Subsets>Create в дереве 

модели, затем выбираются элементы. Выделяются элементы на более гладкой или 

качественной гистограмме и выбирается команда «Subset». При проверке ошибок и 

возможных проблем выбирается команда «CreateSubset». В режиме секущей 

плоскости следует выбирать команду «CreateMeshSubset». 

Изменение подмножеств. Как только подмножество создано, есть много 

инструментов для добавления и вычитания элементов подмножества для 

визуализации проблем и упрощения работы с инструментами редактирования сетки. 

Например, кликом ПК на имени подмножества в дереве модели выбираем команду 

Change (Изменить). Часто добавляется несколько слоев для лучшей визуализации. 
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5.7 Основные команды управления сеточной структурой 

 

 
 

Закладка MeshRepairTools (Рис. 5.7) позволяет редактировать сеточные 

массивы. 

Команда BuildMeshTopology (Рис. 5.7а) позволяет обновлять размеры в 

предварительной сетке. Линейные элементы (1D) будут создаваться между 

элементами оболочки (2D), прикрепленными под углами, превышающими заданный 

угол. Аналогично, узлы (0D) будут создаваться между линейными элементами (1D), 

прикрепленными под углами, превышающими указанный угол. Команда 

автоматически создает полосы между различными частями оболочки, независимо от 

угла между ними. Позволяет выбрать определенные элементы, для которых 

построена топология сетки. 

 

 
  

а) б) в) 

Рис. 5.7 Команды тетра-меширования 

 

Команда RemeshElements (Рис. 5.7б) позволяет исправить один тип элемента, 

который может быть повторно меширован при одном применении команды. 

Выбирается конкретный тип поверхностной сетки из выпадающего списка 

MeshType и затем определяются необходимые элементы. Выбранные элементы 
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сначала удаляются, а затем свободная область повторно мешируется. Размеры 

элементов определяются размером окружающих краев (см. детали в Help). 

Примечание. Эта опция предназначена для плоских подмножеств поверхностной 

сетки и для отдельных объемных частей, но не для искривленных поверхностей или 

целых объемов. 

Команда RemeshBadElements (Рис. 5.7в) имеет аналогичные опции, что и для 

RemeshElements, с той разницей, что удаляются только элементы плохого качества 

из выбранных элементов. 

 

  

 

а) б) в) 

Рис. 5.8 Команды редактирования тетра-сетки 

 

Команда Find/CloseHoles (Рис. 5.8а) определяет отверстия в выбранных элементах и 

меширует их. Определяет соответствующий тип элемента сетки. Определяет 

элементы, в которых можно искать отверстия. Позволяет проецировать новые узлы 

на ближайшую поверхность.  

Команда Mesh from Edges (Рис. 5.8б) позволяет закрывать отверстия, выбирая 

окружающие края. Определяет подходящие элементы сетки. Позволяет выбирать 

края, окружающие отверстия. Позволяет проецировать новые узлы на ближайшую 

поверхность. Интерполирует мешируемую область биквадратичным приближением 

для создания гладкой поверхности. 

Команда Stitch Edges (Рис. 5.8в) (стежка) позволяет «зашивать» промежутки на 

выбранных ребрах путем слияния противоположных узлов, делая сетку с обеих 

сторон согласованной. Если два узла находятся в пределах допуска, они будут 

объединены, а не сшиты вместе. Коэффициент (от 0 до 1) указывает локальный 



66 

 

размер элемента (типичные значения: 0,05-0,2). При необходимости объединяет 

конечные узлы при сшивании выбранных ребер. 

 

  

 

а) б) в) 

Рис. 5.9 Команды редактирования тетра-сетки 
 

Команда Smooth Surface Mesh (Рис. 5.9а) задает автоматический процесс 

улучшения качества выбранных элементов сетки. Общим методом сглаживания 

сетки является сглаживание по Лапласу, которое стремится переместить узлы так, 

чтобы каждый внутренний узел находился в центре тяжести многоугольника, 

образованного его связанными соседями.  

Команда задает элементы поверхности сетки для сглаживания; максимальное 

количество итераций для сглаживания сетки. Точность является относительным 

допуском для качества элемента (от 0 до 1), связанным с размером локального 

элемента. Значение по умолчанию - 0.025. Команда позволяет проецировать новые 

узлы на ближайшую поверхность, а также разглаживает граничные узлы выбранной 

поверхности, создавая гладкие границы. 

Команда FloodFill/MakeConsistent (Рис. 5.9б) приводит к таким же действиям, что и 

Octree meshing процесс (см. детали в Help).  

Команда AssociateMesh with Geometry (Рис. 5.9в) назначает ближайшую часть к 

выбранным элементам сетки. 

Команда Enforce Node (Рис. 5.10а) отслеживает, если узел находится за пределами 

сетки и не является частью сетки (например, узла Weld), параметр Remesh будет 

удалять соседние узлы, чтобы сетка соответствовала расположению узла.  Команда 
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определяет тип сетки, позволяет проецировать перемещенные узлы на ближайшую 

поверхность. 

Если разрешено, проекции на кривые и точки будут проигнорированы при 

повторном мешировании.  

Примечание. Рекомендуется игнорировать проекцию при повторной настройке 

контролируемой области сетки и отключать ее при повторном анализе плохих 

элементов для всей модели. 

 

 

  

а) б) в) 

Рис. 5.10 Команды редактирования тетра-сетки 

 

Команда Make/Remove Periodic (Рис. 5.10б) позволяет управлять периодичностью 

конкретных узлов. Можно проверить существующую периодичность с помощью 

параметров отображения сетки в дереве модели.  

Примечание 1. Чтобы периодичность узлов выполнялась, периодичность должна 

быть определена в Mesh>Global Mesh Parameters. Команда Make Periodic 

позволяет выбирать два узла за раз, чтобы определить периодические пары узлов.  

Примечание 2. Чтобы сделать вершину оси периодической с самой собой, следует 

выбрать только эту вершину, и подтвердить, что выбранная вершина должна быть 

периодической для себя. Команда Remove Periodic удаляет периодичность из 

выбранных узлов. 

Команда Mark Enclosed Elements (Рис. 5.10в) использует материальные точки в 

замкнутом объеме, чтобы пометить все элементы в этом объеме и назначить их 
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принадлежность к той же Volume Part, что и прилагаемая Material Point. При этом 

будет затронута только сетка в частях, содержащих выбранные точки материала. 

Любые элементы в замкнутом пространстве, содержащие Material Point, 

помещаются в данную Volume Part. Если Material Point находится за пределами 

выбранных поверхностей, то все элементы с центроидами за пределами замкнутых 

объемов помещаются в Volume Part. Если есть замкнутый объем, который не 

содержит каких-либо материальных точек, его элементы данной командой не 

затрагиваются. Конечный результат аналогичен результату, полученному с 

использованием Flood Fill, но подход менее ограничен, потому что сетка не 

нуждается в оболочках или гранях, выровненных по окружающим поверхностям. 

Для большинства ситуаций Flood Fill является более надежным и быстрым методом. 

В ситуациях, когда сетка не заполняет поверхность, эту опцию следует использовать 

вместо Flood Fill. 
 

   

а) б) в) 

Рис. 5.11 Команды слияния/разделения узлов, сеток 
 

Закладка MergeNodes (Рис. 5.11) содержит команды, управляющие слиянием 

узлов для улучшения качества сетки при ее редактировании. Кроме того, 

отсоединенные части сетки могут быть объединены вместе.  

Команда Merge Interactive (Рис. 5.11а) позволяет объединить выбранные узлы в 

интерактивном режиме. 

Команда Merge Tolerance (Рис. 5.11б) позволяет объединить узлы, которые 

находятся в пределах определенного допуска. Указывает узлы, которые проверяются 

на наличие близости в пределах допуска, указывает значение допуска. Эта функция 

пытается объединить пары выбранных узлов, близость которых друг к другу 

находится в пределах допуска. Игнорирует ограничения на основе проекции узла во 

время слияния. Например, два точечных спроектированных узла нельзя объединить, 
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поскольку каждый из них ограничен соответствующими точками. Команда 

игнорирует это ограничение и позволяет слить узлы. 

Команда позволяет выбрать всю сетку, но будет выполнять только объединение 

узлов по периметру поверхностной сетки. Внутренние узлы на двойном или 

множественном ребрах не объединены этой опцией, даже если их близость 

находится в пределах допуска. 

Примечание. Для красного цвета ребер с отдельными краями следует нажать правой 

кнопкой мыши Shells> Diagnostics в дереве Display и включить Single edge. 

Команда Merge Meshes (Рис. 5.11в) позволяет объединить отсоединенные части 

сетки, если загружаются два или более домена, а узлы не совпадают на интерфейсе 

между ними. Эти домены обычно создаются отдельно. Объединение будет 

соответствовать узлам, так что связь один-к-одному поддерживается во всем 

объединенном домене. Количество треугольных элементов на интерфейсе одного 

домена должно быть не больше, чем в три раза, количества треугольных элементов 

другого домена. Большие элементы будут разделены на интерфейсе до тех пор, пока 

не достигнут размера элементов другого домена. Может также выполняться слияние 

комбинаций Тетра/Tетра и Tетра/Hexa. При необходимости объединения сеток 

Tetra и Hexa, на интерфейсе будут создаваться пирамиды.  

Примечание. Параметр Merge Meshes может работать хорошо, когда 

четырехугольные элементы на интерфейсе близки к равносторонним. 

 

 
 

 

а) б) в) 

Рис. 5.12 Команды разделения элементов сеток 

 

Закладка Split Mesh (Рис. 5.12) позволяет разделить элементы сетки 

индивидуально.  
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Команда Split Nodes (Рис. 5.12а) позволяет разделить узлы для треугольной сетки и 

переместить их. Оба полученных узла будут иметь одинаковые ограничения (точка, 

кривая или поверхность). Необходимо указать, является ли вершина многообразной 

или нет. Вершины без многообразия - это те, в которых внешние края их смежных 

элементов не образуют замкнутую структуру. Это обычно указывает на элементы, 

которые перескакивают с одной поверхности на другую, образуя «тенто-подобную» 

структуру. (см. примеры в Help). 

Команда Split Edges (Рис. 5.12б) позволяет разделить выделенные ребра пополам. 

Доступна опция Selected , которая  позволяет разделить выбранные ребра. Для этого 

метода также применяется операция разделения ребра, которая распространяется 

через сетку, пока процесс не будет остановлен треугольным элементом или не 

выйдет в область ORFN. Команда проектирует вновь созданные узлы на геометрию. 

Коэффициент расщепления задается между 0 и 1 для определения местоположения 

расщепления по ребру. Примечание. Этот параметр доступен только для Hexa-сетки. 

Команда Swap Edges (Рис. 5.12в) меняет ребра двух смежных треугольников. 

Исходное ребро заменяется ребром, которое соединяет два других угла 

треугольников. 
 

 

 
 

 

 

а) б), в) г) 

Рис. 5.13 Команды разделения элементов сеток 
 

Команда Split Tri Elements (Рис. 5.13а) позволяет разделить выбранные треугольные 

элементы на три треугольника. Разделенное местоположение находится в центре 

тяжести элемента. 
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Команда Split Internal Wall (Рис. 5.13б) создает пары совпадающих треугольников и 

узлов на внутренней стенке. Таким образом, внутренняя стенка логически 

обрабатывается как фактическая стенка с «зазором» между ней и внешней стенкой. 

Этот параметр применим только для Tetra сеток. 

Команда Y-Split Hexas at Vertex (Рис. 5.13в)  разделяет Hexa-элементы в вершине 

по методу Y-Grid. Это можно использовать для разделения вырожденных 

неструктурированных Hexa -элементов пирамидальной или призматической формы 

для улучшения качества, как показано в примере Help. Затрагиваются только 

элементы, связанные с вершиной. Подход также можно использовать для 

поверхностной сетки. 

Команда Split Prisms (Рис. 5.13г) позволяет создать несколько призматических 

слоев, а затем разделить их. Этот метод быстрый и может быть более надежным, чем 

увеличение того же количества призматических слоев с использованием параметра 

Mesh Prism. Имеет следующие опции: 

- Selected Prism Surface Parts 

Определяет выбранные поверхности призмы. При нажатии на значок открывается 

окно со списком частей поверхности призмы. Призматические слои на выбранных 

поверхностных частях будут разделены. Если не выбрана часть сетки, тогда все 

части поверхности призм будут автоматически выбраны. 

- Selected Prism Volume Parts 

Определяет выбранные части объёма призмы. При нажатии на значок откроется 

окно со списком частей объёма призмы. Если выбраны узлы объема, будут 

разделены только призматические слои выбранных частей поверхности, которые 

относятся к этим объёмам. Если объемные части не выбраны, призматические слои 

для всех выбранных частей поверхности будут разделены независимо от объёма. 

- Method 

Определяет метод разделения призматических слоев. 

- Fix ratio 

Позволяет разделить призматические слои таким образом, чтобы указанное 

отношение Prism ratio применялось к его результирующим слоям. 

- Fix initial height 

Позволяет разбить первый слой таким образом, чтобы высотой его первого подслоя 

была заданная начальная высота слоя. 

- Number of layers 

Определяет количество слоев, получаемых от каждого существующего уровня. 

- Split Only Specified Layers 
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Позволяет разделить только определенные слои призмы. 

- Layer numbers (0,1,2...) 

Указывает, какие слои призмы должны быть разделены. Первый призматический 

слой имеет номер 0, второй слой - 1 и т.д. 

- Do Not Split Attached Pyramids 

Когда эта опция включена, пирамидальные элементы, прикрепленные к 

призматическим слоям, не будут разделены. По умолчанию этот параметр отключен. 

Примечание. Использование этой опции может приводить к зависанию узлов в 

сетке, потому что множественные боковые грани призмы будут покрыты одной 

лицевой стороной пирамиды. Последующая проверка сетки обнаруживает 

непокрытые грани и ошибки ориентации поверхности. 

 

 

 

 

 

а) б) в), г) 

Рис. 5.14 Команды перемещения и выравнивания узлов 

 

Закладка Move Nodes (Рис. 5.14) используется для перемещения узлов с 

использованием различных методов. Узлы, проецируемые в заданную точку, не 

могут перемещаться. Узлы, которые проецируются на кривую, будут ограничены 

активными кривыми. Узлы, проецируемые на поверхность, будут ограничены 
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активными поверхностями. Внутренние объемные узлы могут перемещаться вдоль 

плоскости, определенной экраном. Ниже приведены различные варианты команд 

перемещения узлов. 

Команда Interactive (Рис. 5.14а) позволяет выбирать узел левой кнопкой мыши и 

перемещать его в интерактивном режиме. 

Команда Exact (Рис. 5.14б) позволяет изменять координаты выбранных узлов. Узлы 

могут перемещаться по отдельности или относительно базового местоположения. 

Одновременно можно выбирать и изменять несколько узлов. Как правило, эта 

функция используется для изменения числа узлов по одной конкретной координате, 

например Y=0 для обеспечения истинной плоскости симметрии. 

 

 

 

 

 

 

а) б), в) г), д) 

Рис. 5.15 Команды перемещения и выравнивания узлов 

 

Команда Offset Mesh (Рис. 5.14в) управляет смещением сетки. 

Определяет элементы оболочки, подлежащие смещению путем выбора элементов 

оболочки для смещения в нормальном направлении. Нормальное направление 
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элементов, как выбранных, так и связанных с выбранными, должно быть 

последовательным. Определяет расстояние до смещения выбранных элементов.  

Примечание. Смещение изменяет местоположение узлов, но не изменяет число 

выбранных элементов. Местоположение нового узла основывается на нормальном 

направлении всех элементов, связанных с данным узлом. 

Команда Align Nodes (Рис. 5.14г) выстраивает узлы в заданном направлении. 

Выбираются два узла, для определения опорного направление. Указываются узлы, 

которые должны быть выровнены по указанному опорному направлению. 

Команда Redistribute Prism Edge (Рис. 5.15а) позволяет перераспределять 

призматические слои с указанной постоянной толщиной первого слоя или 

определенным коэффициентом роста, охватывающим толщину локального слоя 

призм. Эта опция работает со слоями призм, а также с комбинацией слоев призм и 

сгущающимися гекса-слоями. Призматический слой ограничен тремя параметрами, 

которые определяют четвертый параметр (см. раздел Prism Meshing Parameters). 

Общая высота устанавливается при росте слоя призм и может варьироваться, если 

оставлена начальная высота - ноль. Количество слоев может быть установлено при  

росте слоя призм или скорректировано с помощью разделенных призм (см. команду 

Split Prisms). Исходное отношение высот устанавливается в команде Prism Meshing 

Parameters, но может регулироваться с помощью команды Redistribute Prism Edge. 

Команду Total Height and Number of Layers можно использовать для регулировки 

начальной высоты или отношения высот при вычислении  остальных параметров. 

Примечание. Перераспределение не будет перемещать узлы, связанные с 

пирамидами, но будет перераспределять другие призмы в этом слое и выше. 

Команда Project Node to Surface (Рис. 5.15б) позволяет проектировать узлы на 

поверхности. Содержит несколько опций управления. 

Команда Project Node to Curve (Рис. 5.15в) позволяет проецировать выбранный узел 

на ближайшую кривую или заданную кривую. Движение узла будет ограничено 

вдоль кривой. 

Команда Project Node to Point (Рис. 5.15г) позволяет проецировать выбранный узел 

в заданную точку с определенным допуском. 

Команда Un-Project Nodes (Рис. 5.15д) позволяет отменить проецирование 

спроецированного узла. Затем узлу будет разрешено неограниченное перемещение. 

Команда Lock/Unlock Elements (Рис. 5.16а) позволяет блокировать или 

разблокировать элементы. Заблокированные элементы предотвращают 

автоматические операции, такие как сглаживание сетки или укрупнение при 
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перемещении узлов. Заблокированные элементы можно выделить, включив Mesh> 

Locked Elements в Дереве отображения. 

Команда Snap Project Nodes (Рис. 5.16б) позволяет проектировать узлы на 

соответствующую геометрию. Управление осуществляется несколькими способами 

с помощью управляющих параметров.  

Команда Update Projection   (Рис. 5.16б) обновляет проекцию всех узлов в сетке. 

Узлы будут проецироваться на поверхность, кривую или точку. 

Команда Project Nodes to Plane (Рис. 5.16в) позволяет проецировать узел на 

плоскость.  

Примечание. Эта команда похожа на Project Nodes to Surface, за исключением того, 

что она не требует поверхности и обеспечивает меньший контроль над тем, как 

выполняется проецирование. 

 

   

а) б) в) 

Рис. 5.16 Команды перемещения и выравнивания узлов 

Закладка EditMesh>TransformMesh  на функциональной панели может 

использоваться для преобразования части или всей сетки. Для управления имеются 

различные параметры. Примечание. Закладка полезна, когда область сетки имеет 

симметрию. Одна часть домена может быть сгруппирована, а затем повернута или 

переведена, чтобы охватить полный домен. По структуре и функциональности 

данная закладка аналогична закладке Geometry>TransformGeometry (Рис. 4.2г). 

Закладка Adjust Mesh Density (Рис. 5.17) позволяет измельчить или укрупнить 

всю сетку или только в определенном месте. Это относится только к треугольным 

поверхностным элементам, квадратам и тетра-элементам. При измельчении 
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треугольных поверхностных элементов, если тетра-элементы соединены с 

элементами трех поверхностей, тетра-ребра, соединенные с треугольниками, будут 

разделены так, чтобы сетка оставалась согласованной. Аналогичным образом, 

измельчение тетра-элементов будет разделять смежные тетра-ребра, чтобы сетка 

оставалась согласованной. Элементы в тетраэдральной или тетра/призматической 

гибридной сетке будут укрупнены путем сжимания ребер (слияние узлов) и 

удаления вырожденных элементов, но, если будет получаться элемент с 

соотношением сторон более указанного, операция не будет выполняться. Степень 

укрупнения (отношение количества элементов до и после укрупнения) 

автоматически определяется и сообщается в окне сообщений. Отсоединенные 

вершины автоматически удаляются после укрупнения. 

Команда Refine All Mesh (Рис. 5.17а) измельчает все видимые отображаемые 

элементы. Описаны различные методы измельчения (см. примеры в Help). 

Команда Refined Selected Mesh (Рис. 5.17б) измельчает выбранные элементы из 

сетки. Методы измельчения выбранной сетки такие же, как описано в Refine All 

Mesh. 

Команда Coarsen All Mesh (Рис. 5.17в) укрупняет все видимые отображаемые 

элементы. В Help описаны различные нижеперечисленные параметры укрупнения.  

- Min aspect ratio  

Минимальное отношение сторон позволяет получить полученные укрупненные 

элементы. Чем меньше минимальное соотношение сторон, тем больше элементов в 

сетке будет укрупнено. 

- Max size 

Является наибольшим размером тетра элемента, разрешенным укрупнением. 

Элементы ниже этого размера будут укрупняться и только до этого размера. Чем 

больше это значение, тем значительнее сетка будет укрупнена. 

- Max Surface Deviation 

Для поверхностных элементов (треугольников) эта опция укрупняет элементы, 

основанные на расстоянии от центра тяжести элемента до поверхности, в 

направлении, перпендикулярном поверхности. Если это расстояние меньше 

заданного Max Surface Deviation, элементы будут укрупнены. 

- Number of Iterations 

Это количество сглаживающих итераций. Сглаживание будет автоматически 

выполняться после процесса укрупнения, если это число отлично от нуля. 

- Coarsen surface 
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Если эта опция разрешена, то поверхностные треугольные элементы также будут 

укрупнены. Если отключена, только объемные элементы типа тетра и призмы 

укрупняются. 

- Maintain surface sizes 

Если эта опция разрешена, делается попытка сблизиться с размерами, 

предписанными геометрией (точки, кривые и поверхности). Локальное укрупнение 

может быть достигнуто таким образом, только изменяя размеры тетраэдров в 

конкретных объектах. Когда создается тетра-сетка, элементы делятся на эти 

размеры. Включение этой опции предотвращает выполнение каких-либо 

укрупнений. 

- Parts to freeze 

Опция определяет части, которые замораживаются. Узлы этих частей останутся 

фиксированными. 

Команда Coarsen Selected Mesh (Рис. 5.17г) укрупняет выбранные из сетки 

элементы.  

 

 

 

 

а) б), в) г) 

Рис.5.17 Команды согласования сеточной плотности 
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Закладка Renumber Mesh (Рис. 5.18) перенумеровывает все элементы, 

нумерация ячеек от минимума до максимума выполняется в определенном 

направлении. Этот прием используется для ускорения вычислений решения.  

В команде Renumber Method (Рис. 5.18а) применяются следующие опции: 

- Renumber Elements  

Позволяет перенумеровать элементы. 

- Starting element number 

Начинает нумерацию элементов с указанного номера. 

- Element number range 

Указывает диапазон существующих номеров элементов. 

- Renumber Nodes 

Позволяет перенумеровать узлы. 

- Starting node number 

Запускает нумерацию узлов с данного номера узла. 

- Node number range 

Дает диапазон существующих номеров узлов. 

- Method 

- By Parts (по частям) 

Перенумеровывает элементы и/или узлы в одной части за раз. 

- All elements/nodes 

Перенумеровывает все элементы и узлы. 

- Selected Elements  

Перенумеровывает только выбранные элементы. 

- Selected nodes 

Перенумеровывает только выбранные узлы. 

- Direction 

Направление глобальных осей, в котором можно перенумеровать элементы или 

узлы. Например, для оси X направление равно 1 0 0. 

- Skip 0-numbered Elements and Nodes 

Если опция включена, то нулевые элементы и узлы будут пропущены при 

перенумерации. 

Команда Optimize Bandwidth (Рис. 5.18б) перенумеровывает узлы для минимизации 

ширины  матрицы элементов/узлов. 

Команда Adjust Mesh Thickness Options (Рис. 5.18в). выполняет настройку 

параметров толщины сетки.  
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Примечание. Равномерную толщину оболочки можно также применить в свойствах 

Properties>Define2DElementProperties, но это определение сохраняется в файле 

атрибута, а не в сетке (см. детали в Help). 

 

 

 

 

а) б) в) 

Рис.5.18 Команды нумерации ячеек 

 

Закладка Reorient Mesh (Рис. 5.19) переопределяет нормали выбранных 

элементов или всех элементов определенным образом. 

Команда Reorient Volume (Рис. 5.19а) переориентирует нормали отображаемых 

элементов для направления внутрь объема или наружу. По умолчанию все нормали 

граней будут переориентированы, чтобы указывать внутрь домена, если нет ошибок 

ориентации. 

Команда Reorient Consistent (Рис. 5.19б) выравнивает все нормали отображаемых 

элементов с одинаковой ориентацией (внутрь или наружу) как в выбранном 

элементе. Эта команда работает для всех элементов, связанных с областью 

выбранного элемента поверхности. Любая сетка, отсоединенная от этой сетки, не 

будет затронута. Эта операция будет работать с пересечением разных частей.  

Команда Reverse Direction (Рис. 5.19в) обращает нормали выбранных элементов, 

выбирает элементы на дисплее, ориентация которых должна быть изменена. Это 

приводит к изменению нормали только тех элементов, нормаль которых находится в 

противоположном направлении относительно  экрана. 
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Команда Reorient Direction (Рис. 5.19г) изменяет нормальное направление 

отображаемых элементов в соответствии с заданным вектором X Y Z. Так как 

нормаль грани может указывать только на два возможных противоположных 

направления, нормаль будет указывать в направлении, ближайшем к направлению 

указанного вектора 

Команда Reverse Line Element Direction (Рис. 5.19д) обращает направление 

линейного элемента. 

 

 

 

 

 

 

 

а), б) в), г) д), е) 

Рис.5.19 Команды согласования ориентации граней 

 

Команда Change Element IJK (Рис. 5.19е) осуществляет четыре различных метода 

для изменения индексов IJK элемента. 

- IJK -> KIJ 

Для выбранного элемента(ов) индексы будут изменены с IJK на KIJ. 

- Set Origin 

Для выбранного элемента(ов) начало координат будет установлено в указанном узле. 

- Align Element 

Выравнивает все элементы со ссылкой на выбранный элемент. 

- Set IJK 
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Позволяет установить текущие индексы IJK выбранного элемента(ов) на новые 

индексы IJK. 

Закладка Convert Mesh Type (рис. 5.20, 5.21) преобразует один тип элемента в 

другой. 

Команда Tri to Quad (Рис. 5.20а) позволяет преобразовать треугольную 

поверхностную сетку в четырехугольную поверхностную сетку. Это применимо для 

всех видимых поверхностей. 

 

 

 

 

 

а) б), в) г) 

Рис.5.20 Команды конвертирования сеточных элементов 

 

Команда Quad to Tri (Рис. 5.20б) делит каждый четырехугольный элемент на два 

треугольника. Диагональный край будет размещен так, чтобы максимально 

увеличить минимальный внутренний угол. 

Команда Tetra to Hexa (Рис. 5.20в) позволяет конвертировать тетра-сетку в 

гексаэдральную сетку. Данная команда подразделяет выбранные tetra -элементы на 

четыре гекса- элемента, создавая узел в центре tetra, в центре тяжести трех сторон 

тетраэдра. Четыре  hexa -элемента создаются путем соединения этих узлов (см. 

детали в Help). 
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Команда All Types to Tetra (Рис. 5.20г) преобразует все типы элементов в tetra-

элементы. Выбранные элементы не обязательно должны принадлежать к 

специальному начальному типу элемента. 

 

 

 
 

а) б) в) 

Рис.5.21 Команды конвертирования сеточных элементов 

 

Команда Shell to Solid (Рис. 5.21а) преобразует 2D-элементы в 3D-элементы. 

Если включена опция Selected elements, можно выбрать те 2D-элементы, которые 

должны быть экструдированы в 3D-элементы. 

Опция Thickness позволяет указать значение толщины трехмерных элементов. Если 

включена опция Square Corners, будут сформированы прямые углы. 

Команда Create Mid Side Nodes (Рис. 5.21б) позволяет создавать средние узлы на 

всех элементах сетки для последующего измельчения сетки и согласования с 

границами (см. детали и примеры в Help). Если включена опция Mid Face Node, 

узлы будут создаваться в центре каждой грани. Опция Create Node On Interface 

используется при создании средних боковых узлов на интерфейсе между 

выбранными элементами и прикрепленными к ним элементами. Если опция 

включена, то края присоединенных элементов аппроксимируются квадратичным 

сплайном. Если отключена, то ребра, которые являются общими для выбранных 
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элементов и прикрепленных элементов, останутся линейными. Если включена опция 

Project to Geometry, вновь созданные узлы будут проецироваться в ближайшую 

геометрическую поверхность. 

Команда Delete Mid Side Nodes (Рис. 5.21в) позволяет удалять средние боковые 

узлы. Средние узлы могут быть удалены из всей сетки или из выбранных 

элементов/узлов двумя разными способами.  

Здесь можно отметить следующие опции. 

- Elements or Nodes: Можно выбрать любые элементы или узлы. 

- Selected Elements/Nodes: Если эта опция включена, она позволяет удалять узлы 

средней части из выбранных элементов или удалять выбранные квадратичные узлы. 

- Convert Quadratic Elements To Multiple Linear Elements: 

Если эта опция выключена, она просто удалит Midside/Midface узлы, не нарушая 

никаких других узлов. Если эта опция включена, эта опция будет уточнять сетку 

таким образом, чтобы Midside/Midface узлы стали узлами сетки. 

 

5.7 Выбор солвера и сеточные форматы 

 

Для выбора солвера используется красная панель инструментов на вкладке 

«Output».  Доступ к этому же меню осуществляется с помощью настроек Settings 

>Solver, где доступны 123 формата. Все выходные форматы могут быть установлены 

выпадающим меню Output Solver. Помощь по каждому формату можно найти на 

веб-сайте ANSYS: 

http://www.ansys.com/Products/Other+Products/ANSYS+ICEM+CFD/ 

Выход + Интерфейсы / выход + Интерфейсы + TOC 

Сеточные форматы. Существует 2 типа форматов сетки, которые читают 

солверы.  

Формат неструктурированной сетки. Большинство солверов используют 

неструктурированные форматы в силу их универсальности, например, Fluent, Ansys 

CFX, CFD ++, Abaqus, Ansys. Узлы неструктурированных сеток характеризуются 

идентификатором и местоположением. Неструктурированная сетка ICEM CFD 

имеет расширение *.uns, и может быть создана из любого сеточного формата в 

ICEM CFD. 

Формат многоблочной структурированной сетки. Некоторые (старые) 

решатели CFD требуют формат многоблочной структурированной сетки. Например, 
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Plot3D, CFX-TASCFLOW, KIVA-3V. Формат CGNS допускает как 

неструктурированные, так и многоблочные структурированные сетки. Узлы имеют 

обозначение и местоположение индекса (i, j, k).  

Структурированная сетка ICEM CFD состоит из многих файлов: Project.1, 

project.2, project.3 и т.д. Для каждого домена сетки создается файл топологии 

topo_mulcad_out.top, который описывает, как каждый домен подключен к другому 

домену. Также создается файл Project.multiblock, который позволяет выбрать все 

файлы многоблочной сетки для этого имени проекта, выбрав этот один файл. Только 

блоковая система ICEM CFD может быть представлена в многоблочном 

структурированном формате. 
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6. ПОСТРОЕНИЕ ГЕКСАГОНАЛЬНОЙ СЕТКИ 

 

Гексагональная сетка (сокращенно гекса-сетка) создается в ANSYS ICEM CFD 

на основе блочной структуры (каркаса) рассматриваемой области. Каждый блок 

разбивается квазиортогональной сеткой на основе гексаэдров. Блоковые элементы 

структуры – грани, ребра, и вершины гексаэдров проектируются на геометрию 

рассматриваемой области. Блоковая структура сохраняется в независимом файле и 

может быть загружена в топологически эквивалентную геометрию для дальнейшего 

использования. 

 Существует два различных подхода создания блочной структуры: 

а) подход «скульптора», который заключается в погружении объекта в общий блок и 

последующем отсечении лишних частей для описания геометрических форм 

объекта; 

б) создание блока на части объекта и последующее вытягивание или надстраивание 

всей блочной структуры для всего объекта. Возможно комбинирование этих двух 

подходов. 

Блочный подход использует то же геометрическое описание объекта, что и 

тетрагональная идеология (tetin-файл). При построении блочной структуры объект 

может быть неодносвязным, иметь дыры. Точки и кривые не являются критичными 

при построении блочной структуры, но весьма полезны как опорные элементы.  

Для эффективного построения кривых и точек полезно предварительно 

использовать команду геометрии RepairGeometry>BuildDiagnosticTopology. Также 

введение опорных элементов целесообразно закладывать в структуру объекта при 

его создании в какой-либо CAD программе. 

После построения блочная структура проектируется на особенности геометрии 

объекта: поверхности проектируются автоматически с участием ручного 

управления; кривые и точки проектируются вручную. 

В целом процесс построения гекса-сетки заключается в следующем. Строится 

блоковая структура, топологически эквивалентная геометрии объекта. Затем 

блоковая структура ассоциируется с геометрией, ребра ассоциируются с кривыми, 

вручную или автоматически двигаются вершины блоков до совпадения с 

геометрическими положениями на объекте. При необходимости используется 
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сплайн-интерполяция. Далее задаются сеточные размеры и распределения узлов на 

ребрах, строится предварительная сетка, проверяется ее качество и делается запись 

сетки под формат выбранного солвера. 

 

6.1 Основные команды управления блочной структурой 

Построение гексагональной сетки выполняется в предварительно 

подготовленной к построению (см. раздел 3) расчетной области.  
 

 

Рис. 6.1. Закладка Blocking  
 

  

 

 

а) б) в) 

Рис. 6.2. Содержание закладки CreateBlock  
 

Построение стартует с закладки Blocking>CreateBlock (рис.6.1). Далее 

выполняется выбор из пяти способов инициализации, либо преобразования блока 
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(рис.6.2). Среди них – простое построение блока методом охвата, построение блока 

по восьми точкам (рис.6.2б), вытягивание блока из какой-либо грани (рис.6.2в), 

вытягивание 3D блока из 2D блока и обратная операция (рис.6.2в). 

 

 

 

 

 

 

 

 

 

а), б) в), г) д), е), ж), з) 

Рис. 6.3. Содержание закладки SplitBlock 
 

После создания блока становятся доступными остальные закладки.  
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Следующая закладка SplitBlock открывает набор команд, направленных на 

расщепление блока. 

Первая команда SplitBlock (рис. 6.3а) разбивает выделенный блок указанием на 

ребро.  

Вторая команда O-Grid Block (рис. 6.3б) на основе существующей блоковой 

системы создает О-подблоковую систему (голубой цвет ребер) для дальнейшего 

создания О-сетки. 

Третья команда  Extend Split (рис. 6.3в) позволяет расширять разделение блоков на 

выбранный край или на все ребра. Можно выбрать определенные блоки или все 

видимые блоки для расширения разделения (см. Documentation for ANSYS ICEM CFD). 

Четвертая команда  Split Face (рис. 6.3г) позволяет разделить грань в нужном месте. 

Выбирается ребро, где будет выполняться разделение, и удерживается ЛК, чтобы 

переместить курсор на этом краю в нужное место разделения. Затем отпускаем ЛК и 

нажимаем СК, чтобы зафиксировать местоположение и завершить операцию 

разделения грани. 

Пятая команда Split Vertices (рис. 6.3д) содержит параметр, который позволяет 

разбить вырожденную вершину. Это эквивалентно расщеплению ребра. Вершина, 

выбранная для разделения, является результатом свертывания одного блока. 

Выбираем подходящую вершину для разделения и нажимаем Apply, чтобы 

разделить вершину 

Шестая команда Split Free Face (рис. 6.3е) позволяет разделить свободную грань 

блока, которая разбивает блок на два свободных блока. 

Седьмая команда Imprint Free Face (рис. 6.3ж) позволяет отпечатывать границы 

одной стороны на неструктурированный 2D-поверхностный блок. Это действие 

также выполняется автоматически для разметки блоков, когда используется опция 

«Создать блок»> «2D-3D»> «Заполнить»> «Дополнительно»; но в некоторых 

случаях полезно делать это вручную, прежде чем использовать 2D-3D-заливку. 

Восьмая команда Split Free Block (рис. 6.3з) позволяет расщепить свободный блок 

на структурированные и развернутые блоки. Эта операция требует, чтобы вначале 

были созданы листы блока, которые затем будут использованы для разделения 

свободного блока. Свободный блок можно разделить на несколько томов за одну 

операцию. Затем можно преобразовать блокированные свободные блоки в 
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структурированные или развернутые блоки по мере необходимости. Листовые 

блоки, используемые для разделения свободного блока, являются внутренними 

гранями, которые проходят через объем. В версии ICEM CFD 14.5 поддерживаются 

только структурированные листы (см. Documentation for ANSYS ICEM CFD). 

Закладка Merge Vertices (рис. 6.4) предлагает параметры пользователя для 

объединения (слияния) двух или нескольких точек. При слиянии нескольких вершин 

необходимо их объединить.  

Команда Merge Vertices by Tolerance (рис. 6.4б) позволяет объединить только те 

узлы, которые соответствуют указанному пределу допуска. Следует выбрать 

вершины, которые нужно объединить, и указать значение допуска. 

Команда Collapse Block (рис. 6.4в) позволяет свернуть блок или ребро, уменьшив 

одно или несколько ребер до нулевой длины. Это изменяет топологию остальных 

невырожденных блоков. Выбираем ребро, чтобы определить направление, которое 

должно быть свернуто до нулевого размера. В интерактивном режиме можно 

добавлять блоки, которые будут свернуты в указанном направлении.  
 

 

 

 

 

а) б), в) г) 

Рис. 6.4 Содержание закладки MergeVertices 
 

Команда Merge Vertex to Edge (рис. 6.4г) позволяет объединить выбранную 

вершину и ребро. Выбранное ребро будет разделено и объединено с выбранной 

вершиной. Это чаще всего используется, когда область между ребром и вершиной не 
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содержит блоков, а две несвязанные топологии, которые не имеют совпадающих 

вершин, могут быть объединены. 

 Закладка EditBlock (рис. 6.5) используется для изменения существующих 

блоков. В частности, команда MergeBlocks (рис. 6.5а) позволяет объединить 

несколько блоков в один большой блок.  

Команда MergeFaces позволяет объединить грани и соответствующие им блоки. 

Достаточно выбрать грани, которые нужно объединить, пометив узлы граней.  

 

 

 

 
 

 

 

 

 

а), б) в), г) д), е) 

Рис. 6.5. Содержание закладки EditBlock 
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Команда ModifyOgrid (рис. 6.5б) позволяет изменять масштабный коэффициент 

Ogrid, допускает управление масштабированием Ogrid. Если абсолютное 

расстояние отключено, значение смещения работает как коэффициент, умноженный 

на текущий размер O-сетки, где значения меньше 1 приводят к меньшей области O-

сетки, а значения больше 1 дают большую область O-сетки. Если абсолютное 

расстояние включено, значение смещения представляет собой новую длину 

радиального ребра O-сетки. Сброс свойства ортогональности Ogrid может изменять 

ортогональность при перемещении вершин. 

Команда PeriodicVertices (рис. 6.5в) позволяет преобразовать выбранные пары 

вершин в периодические узлы. Позволяет выбирать пары узлов, которые должны 

быть периодическими преобразованиями друг друга. Грань является периодическим 

преобразованием другой грани, если ее четыре узла являются периодическими 

преобразованиями узлов другой грани.  

Команда ConvertBlockType (рис. 6.5г) позволяет преобразовывать блоки в 

следующие типы (см. Руководство пользователя> Hexa> Hexa Block Types для 

описания различных типов блоков) - Mapped, Free, Swept, Y-block, 3D Mesh Free 

Block. 

Команда ChangeBlockIJK (рис. 6.5д) позволяет изменять индексы IJK блока. 

Команда Renumber Blocks (рис. 6.5е) позволяет перенумеровать блоки. 

Закладка Associate (Рис. 6.6.) используется для установления соответствия 

различных элементов блоковой системы.  

Команда AssociateVertex (Рис. 6.6а) позволяет связывать вершины и проектировать 

вершину на себя, точки, кривые и поверхности.  

Команда AssociateEdgeТoCurve (Рис. 6.6б) позволяет связать грани блоков с 

кривыми. Вершины в краях ребер также связаны с одной и той же кривой, если они 

ранее не были связаны с другой кривой или точкой. Пограничные сегменты могут 

быть индивидуально связаны после использования разбиений по ребрам. Несколько 

ребер могут быть связаны с несколькими кривыми, но все кривые будут 

сгруппированы в одну составную кривую.  

Примечание. Связывание ребер с кривыми приводит к созданию элементов линии 

вдоль этих кривых. Для двумерного плоского блока важно, чтобы все грани по 
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периметру были связаны с кривыми периметра, так как некоторые солверы 

используют элементы периметра в качестве границ. 

Команда EdgeТoSurface (Рис. 6.6в) позволяет связывать грани блоков с 

поверхностями. Цвет выбранных граней станет белым/черным, указывая, что узлы 

на этом ребре будут проецироваться на ближайшую активную поверхность. По 

умолчанию ребра и грани между двумя блоками (граничные грани) будут 

автоматически ассоциироваться с ближайшей активной поверхностью. Связанные 

вершины и граничные расщепления также будут связаны с ближайшей активной 

поверхностью. При перемещении вершин или разбиений граней движение не будет 

регистрироваться, пока курсор не пройдет над активной поверхностью. Необходимо 

убедиться, что вершины или разветвления грани движутся по правильной 

поверхности. 

Команда AssociateFaceТoSurface (Рис. 6.6г) позволяет выполнить настройку граней 

к геометрии. По умолчанию ребра и грани между двумя граничными гранями блоков 

будут автоматически ассоциироваться с ближайшей активной поверхностью. 

Нажатием значков выбираются грань и часть поверхности.  

Команда Disassociate from Geometry (Рис. 6.6д) позволяет отключить выбранное 

ребро, поверхность или грань, связанную с геометрией. Выбор различных объектов, 

которые нужно отключить, может выполняться индивидуально или совместно. 

Замечание. Любая ассоциация может быть удалена (ничего не связывает), однако 

можно легко перезаписать ассоциации, не деассоциируя их. Например, если ребро 

связано с кривой, можно напрямую связать его с поверхностью, и не нужно сначала 

деассоциировать его. 

Команда Update Associations (Рис. 6.6е) позволяет устанавливать ассоциации с 

ближайшими объектами назначенного типа. 

Команда Reset Associations (Рис. 6.7а) сбрасывает ассоциации внешних блоковых 

объектов обратно на связь с ближайшим объектом. 

Команда Snap Project Vertices (Рис. 6.7б) позволяет проецировать все вершины, 

связанные с соответствующими точками, кривыми или поверхностями. Для 

проецирования вершин доступны следующие действия: 

1)проектирование всех видимых вершин для своего объекта; 

2)проектирование выбранных вершин на соответствующие объекты. 
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3)перемещение внутренних узлов (не проецируемых), которые прикрепляются через 

ребро O-сетки к внешним узлам (проецируемым) относительно проекции. 
 

 

 

 
 

 

 

 

 

а), б) в), г) д), е) 

Рис. 6.6 Содержание закладки Associate. Часть 1 

 

Примечание. Проецирование применяется только к активным частям. 

Проецирование не будет зависеть от объектов, которые закрыты, но включены в 

видимые части. Если наложен запрет на перемещение узлов в определенные 

объекты, они должны быть помещены в отдельную отключенную часть. 

Команда AutoAssociate (Рис. 6.7в) позволяет связать ребра с кривыми. 

AutoAssociation рассматривает топологию поверхностей и топологию блока и 

пытается связать проекции ребер блока по отношению к топологии блока. 
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Команда Group/UngroupCurves (Рис. 6.7г) позволяет группировать кривые в 

составную кривую или разгруппировать составные кривые на отдельные кривые. 

Это необходимо, например, для привязки ребра к набору кривых. Кривые сначала 

должны быть сгруппированы в составную кривую, а затем ребро может быть связано 

с этой составной кривой. Композитные кривые можно отобразить, щелкнув ПК на 

Curves в дереве дисплея и выбрав опцию Show Composite. 
 

 

 

 
 

 

 

 

а) б), в) г) 

Рис. 6.7 Содержание закладки Associate. Часть 2 
 

Закладка MoveVertex (Рис. 6.8) применяется для перемещения, коррекции 

положения вершин. 

Команда Move Vertex (Рис. 6.8а) позволяет изменить местоположение вершины. 

После фиксации ограничений выбираем вершину для перемещения. Выбираем 

вершину, используя ЛК, согласуем выделение СК, либо через ПК отменяем выбор.  
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Команда Set Location (Рис. 6.8б) позволяет перемещать вершины, задавая их 

местоположение через задание координат и точки отсчета (см. Documentation for 

ANSYS ICEM CFD). 

Команда Align Vertices (Рис. 6.8в) позволяет выровнять вершины вдоль ребра к 

выбранной опорной вершине с помощью плоскостей. Указывается плоскость, в 

которой будут перемещаться вершины. 

Команда Align Vertices In-line (Рис. 6.8г) позволяет выровнять вершины с вдоль 

определенной линии. Нужно выбрать две точки, чтобы определить опорное 

направление линии, а затем выбрать вершины для выравнивания по этой линии 

Команда Set Edge Length (Рис. 6.8д) позволяет изменить длину ребер явно. 

Необходимо выбрать ребро(а), которое нужно изменить, и указать длину. 

Команда Move Face Vertices (Рис. 6.8е) позволяет перемещать или поворачивать 

вершины грани. 1) Перемещение вершин граней. Выбираем грань, вершины которой 

должны быть перемещены. Указываем направление, введя вектор смещения, или 

выбрав начальную и конечную точки для перемещения вершин грани. 

2) Повернуть вершины. Выбираем поворотные вершины, центральную точку и угол 

поворота. Указываем ось вращения, введя вектор или выбрав начальную и конечную 

точки. 

Закладка TransformBlocks (Рис. 6.9) позволяет управлять преобразованиями 

блоков. 

Команда Translate Blocks (Рис. 6.9а) позволяет перенести исходную блоковую 

топологию в направлении заданного вектора. 

Команда Rotate Blocks (Рис. 6.9б) позволяет вращать исходную топологию блока. 

Задается ось вращения путем выбора X, Y, Z или другого вектора. Задается значение 

угла, на которое блок должен повернуться. Определяется центр вращения. 

Команда Mirror Blocks (Рис. 6.9в) позволяет отразить топологию относительно трех 

заданных плоскостей, плоскостей YZ, XZ, XY или любой плоскости, нормальной к 

определенному вектору. Указывается точка отражения как начало координат, центр 

тяжести или определяемая пользователем точка. 
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а) , б) в), г) д), е) 

Рис. 6.8. Содержание закладки MoveVertex 

 

Команда Scale Blocks (Рис. 6.9г) позволяет масштабировать топологию. Следует 

указать масштабный коэффициент и центр трансформации как начало. 
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а) , б) в) г), д) 

Рис. 6.9. Содержание закладки TransformBlocks 

 

Команда Copy Periodic Blocking (Рис. 6.9д) позволяет скопировать блок для 

периодических моделей. Эта функция полезна, когда модель содержит 

периодическую симметрию, но геометрия существует только для одного сектора. 

Блок сначала строится по геометрии сектора, а затем геометрия и блок копируются и 

поворачиваются для формирования полной модели. 

Закладка EditEdge (Рис. 6.10) дает возможность редактировать ребра, в 

частности ребра подблоков О-сетки. 

Команда Split Edge (Рис. 6.10а) позволяет редактировать грани блоков, используя 

следующие типы расщеплений: сплайны, линейную аппроксимацию (см. 

Documentation for ANSYS ICEM CFD). 
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Команда Unsplit Edge (Рис. 6.10б) позволяет удалять расщепление ребер. Для метода 

Single выбираем вершину разделяемого ребра для удаления. Для метода All 

выбираем ребро, чтобы удалить все расщепления. 

Команда Link Edge (Рис. 6.10в) позволяет установить форму ребер. Выберите 

целевые ребра, а затем ребро источника формы. При этом метод Selected 

устанавливает форму только выбранного ребра. Метод Interactive - позволяет 

установить форму целевого ребра в интерактивном режиме. Метод In dimension - 

автоматически устанавливает форму для всех связанных ребер. Выбираются 

источниковое ребро для параметра Link Edge Dimension, источниковый индекс или 

вершина, и целевой индекс или вершина. 

Команда Unlink Edge (Рис. 6.10г) позволяет удалить формы ребер, связанных 

опцией Link Edge. 

Команда Change Edge Split Type (Рис. 6.10д) позволяет изменить тип разделения 

ребер (например, изменить сплайн на линейную аппроксимацию). Доступны опции 

Spline, Linear и Control Point. 

 
 

 

 

 

 

 

 

а), б) в), г) д) 

Рис. 6.10. Содержание закладки EditEdge 
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Закладка PreMeshParams (Рис. 6.11) задает параметры сетки в системе блоков. 

Команда UpdateSizes (Рис. 6.11а) позволяет обновлять размеры в предварительной 

сетке Pre-Mesh. Следующие опции доступны для обновления размеров в Pre-Mesh:  

UpdateAll вычисляет интервал узлов ребер на основе ограничительных соотношений 

с использованием закона сетки BiGeometric (по умолчанию). Можно отрегулировать 

количество узлов на каждом ребре на основе Global Surface или Curve Mesh Size, и 

по умолчанию каждое ребро будет следовать закону геометрии BiGeometric. 

Примечание 1. Закон сгущения по умолчанию и коэффициент сгущения указаны в 

разделе Settings > Meshing > Hexa/Mixed. Примечание 2. Можно проверить 

распределение, применив Blocking > Edge > Show Edge, чтобы убедиться, что 

каждое ребро соответствует закону сетки BiGeometric. 

Команда Scale Sizes (Рис. 6.11б) позволяет масштабировать размер ячейки 

глобально. 

Команда Edge Params (Рис. 6.11в) позволяет детально изменить параметры сетки, 

указав различные законы сгущения и расстояние между узлами вдоль любого ребра. 

Каждое ребро имеет несколько параметров, которые определяют расстояние между 

сеткой вдоль ребра: количество узлов, закон сгущения, начальную длину в 

начале/конце ребра. Команда Edge Params отображает окно со всеми параметрами 

сетки. После выбора ребра будут отображены параметры сетки для этого ребра. Все 

значения параметров могут быть изменены, за исключением заданных границ Edge 

ID и EdgeLength. 

Примечание. Параметризовать параметры ребра можно также с помощью 

переменных в файле сценария воспроизведения. 

Команда Match Edges (Рис. 6.11г) позволяет сопоставлять расстояние между краями 

опорного ребра до целевого ребра соединения. Расстояние между узлами на конце 

целевого ребра, которое соединяется с базовым ребром, будет изменено в 

соответствии с интервалом между узлами на базовом ребре. 

Команда Refinement (Рис. 6.11д) позволяет уточнять разбиение блоков по 

масштабному коэффициенту. Значение уровня больше 1 приведет к измельчению, в 

то время как значение уровня меньше 1 приведет к укрупнению предварительной 

сетки Pre-Mesh. 
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Рис. 6.11. Содержание закладки PreMeshParams 

 

Закладки на рисунке 6.12 PreMeshQuality/Smooth (а,б), BlockChecks (в), 

DeleteBlock (г) предназначены для улучшения качества построенной гекса-сетки. 

Закладка PreMeshQuality (рис. 6.12а) строит гистограмму качества сетки на 

основе критериев по выбору пользователя. Критериев насчитывается несколько 

десятков (см. Documentation for ANSYS ICEM CFD). Наиболее употребительны 

детерминанты. 

Закладка PreMeshSmooth (рис. 6.12б) сглаживает полученную сетку на основе 

количества итераций, ограничения на качество на основе выбранного критерия, и 

строит гистограмму ее качества. 
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а) б) в), г) 

Рис. 6.12. Содержание закладок PreMeshQuality/Smooth (а,б), BlockChecks (в), 

DeleteBlock (г) 

 

Закладка BlockChecks (рис. 6.12в) проверяет качество блоков на основе 

следующих методов: 

- Run Check/Fix- проверяет внутренние структуры данных на наличие 

несоответствий и исправляет их, если это возможно. 

- Fix Inverted Block - исправляет все перевернутые блоки. Инвертированные блоки 

имеют отрицательный детерминант. 

- Invert Selected Block Method - инвертирует выбранные блоки. 

- Pack Block Numbers - автоматически пересчитывает все блоки в последовательном 

порядке. Это делается для того, чтобы избежать очень больших номеров блоков, 

которые могут возникнуть после повторного редактирования блока и 

восстановления VORFN-блока. 

Закладка DeleteBlock (рис. 6.12г) позволяет удалить блоки из топологии. Опция 

Delete по умолчанию отключена. Если Delete постоянно отключена, блок будет 

перемещен в область VORFN.  

Область VORFN по существу неактивна, и сетка не вычисляется для нее, 

однако эта область помогает поддерживать связи. Блоки могут быть извлечены из 
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области VORFN с помощью опции AddBlocks to Part. Если Delete будет включена, 

блок будет удален навсегда. В этот момент связи будут нарушены, и область 

VORFN будет перестроена. Это может быть полезно в некоторых ситуациях, но это 

также приведет к повторной индексации блоковой структуры. Полученная 

индексная структура обычно более сложна и с ней труднее работать. 

Команда PreMesh запускается в ветке Blocking дерева модели. Для 

формирования сеточного файла в формате *.cfx5  необходимо деструктурировать 

сетку, выбрать солвер (см. пример Приложения 2).  
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7. ПРОГРАММНЫЙ КОМПЛЕКС ANSYS CFX. 

 

Основой расчетной технологии  ANSYS CFX является солвер Algebraic 

Coupled Multigrid. Используя  неявную  связанную  схему интегрирования 

линеаризованной системы  уравнений Навье-Стокса, данный решатель обеспечивает 

достаточно быструю и  устойчивую сходимость  для всех типов задач.  При этом 

время решения задачи находится примерно в линейной зависимости от мощности 

расчетной сетки.  

Преимущество ANSYS CFX проявляется  при  расчете больших моделей с 

многокомпонентными течениями и сложной структурой. Солвер ANSYS CFX слабо 

чувствителен к отношениям размеров элементов, временным шагам и 

релаксационным факторам. Точность решения  достигается как за счет высокой 

точности в пересчете на узел, так и схемой дискретизации второго порядка, 

устанавливаемой по умолчанию. Эти свойства сохраняются при распараллеливании 

расчетов, обеспечивая удовлетворительные параметры ускорения на 

многопроцессорных платформах и кластерах рабочих станций. 

Точность моделирования опирается на физические модели, используемые в 

расчете. ANSYS CFX содержит значительное количество физических  моделей для 

обеспечения приемлемых результатов  широкого диапазона промышленных задач. 

Все физические модели могут взаимодействовать друг с другом на любой топологии 

сетки, с применением всех типов интерфейсов областей расчета, используя 

связанный многосеточный солвер, в том числе и при распараллеливании счета. 

Опыт, накопленный научным сообществом в моделировании многофазных 

потоков позволил применять разнообразные физические модели, допускающие 

расчет потоков из нескольких фаз, их взаимодействие, свободные поверхности и 

учет эффекта поверхностного натяжения. Модель движения твердых частиц 

(Lagrangian Particle Transport) позволяет учесть одну или несколько дискретных 

примесей в однородном потоке. Модель межфазного тепло- и массообмена 

позволяет рассчитывать кипение, испарение и кавитацию. 

Вращающиеся потоки. ANSYS CFX обеспечивает CFD-технологии 

моделирования для взаимно вращающихся потоков. Несколько типов интерфейсов 
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между расчетными областями облегчают моделирование «статор-ротор» 

взаимодействия. Пре- и постпроцессор содержат специальный режим описания для 

анализа гидродинамики в турбомашинах. 

Моделирование турбулентности. Большинство течений являются 

турбулентными, и ANSYS CFX содержит более 16 моделей турбулентности, 

позволяющих учесть детализацию течения. В качестве зарекомендовавших себя 

моделей используются k-eps и SST модели с автоматическими пристеночными 

функциями.  Для более сложных течений, с высокой анизотропностью 

турбулентности, применяются модели рейнольдсовых напряжений (RSM). Среди 

зональных моделей турбулентности, помимо LES  и DES-формулировок, существует 

смешанная модель DES-SST, более корректно учитывающая пристенные эффекты. 

Интересной опцией является переходная модель турбулентности на основе SST-

модели турбулентности (SAS SST), созданная специально для турбомашиностроения 

и аэрокосмической промышленности. 

Теплообмен.  Оптимизация теплообмена между потоком  и  твердым телом 

является типичной задачей для многих отраслей промышленности. Возможности 

ANSYS CFX позволяют решать подобные задачи в трехмерной постановке с учетом 

сопряженного теплообмена и теплопроводности твердого материала. 

Радиационный теплообмен. Широкий выбор моделей радиационного 

теплообмена позволяет учесть такие эффекты, как преломление, отражение, 

частичное отражение и поглощение. Эти эффекты крайне важны при анализе 

горения, теплообмена и вентиляции. 

Горение. В уравнениях, описывающих стехиометрические реакции, 

взаимодействие  всех компонентов реакций учитывается  одновременно,  что 

улучшает  сходимость  решения  в  сложных реакциях.  Представлены такие модели 

горения как EDM, FCR и Flamelet-типов, позволяющие рассчитывать горение как  

полностью, так и частично перемешанных смесей. 

Жидкостно-структурное взаимодействие. Программный комплекс ANSYS, 

используя специальные  решения  как в  структурном анализе, так  и в 

гидрогазодинамике позволяет моделировать связанные задачи аэроупругости, 

сопряженного теплообмена. Подобный подход дает возможность добиваться  

результатов  как  в  каждой  отдельной области, так и на интерфейсе между ними. 



105 

 

Подвижные сетки. В тех случаях, когда геометрия  расчетной  области 

изменяется в процессе работы устройства, например, в шестеренчатых и 

мембранных насосах, поршневых компрессорах и двигателях, корректное 

моделирование возможно только с  учетом эффекта подвижных сеток. ANSYS CFX 

позволяет работать  с подобными расчетными моделями, в том числе совместно с 

ANSYS Mechanical/Multiphysics.  

CFD-постпроцессинг. В CFX-Post в интуитивно понятном интерфейсе 

содержатся эффективные средства постпроцессинга, в том числе качественный и 

количественный анализ результатов. Средства отображения графической 

информации  дают возможность проанализировать структуру потока с помощью 

изоповерхностей, сечений, векторов, траекторий и многих других методов. Анализ  

количественных результатов с помощью встроенных функций позволяет  получить 

более точное представление о характеристиках модели. Специализированный 

модуль Turbo-Post дает возможность анализировать аэродинамику турбомашин с 

помощью типичных для них представлений (Meridional, Theta, Span). 

Параллелизация вычислений. Используя любую комбинацию имеющихся 

вычислительных ресурсов, ANSYS CFX позволяет уменьшить время расчета и 

выполнить большие по объему задачи. Все без исключения физические модели 

могут быть распараллелены. При этом достигается такая же сходимость и точность, 

как и при обычном расчете.  

Эффективность ANSYS CFX основана на совокупности проверенных и 

лидирующих в своей области технологий в каждом элементе программного 

комплекса. Именно это обстоятельство обеспечивает точность, надежность, 

скорость, гибкость, и дает результаты при применении. 

 

7.1 Работа c запускающей программой CFX Launcher программного 

комплекса ANSYS CFX. 

ANSYS CFX Launcher  запускается двойным кликом иконки . Далее 

Пользователь выбирает рабочую директорию, имя которой набрано латинскими 

литерами и цифрами, и в процессе выполнения проекта последовательно вызывает 
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ANSYS CFX-Post (рис. 7.1) нажатием на соответствующие иконки.  

 

7.2. Cтруктура программного комплекса ANSYS CFX 

 

Структура работы программного комплекса ANSYS CFX состоит из подготовки 

данных к сеточной модели в препроцессоре, решателя или солвера, и обработки 

полученных данных в постпроцессоре (Рис.7.1). 
 

Входные файлы Подпрограмма Выходные файлы 

.res -> CFX-Pre -> .def 

.res -> CFX-Solver Manager-> .out 

.res -> CFX-Post -> .png, и др. 

 

) принимает сеточную модель от построителя сетки, формирует граничные условия, 

в частности, интерфейсы на некоторых границах, задает свойства рабочего тела 

(жидкость, газ, смесь и т.д.), формирует условия решения задачи (стационарное или 

нестационарное течение), точность решения и задает модель турбулентности, либо 

. Последний файл является файлом постановки задачи и принимается как входная 

информация решателя. Препроцессор также может использовать уже готовые файлы 

, а также файл предыдущего решения *.res для преобразования или новой 

постановки задачи. 

 и генерирует в процессе интегрирования уравнений Навье-Стокса, осредненных по 

Рейнольдсу-Фавру, и уравнений модели турбулентности, бинарный файл решения с 

, и текстовой файл с расширением *.out, содержащий подробную информацию об 

особенностях решения. Его расшифровка для пользователя представляет особый 

интерес и будет дана ниже.  

Солвер также формирует директорию решения, которая содержит 

вспомогательные файлы, файл распараллеливания *.par , файл мониторинга *.mst  и 

другие файлы. При запуске расчета солвер на основании граничных условий по 

умолчанию формирует начальное приближение к решению задачи. По заказу 

пользователя солвер может принимать также один или несколько бинарных файлов с 
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 для использования в качестве начального приближения к последующему решению 

задачи. При изменении сеточной модели солвер производит интерполяцию 
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Постпроцессор (CFX-Post), является отдельной программой и предназначен для 

визуализации результатов расчета и обработки данных. (Рис.7.1). 

 
 

Рис. 7.1 Инструментарий вычислительного комплекса 
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7.3 Работа с препроцессором ANSYS CFX PRE 
 

Препроцессор подключен к программе запуска ANSYS CFX Launcher, и 

запускается нажатием кнопки ANSYS CFX-Pre (рис. 7.2). Далее импортируется 

сетка в формате *.cfx5 последовательностью команд: File>NewCase>General; 

. Необходимо задать единицы измерения длины, соответствующие использованным в 

ANSYS ICEM CFD. Следует, однако, помнить, что по умолчанию результаты 

расчетов в постпроцессоре выдаются в основных единицах системы СИ.  

General Mode применяется для общих целей и использует базовый CFX-Pre 

интерфейс. Остальные моды специализированы, с их возможностями можно 

ознакомиться в Help Tutorial ANSYS CFX-Pre (Xpre.pdf).  
 

  

a) б) 

Рис.7.2 Панель запуска ANSYS CFX (a) и выбор моды симуляции (б) 

 

ANSYS CFX-Pre принимает сеточную модель от построителя сетки, формирует 

граничные условия, в частности, интерфейсы на некоторых границах, задает 

свойства рабочего тела (жидкость, газ, смесь и т.д.), формирует условия решения 

задачи (стационарное или нестационарное течение), точность решения, и задает 

модель турбулентности, либо ламинарный режим. Препроцессор формирует 
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 для преобразования или новой постановки задачи. Примечание. Здесь и везде 

вместо звездочки подразумевается имя проекта (файла). 

Просмотрщик или Viewer отрисовывает импортированную геометрию и сетку, 

и позволяет манипулировать положением геометрического тела. 

Структура исходного окна CFX-Pre состоит из просмотрщика с линейкой и 

осями координат, и нескольких панелей: функциональной, меню утилит (рис.7.3), 

исходного дерева модели, окна сообщений, операций с геометрией. Новые домены и 

другие объекты появляются в дереве модели. Сообщения в окне сообщений, 

отмеченные красным шрифтом, указывают на некорректности формулировки 

физического процесса или модели.  

 

Рис. 7.3. Панель исходного вида ANSYS CFX-Pre 
 

Домены определяют область используемых материалов и физических моделей, 

используют различные системы координат – вращающиеся стационарные. 

Применяются различные типы доменов - жидкие, твердые, пористые. Все 

подобласти, опирающиеся на одни и те же физические законы, могут быть 

сгруппированы в один домен. Опорное (базовое) давление (Reference Pressure) 
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рекомендуется устанавливать в соответствии с рабочим давлением устройства, либо 

принимать нулевые значения. 

Рассмотрим основные закладки Исходного вида (рис. 7.4). 

 Обеспечивает доступ ко всем действиям с сеткой: импорт, преобразования, операции 

с представлением/визуализацией. 

 Позволяет задать один или несколько анализов моделирования. 

. Позволяет сформулировать и редактировать задачу. 

Предполагает получение стационарного решения или нестационарное состояние.  

– области моделирования, могут быть названы собственными именами. Позволяют 

задать и редактировать тип, свойства жидкостей, газов, пористых и сплошных тел; 

режимы взаимного движения и устанавливать соответствующие интерфейсы. 

 
Рис. 7.4 Содержание дерева модели 

 

Boundary – граница. Применение команды-закладки позволяет задать тип 

границы и в закладках сформулировать граничные условия. Формулировка 
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граничных условий является принципиально важной для правильного и успешного 

решения задачи о течении среды в канале или вокруг тела. Допускается задание 

данных на границе в виде массивов параметров в привязке к системе координат.  

При постановке задачи важно учитывать точность, реалистичность условий на 

границах доменов и всей области. Например, однородный профиль скорости обычно 

не реалистичен, но может быть использован на подходящем расстоянии выше по 

течению. Следует также по возможности избегать постановки граничных условий в 

циркуляционных зонах.  

Хорошо обусловленные граничные условия (ГУ). Постановка ГУ на границах 

расчетной области требует избегать переопределения либо недоопределения 

параметров. Это условие следует из формулировок соответствующих задач 

математической физики. Например, в случае течения жидкости через канал задание 

массового расхода или скорости на входной границе, статического давления на 

выходной границе является физически оправданным и хорошо математически 

обусловленным для несжимаемой жидкости.  

ainInterfaces - условия на интерфейсах контактирующих доменов. Позволяет задать 

и редактировать метод соединения сеток или доменов, способ передачи параметров в 

процессе решения. 

SolverControl – управление параметрами процесса решения. Позволяет задание 

и редактирование единиц измерения величин в решении, временного шага, точности 

выхода на результат, управление выводом данных результата. Временной шаг (Time 

Step) важен для управления солвером в процессе решения. Уменьшение временного 

шага обеспечивает более высокую устойчивость процесса решения, но и более 

медленную сходимость. Солвер останавливает расчет при достижении оценки 

невязок по RMS до 1e-04, либо менее по заказу пользователя (RMS - 

среднеквадратичная оценка отклонения параметра). Возможна установка условия на 

дисбаланс по расходу либо импульсу, например, ниже 1%, а также параметров в 

контрольных точках.  

OutputControl – управление процессом выдачи промежуточных и 

окончательных результатов расчета. Кроме стандартных мониторов допускается 

выдача значений в зарезервированных точках, интегральных параметров на 

поверхностях. 

. Создает, импортирует, редактирует свойства материалов и химические реакции.  

Закладка используется для создания, редактирования и построения выражений, 

функций пользователя, подпрограмм пользователя и дополнительных переменных. 
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. Позволяет задать управление анализом в моделировании. Позволяет включение 

распараллеливания задания на расчет между несколькими узлами или ядрами 

процессора. 

. Позволяет изменить графический стиль, уровни, маркеры и общие опции вместо 

опций, заданных по умолчанию. 

Особую роль играют закладки DefaultDomain > BasicSettings / FluidModels / 

Initialization  
 

  

Рис. 7.5 Структура команд меню утилит 
 

DefaultDomain – ассоциируется с именем (по умолчанию) всей области. 

Вкладка BasicSettings содержит описания материала, его морфологии, базового 

давления, модели плавучести, движения области. Вкладка FluidModels определяет 

теплоперенос (требует согласования с граничными условиями), режим движения 

среды (ламинарный/турбулентный), предлагает модель турбулентности, модель 

горения, модель теплового излучения, модель электромагнитных свойств. 
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Вкладка Initialization позволяет инициализировать начальное приближение для 

расчета. Для простых областей начальное приближение строится автоматически. 

Правдоподобные начальные условия обеспечивают устойчивость работы солвера на 

начальном этапе в течение первых нескольких итераций.  

Клик правой кнопкой мыши (ПК) на любом объекте дерева вида выводит 

короткое меню команд (рис.7.5). Отметим некоторые важнейшие команды. 

 Открывает CCL - диалоговый режим. 

.  Открывает диалоговый режим импорта сетки. 

. Перезагружает сеточные файлы в случае их повреждения, либо замены на новые 

сеточные файлы. 

. Открывает диалоговый режим модифицирования (вращения, переноса, отражения, 

изменения масштаба) сетки. 

. Позволяет сформировать файл запуска расчета, запустить солвер. 

Содержание команд меню утилит в некоторой степени дублирует функции 

значков функциональной панели 

 

7.4. Особенности моделирования турбулентности [1, 23 ] 

 

Турбулентность в измерениях проявляется в виде случайных пульсаций 

параметров течения в широком диапазоне частот и масштабов; представляет собой 

неустановившееся непериодическое течение, в котором переносятся масса, импульс, 

энергия. 

Турбулентность возникает при доминировании инерционных свойств течения 

над вязкими, и представляет собой каскад неустойчивостей ламинарных фрагментов 

течения.  

Турбулентным течениям присущи свойства диффузности и диссипативности. 

Капельность при возникновении турбулентности не является определяющим 

свойством.  

Турбулентное течение является вращательным в принципе и представляет 

иерархию вихрей, состоящих в прямом/обратном каскадном процессе обмена 

энергией пульсаций; поэтому турбулентность трехмерна и нестационарна.  

Турбулентность содержит широкий спектр масштабов вихрей, размер 

наибольших имеет порядок основного течения. Крупные вихри генерируют энергию 

из основного течения, энергия передается от крупных вихрей к более мелким; в 
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самых мелких вихрях турбулентная энергия преобразуется во внутреннюю энергию 

с помощью вязкой диссипации; этот процесс называется прямым энергетическим 

каскадом. 

Турбулентность является свойством течения сплошной среды и не 

распространяется до молекулярных масштабов.  

Статистические результаты усреднения в механизмах переноса турбулентности 

позволяют моделирование турбулентности. 

Режим течения может быть охарактеризован числом Рейнольдса, ReL

U L


 , 

которое определяется характерным масштабом, скоростью основного течения, 

кинематической вязкостью. Из опытов Рейнольдса следует, что ламинарный 

(слоистый) режим реализуется при числах Re 2300 , однако является 

неустойчивым. 

Прямое численное моделирование (DNS) 

Теоретически, все турбулентные, переходные и ламинарные течения могут быть 

численно разрешены в полной системе уравнений Навье-Стокса (N-S). Разрешается 

весь спектр масштабов частот пульсаций. Моделирование каких-либо процессов не 

требуется. Однако DNS требует чрезвычайно мелкой сетки, высокого порядка 

точности схемы интегрирования, специальных граничных условий, и потому 

является чрезвычайно затратным для большинства течений. Не имеет инженерного 

применения. 

Моделирование больших вихрей (Large Eddy Simulation) (LES) 

В этом случае решаются пространственно осредненные с применением фильтра 

N-S уравнения. Большие (отфильтрованные) вихри разрешаются, вихри, меньшие 

фильтра (сеточного размера) моделируются специальным образом. Менее затратное, 

чем DNS, моделирование, однако, чрезвычайно затратное для большинства 

практических приложений. 

Уравнения Навье-Стокса, осредненные по Рейнольдсу-Фавру (RANS) 

Используются осредненные по времени RANS уравнения. При этом все 

турбулентные масштабы моделируются, разработаны различные модели 

турбулентности. Данный подход широко применяется для расчета промышленных 

течений. Осреднение по ансамблю, иначе по времени, может быть использовано для 

описания свойств течения в среднем. Любая величина, например мгновенная 

скорость ui,  при осреднении расщепляется на среднюю и пульсацию. Уравнения 

RANS для импульса имеют вид: 
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,  

где ij i jR u u   
 
называются рейнольдсовыми напряжениями.  

Рейнольдсовы напряжения в силу нелинейности уравнений Навье-Стокса – 

являются дополнительными неизвестными, введенными процедурой осреднения, 

они должны моделироваться (на основе средних величин) для замыкания системы 

основных уравнений. Это замыкание является предметом моделей турбулентности. 

Проблема замыкания относит неизвестные рейнольдсовы напряжения к 

известным (разрешаемым) переменным с использованием дополнительных 

уравнений. Эти уравнения и представляют собой модели турбулентности. 

Все модели турбулентности содержат эмпирику. Эти уравнения не могут быть 

выведены всецело из фундаментальных законов. Калибровка моделей производится 

на основе опытных данных и анализа решений. 

RANS модели могут быть сформулированы на основе двух подходов. 

1) На основе модели вихревой вязкости  

T T

2 2

3 3
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Согласно гипотезе Буссинеска рейнольдсовы напряжения моделируются на основе 

вихревой (турбулентной) псевдовязкости, 
T .  Гипотеза работает для простых 

турбулентных сдвиговых слоев: пограничных слоев, круглых струй, слоев смешения, 

каналовых течений и т.п. 

2) На основе модели рейнольдсовых напряжений (RSM) и уравнений переноса 

для рейнольдсовых напряжений. RSM-модель более предпочтительна в сложных 3D 

турбулентных течениях со значительной кривизной линий тока и развитыми 

вихревыми структурами, однако модель высокозатратна и менее устойчива, чем 

модели вихревой вязкости. 

CFX препроцессор обеспечивает разнообразие моделей, некоторые из них 

имеют специальное применение, другие применяются для широкого класса течений 

с разумной степенью достоверности. 

Модели турбулентности в общем случае описывают течение вне погранслоя. 

Масштабирование безразмерного профиля скорости вблизи стенки и на интервале 

безразмерного расстояния до стенки указывает на автомодельный характер профиля 

для широкого класса течений. 
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Таким образом, пристеночные условия достаточно предсказуемы, и поэтому 

могут быть использованы аппроксимации для определения пристенных профилей 

вместо использования мелкой сетки для действительного разрешения профиля 

(Рис.7.6). Такие аппроксимации называются пристенными функциями (Wall 

Functions). 

Переменная y+ - безразмерный размер в погранслое; используется для оценки 

расстояния первого узла от стенки. Пристенные функции работают только со 

специальными значениями y+ . Именно, если y+ принимает большие значения, 

первый узел сетки выходит за пределы погранслоя, и пристенные функции выходят 

за пределы области погранслоя (Рис.7.6). 

 
Рис. 7.6. Количество узлов в погранслое [1] 

 

При малых y+, первый узел лежит в ламинарной (вязкой) части погранслоя, где 

пристенные функции не аппроксимируют параметры течения. Поэтому в погранслое 

обычно требуется несколько узлов сетки при использовании пристенных функций. 

В некоторых случаях, например, при отрыве погранслоя, пристенные функции 

некорректно предсказывают профиль скорости в погранслое. В этом случае 

пристенные функции неприменимы. Следует, однако, помнить, что не все модели 

турбулентности допускают отключение пристенных функций. 
 

7.5 Краткий обзор моделей турбулентности, применяемых в CFX [1,23]. 
 

Стандартная k- модель. Это промышленный стандарт CFD, т.к. предлагает 

удовлетворительный компромисс численной эффективности и точности. 

Пристенные функции здесь встроены и используются всегда. Величина y+ должна 
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быть < 300 для эффективности пристенных функций. Солвер CFX использует 

масштабируемые пристенные функции. Масштабируемость означает, что узлы 

вблизи стенки игнорируются, если сетка в y+ величинах ниже значимого предела 

пристенных функции.   

Модель k-. Одно из преимуществ k- модели - это разрешение пристенных 

течений для низкорейнольдсовых расчетов. Термин “низкорейнольдсовы расчеты” 

означает, что пристенная сетка является достаточно мелкой для разрешения 

ламинарной (вязкой) части погранслоя, очень близкой к стенке. Низкорейнольдсова 

k- модель требует 2y  , при применении низко-рейнольдсовой k- модели 

требуются значительно меньшие значения y+ . В промышленных течениях значение 

2y   не может быть гарантировано в  большинстве приложений.  

Модель переноса сдвиговых напряжений (Shear Stress Transport - SST). 

SST модель основана на суперпозиции k- и k- моделей и имеет аналогичную 

трактовку пристенных функций. Модель учитывает перенос турбулентных 

сдвиговых напряжений и дает улучшенное их предсказание и размеры отрывных 

областей. Это хороший выбор при прочих равных факторах. 

При применении SST или  k- моделей y+ должен быть < 300, в этом  случае 

подход на основе пристенных функций работает. Это условие не даст преимуществ 

низкорейнольдсовой формулировки, которая необходима для аккуратного 

предсказания отрывных областей. Однако, подход может быть использован на более 

грубых пристенных сетках и давать правдоподобные результаты, в рамках 

ограничений пристенных функций. Для получения полного преимущества 

низкорейнольдсовой формулировки y+ должен удовлетворять условию y+ < 2.  

Полезно предварительно оценить y+ до получения сетки и решения. Для этого 

может быть использована формула для течения вдоль плоской пластины: 
13/1474 ReLy Ly   , где 

 

- y  - необходимое расстояние между стенкой и первым узлом; 

- L - масштаб длины в течении; 

- y+ - желаемое значение y+; 

- ReL - число  Рейнольдса, основанное на масштабе длины L. 

Вывод этой формулы дан в документации: ANSYS CFX-Solver Modeling Guide >> Turbulence and 

Near-Wall Modeling >> Modeling Flow Near the Wall >> Guidelines for Mesh Generation 

Успешное моделирование турбулентности требует инженерных представлений 

относительно физики течения, доступных компьютерных ресурсов, требований 

проекта по точности, времени его исполнения. 
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7.6. Работа с решателем CFX-Solver Manager 

Manager подключен к программе запуска ANSYS CFX Launcher, и инициируется 

Manager (рис. 7.2). 

 

Рис.7.7 

В данном окне при запуске команды File>Define Run появляется окно 

приглашения файла с расширением решения *.res (продолжение счета), либо файл 

постановки задачи с расширением *.def, (рис. 7.7). В окне задается директория и 

предлагается задать спецификацию на начальные условия (продолжение счета с 

варианта, либо объединения вариантов). Задается тип расчета (по умолчанию Full, 

либо только модуль распараллеливания Partitioner), выбор двойной точности 

DoublePrecision, и RunMode - использование одного ядра (Serial), либо 

параллелизация расчета между процессорами (Platform MPI DistributedParallel) 

или ядрами (Platform MPI LocalParallel). Если поставлен флажок расширенного 

управления (ShowAdvancedControl), то появляются закладки Partitioner, Solver, 

Interpolator, в которых могут быть заданы настройки распараллеливания, настройки 
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солвера и интерполятора. Такие настройки важны для больших проектов, в которых 

могут потребоваться расширения заказов оперативной памяти сверх ресурсов, 

выставленных по умолчанию. Детали процедуры и параметры распараллеливания 

описаны в CFX-Solver Manager >Help. После нажатия кнопки Start в процессе 

расчета солвер генерирует файл с расширением *.out и ряд служебных файлов. 

 

7.7. Структура файла с расширением *.out, сопровождающего процесс решения 

Файл написан на языке Physics definition CFX Command Language (CCL). 

Файл начинается с описания директории, в которой работает солвер и содержания 

командной строки. Далее указывается выписка о характеристиках материала, с 

которым работает солвер из библиотеки материалов.  

 

 

 

Далее приводятся данные об интерполяции с файла начальных данных, если 

таковой был задан для решения задачи 
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Также приводятся данные о запросе памяти для интерполятора. В некоторых 

случаях эти данные помогают устранить ошибку о недостаточной памяти путем 

выделения дополнительной памяти в стартовой операции. 

Затем приводятся детали процесса интерполяции. 

 
 

 

 

Если решение выполняется на нескольких потоках, то запускается процесс 

распараллеливания Partitioning всей задачи на части. При этом в рабочей 

директории формируется файл с расширением *.par, который может использоваться 

в дальнейшем, минуя этап распараллеливания. 

Здесь также выставляются требования к памяти для распараллеливания. Иногда 

солвер требует выделения для этого дополнительной памяти. Выводятся также 

детали процесса распараллеливания и метод. 

 



121 

 

 

 

 

Старт процесса решения. Здесь требования к памяти относятся к процессу 

решения.  
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В процессе компиляции солвер определяет качество сетки и приводит 

статистику.  

 

 

Далее выполняется диагностика процесса сходимости решения. Появляется 

выдача (промежуточного) итога по текущему внешнему циклу итерации. 

 

Во время решения выводится диагностика процесса сходимости решения к 

окончательному результату. Здесь Rate=Rn/Rn-1, RMS Res и Max Res означают 

среднеквадратичное и максимальное отклонения остаточного члена (невязки) в 

соответствующем уравнении движения, Linear Solution показывает точность 

предварительного линейного решения, символы OK, ok, F(alse) дают качественную 

характеристику полученного приближения в соответствующих уравнениях. 
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Последние два символа могут появляться и игнорироваться в стартовых итерациях, в 

процессе решения их появление может исчезать за счет улучшения исходного поля 

решения, уменьшения временного шага или перестроения сетки. 

 При завершении решения выводятся дисбалансы величин. 

 

 

out файла включают силы и моменты на стенках, максимальные и минимальные 

значения переменных и требования процессора к решению. 
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В целом, *.out файл содержит информацию о физике решения, ходе и условиях 

расчета.  

out файлом в текстовой форме выводятся графики невязок решения по уравнениям, 

характеристики модели турбулентности по умолчанию. Графики величин в окне 

монитора формируются пользователем. Пользователь может заказывать другие 

параметры, создавать индивидуальные функции на элементах объекта к выводу в 

графическом окне. 

Ниже дано стандартное окно вывода текущей информации о процессе 

сходимости решения к установившемуся состоянию. Состояние окна вывода может 

быть сохранено, в том числе, и в качестве рисунка. Команда на сохранение 

появляется нажатием ПК на поле монитора.  
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Командный язык CFX Command Language (CCL) – объектно-

ориентированный язык высокого уровня, позволяющий легко описывать параметры 

задачи и процесса решения. Может применяться пользователем для составления 

инструкций к Пре- и Постпроцессору. 
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7.8 Работа с постпроцессором ANSYS CFD-Post 
 

Модуль CFD-Post, иначе постпроцессор, является отдельной программой и 

предназначен для визуализации результатов расчета и обработки данных (Рис.7.8). 
 

 

Рис. 7.8. Панель исходного вида ANSYS CFD- Post 

 

CFD-Post - это постпроцессор для продуктов ANSYS CFD (CFX и FLUENT). 

Он может работать как автономный постпроцессор или будучи встроенным в рамки 

Workbench.  

CFD-Post включает все возможные объекты и локализации построения: 

плоскости, изоповерхности, векторы, линии тока, контуры, анимации. Позволяет 

производить точный количественный анализ: определять средневзвешенные 

значения величин, силы, выполнять Фурье-анализ величин, производить сравнение 

результатов, использовать встроенные и созданные пользователем макросы. Может 
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создавать пользовательские скалярные/векторные переменные. Выполняет 

автоматические отчеты, строит диаграммы (в переменных XY, во времени), 

гистограммы, составляет таблицы. Поддерживает файлы сеанса (сценарии), файлы 

состояний, языки команд и выражений (включая язык программирования Perl). Для 

локализации полей CFD-Post строит координатные плоскости, поверхности, точки, 

облака точек, изоповерхности, поверхности переменных с заданным значением, 

изоклипы, использующие копии любого существующего местоположения, и 

скрепляющие их одним или несколькими критериями.  

В CFD-Post доступно описание области вихревого ядра (Vortex Core Region), 

используемой для автоматической идентификации вихревых областей, особенно 

применительно к LES. В CFD-Post могут быть построены поверхности вращения с 

зарезервированными опциями для цилиндра, конуса, диска и сферы, поверхности 

вращения, образованные из произвольных линий, полилиний. Существуют 

дополнительные возможности создания произвольных поверхностей, включая 

считывание данных по точкам из файла другой задачи. Допускается трансформация 

поверхностей: вращение, масштабирование существующих поверхностей, смещение 

существующей поверхности в направлении нормали или трансляцией. 

При активировании в CFD-Post геометрических и газодинамических объектов 

типа: Locations, Vector, Contour, Streamline, в нижней правой части возникает окно 

детализации объекта с рядом закладок. 

Визуализация обеспечивается настройками цвета, рендеринга и просмотра. 

CFD-Post позволяет выбрать переменные в определенных локализациях, установить 

диапазон (глобальный, локальный, пользовательский) и выбрать цветовую шкалу, 

провести рендеринг, степень прозрачности, установить освещение, изобразить 

поверхности твердых границ. 

Постпроцессор подключен к программе запуска ANSYS CFX Launcher, и 

запускается нажатием кнопки ANSYS CFD-Post. Далее импортируется результат 

расчета *.res (*.bak) последовательностью команд: File>LoadResults (Рис. 7.9). При 

наличии сценария построения модели *.cst он может быть загружен также 

. Верно и обратное: сценарий после построения может быть сохранен командой 

 

Единицы физических величин настраиваются ПК на поле Вида(View) 

командой ViewerOptions, а также в EditOptions . Здесь же настраиваются другие 
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функции, например, свойства мыши, цвет экрана, формат текста и т.д. Описание 

команд Import/Export/Report можно найти в Help Tutorial ANSYS CFD-Post. 

Структура исходного окна CFD-Post состоит из просмотрщика с линейкой и 

осями координат, и нескольких панелей: функциональной, меню утилит (рис.7.8), 

исходного дерева модели, окна сообщений, операций с геометрией. Новые объекты 

появляются в дереве модели. 

Клик правой кнопкой мыши (ПК) на любом объекте дерева вида выводит 

короткое меню команд. Отметим важнейшие команды закладки File. 

Открывает CCL диалоговый режим; 

- Открывает диалоговый режим импорта сетки; 

- Перезагружает сеточные файлы в случае их повреждения, либо замены на новые 

сеточные файлы. 

Закладка Insert  дублируется в Инструментах функциональной панели. Закладка 

 дублирует команды калькуляторов и часть команд панели операций  

Слева от команд панели операций размещены закладки Outline, Variables, 

Expressions, Calculators, Turbo.  

Закладка Outline является основной, содержит указания на основную модель, 

ее части, сеточные домены, локализации пользователя, шаблоны отчетов. 

Инструменты Vectors, Contour и Streamlines используют существующие 

локализации в качестве основы. Возможно построение любой векторной 

переменной; проектирование векторов Normal или Tangential на базовый объект. 

При визуализации на панели «Details» отображается информация для 

выбранной переменной. Поле «Unit» позволяет изменять отображаемые единицы 

при построении переменной. 

Новые пользовательские значения сохраняются в файле результатов, поэтому 

можно закрыть CFD-Post и сохранить данные. Старые значения могут быть 

восстановлены. 

Об определении гибридных и консервативных переменных. Конечные объемы, 

используемые CFX-Solver, не совпадают с  элементами сетки, так как узлы сетки 

лежат в центре контрольных объемов. Значения параметров хранятся в файле 

результатов в узлах и представляют собой «средние» значения по контрольному 

объему. Вблизи границ стенок существует половина контрольного объема с 

некоторой представительной ненулевой скоростью. Эта ненулевая скорость 
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сохраняется на узле стенки, но по граничным условиям скорость на стенке должна 

быть равна нулю. Таким образом, консервативные переменные - это значения в 

контрольном объеме, гибридные значения - значения граничных условий. 

Для визуализации CFD-Post по умолчанию использует гибридные значения в 

связи с необходимостью показывать нулевые скорости на стенках. В расчете солвер 

использует консервативные значения, которые удовлетворяют законам сохранения. 

Правило действует только применительно к результатам, полученным CFX. Также 

можно переключаться между Hybrid и Conservative на вкладке Color для каждого 

графика. Созданные пользователем переменные будут выведены из консервативных 

значений по умолчанию.  

Закладка Variables при активировании создает встроенные по умолчанию 

закладки Derived, Geometric, Solution.  

Закладка Derived содержит производные от параметров решения, и закладку 

Vortex Core с выражениями для вычисления параметров вихревой области на основе 

тензора поля скорости. Закладка Geometric содержит подготовленные процедуры 

для геометрических характеристик расчетной области и ее элементов. Закладка 

Solution содержит основные газодинамичсекие параметры течения с указанием в 

нижней части окна размерности, минимального/максимального значений, 

возможности выбора гибридного/консервативного значений, и возможности замены 

параметра на пользовательское выражение. Параметры могут использоваться при 

обработке получепнного решения. 

Закладка Variables содержит информацию обо всех доступных переменных. 

Производные переменные вычисляются CFD-Post (не содержатся в файле 

результатов).  

Возможно создание новых пользовательских переменных, в частности, 

дополнительные переменных, автоматически создаваемых для случаев описания 

полей в элементах турбомашин. 

Новые переменные пользователя создаются ПК мыши > Create ... в верхней 

половине вкладки Variables. Для создания пользовательских переменных можно 

воспользоваться методом Expression, который определяет переменную через 

выражение, которое может быть функцией любой другой переменной. Обычно 

сначала создают выражение на вкладке Expressions. Метод Gradient вычисляет 

градиент любой существующей скалярной переменной, создает новую векторную 

переменную. 
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Закладка Expressions по умолчанию содержит установочные параметры – 

текущее время, временные шаги, базовое давление. В данный раздел можно записать 

  

Закладка Calculators предоставляет выбор калькуляторов: Macro Calculator, 

Mesh Calculator, Function Calculator. Macro Calculator предназначен для 

формирования отчета по проекту и нуждается в предварительной подготовке 

применительно к проекту. По умолчанию даны образцы отчетов. Mesh Calculator 

представляет параметры метрики и статистику, дает информацию о качестве сетки и 

дублирует аналог в ANSYS ICEM CFD. Function Calculator предоставляет 

возможность для вычисления параметров полей в заданной точке, геометрических 

характеристик, а также интегральных характеристик течения – расходов, сил, 

моментов в разных локализациях, заранее созданных пользователем в проекте. 

Опционально показывает эквивалентные выражения для вычисления на языке Perl.  

Калькулятор функций позволяет извлечь инженерные данные из результатов. 

Применяются те же функции, что и при создании выражений. 

Закладка Turbo предназначена для обработки результатов расчета 

газодинамических параметров во вращающихся машинах. Требует указания оси 

вращения и предварительной инициализации геометрических параметров расчетной 

области и подобластей, а именно, указания соответствия служебных слов Hub 

(корень), Shroud (периферия), Blade (лопасть), Inlet (вход), Outlet (выход), Periodic 

(периодичность) и названия элементов области данного проекта. Вообще говоря, 

данной методикой можно обработать достаточно произвольный канал.  

Мода Turbo после успешной инициализации позволяет построить трехмерные 

изображения полей в каналах, а также графики параметров и выражений 

пользователя, осредненные по массе, объему, площади, длине в направлениях: по 

лопастным обводам, в окружном направлении, от входа к выходу, от корня к 

периферии. 

В данной моде предоставлена возможность оценки эффективности насоса, 

гидротурбины, газовой турбины и компрессора путем применения подготовленных 

турбомакросов. Для форматирования и представления результатов могут быть 

созданы таблицы и диаграммы. 
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. 

Закладка Session означает запись/воспроизведение сценариев, по которым 

выполняются определенные группы действий: настройка и сброс рисунков, 

настройка видов и т.д. Сценарии на предварительной сессии и записываются в 

  

Закладка Tools среди команд содержит команду Probe - возможность 

определения локальных значений полей, вызов трех различных калькуляторов, 

редактор команд на языке CCL – CommandEditor. 

Закладка Insert – содержит команды для вставки/определения разнообразных 

объектов: Locations, Vector, Contour, Streamline, Legend, Variable, Expression, 

Table, Chart и др.  

Locations - формирует геометрические объекты – точки, линии, плоскости, 

поверхности, объемы. 

Vector - строит поля векторов скорости и других векторных величин на 

произвольных линиях, линиях тока, на поверхностях и в объемах.  

Contour - предназначен для построения полей заданных параметров на 

выделенных поверхностях. 

Streamline - отрисовывает линии тока в пространствах объемов, либо их 

проекции на выделенную поверхность. 

Legend – содержит набор цифровых обозначений цветов поля параметров. 

Variable, Expression - содержат набор переменных и выражений для 

использования в полях переменных. 

Table – табличный редактор для вычислений значений параметров и 

выражений в точках, линиях, поверхностях и объемах, локализованных 

пользователем. По некоторым функциональным возможностям напоминает MS 

Excel. 

Chart - представление распределений параметров или их комбинаций в виде 

графиков. Требует предварительной подготовки массивов данных посредством 

 на заранее подготовленных локализациях.  
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Рис. 7.9 Команды Меню утилит 
 

CFD-Post может взаимодействовать с несколькими различными файлами 

результатов. Перечислим основные. Файлы результатов CFX *.res / *.mres, ANSYS 

*.rst, FLUENT *.dat. Сеточные файлы  CFX *.def / *.mdef, ANSYS *.cmdb, FLUENT 

*.cas.  

CFD-Post импортирует Polyline *.csv, поверхность пользователя (User Surface) 

*.csv, ANSYS поверхности (ANSYS surface) *.cdb. Экспортирует данные профиля 

*.csv, общие форматированные результаты *.csv, ANSYS load file *.csv,  файлы 

записанного сеанса или сценария (*.cse), файлы графических состояний (*.cst), 

макросы (*.cse) 

Файлы сеанса (сценария) могут использоваться для быстрого воспроизведения 

всех действий, выполненных в предыдущем CFD-Post сеансе. Запись сеанса 

выполняется на командном языке CFX (CCL). Состояние (State) сохраняет 

мгновенный снимок всех объектов. Используется для повторной загрузки всех 

объектов (и их последующей обработки), которые существовали при сохранении 

файла состояния. 
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Файлы состояния не привязаны к определенному файлу решения, однако 

правильно работают, если имена подобластей и доменов согласованы. Файлы 

состояния исключают действия (например, вывод файла). 
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ПРИЛОЖЕНИЕ 1 

 

Общий план построения сетки в простой односвязной области 

(методические указания) 

 

Сеточный генератор ICEM CFD позволяет построить в расчетной области 

варианты тетра-сетки и гекса-сетки. При необходимости область может быть 

разрезана, и сетка строится в частях всей области течения. Последующее соединение 

). 

После вызова сеточного генератора ICEM CFD инициируется имя и 

директория нового проекта латиницей, и импортируется геометрия области в 

формате PARASOLID с расширением *x_t , для которой подтверждаются единицы 

измерения длин (например, миллиметры). Далее вводятся наименования элементов 

области (Parts): inlet, outlet, wall и т.д., а также указывается локализация потока 

(body или fluid) вне области или внутри области. Далее пользователь выбирает 

способ аппроксимации области на основе тетраэдров, либо гексаэдров. 

 

Порядок построения тетра-сетки в односвязной области 

 

1. Задается максимальный размер элемента в Mesh>GlobalMeshSetup 

2. При необходимости задаются максимальные размеры элементов на частях 

области в Mesh>PartMeshSetup 

3. Вычисляется тетра-сетка в Mesh>ComputeMesh 

4. Проверяется качество сетки в EditMesh>Quality 

5. При необходимости производится сглаживание в 

EditMesh>SmoothMeshGlobally 

6. При необходимости производится локальное увеличение плотности сетки в 

Mesh>CreateMeshDensity 

 

 

Порядок построения призматической сетки в пограничном слое односвязной 

области 
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1. Задаются параметры выдавливаемого призматического пограничного слоя 

командой GlobalMeshSetup>PrismMeshingParameters: c установками 

HeightRatio=1; NumberOfLayers=1; рекомендуется PrismHeight LimitFactor=1.5 

2. Указываются части, на которых формируется пограничный слой в 

Mesh>PartMeshSetup 

3. Выдавливается пограничный призматический слой на тетра-сетке в 

Mesh>ComputeMesh 

4. Проверяется качество сетки в EditMesh>Quality 

5. При необходимости производится сглаживание в EditMesh> 

SmoothMeshGlobally 

6. Производится равномерное разбиение пограничного слоя на призматические 

подслои в EditMesh>SplitMesh>SplitPrisms при параметрах: PrismRatio=1; 

рекомендуется NumberOfLayers=10-15 

7. Производится сгущение разбиения пограничного слоя на призматические 

подслои в EditMesh>MoveNodes>RedistributePrismEdge при рекомендованном 

параметре: PrismRatio=1.4-1.5 

8. Выполняется проверка полученной сетки в EditMesh> DisplayMeshQuality, 

EditMesh>CheckMesh, в дереве модели через  Mesh>CutPlane 

 

Порядок построения гекса-сетки в односвязной области с трубчатым 

поперечным сечением и изгибом осевой линии  

 

1. При наличии наименования частей модели и локализации потока обращаемся к 

построению общего блока модели в Blocking>CreateBlock 

2. При наличии изгибов осевой линии разделяем общий блок на части в 

Blocking>SplitBlock, как это демонстрируется в примере. 

3. Удаляем лишние блоки вне тела расчетной области (см. Пример) в DeleteBlock 

4. Сливаем точки на изгибах осевой линии в MergeVertices (см. Пример)  

5.  Разбиваем составные блоки в SplitBlock на части по местам перехода 

прямолинейных участков трубы в криволинейные участки (см. Пример). 

6. Для получаемых четырехугольников выполняем ассоциацию в 

Associate>AssociateToCurve с окружностями стыка участков труб (см. Пример). 
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7. На блоке, расположенном в изгибе трубы, устанавливаем метки на ребрах и 

подтягиваем ребра курсором с помощью операции Blocking>EditEdge (см. Пример) 

8. Инициируем О-блочную структуру во всем уголке с помощью операции 

Blocking>SplitBlock>OgridBlock последовательным выполнением операций 

SelectBlocks, SelectFaces; получаем вложенные подблоки (см. Пример) 

9. Для выравнивания стыков между подблоками применяем операцию 

Blocking>MoveVertex 

10. Изгибаем ребра подблока на изгибах трубы сплайнами с помощью операции 

Blocking>EditEdge>LinkEdge  

11. Задаем максимальный размер сетки в Mesh>GlobalMeshSetup; Генерацию 

сетки начинаем с операции Blocking> PreMeshParams> UpdateSize; построение 

грубой сетки производим в Blocking>PreMesh, затем уточняем, масштабируем, при 

необходимости уменьшаем ядро в Blocking>PreMeshParams>EdgeParams; 

аккуратно выдерживаем пропорции: «минимальный размер ячейки – размер 

области»; при необходимости применяем операцию улучшения интервалов 

 

12. Проверяем качество сетки в Blocking>PreMeshQuality. 

13. При необходимости применяем сглаживание в Blocking>PreMeshSmooth. 

14. Для передачи сетки в солвер CFX выполняем конвертацию сетки в 

неструктурированное представление операцией ПК в дереве модели 

Blocking>PreMesh>ConvertToUnstructMesh. 

 

Подготовка передачи сетки в препроцессор 

В сеточном генераторе ICEM CFD передача сетки для использования в 

обеспечивается операциями Output>SelectSolver и Output>WriteInput . Последняя 

операция формирует и сохраняет на диске в рабочей директории файл с 

расширением *.cfx5  для дальнейшего импорта в CFX-Pre. 

  



137 

 

 

ПРИМЕР ВЫПОЛНЕНИЯ ЗАДАНИЯ 

к расчетной работе 

«Определение течения в канале и потерь полного давления» 

 

Необходимо определить течение и потери полного давления в области, 

представляющей собой трубу постоянного диаметра 20 мм с участком скругления, 

составляющим угол 90град (рис.1). Скорость воды на входе в трубу составляет 1м/с, 

базовое (reference) рабочее давление составляет 1 атм. 

 

  

Рис.1 

 

Здесь показана гекса-сетка, построение которой дано в Приложении 2 к 

настоящему пособию.  

Полученная сетка переводится в неструктурированный формат, 

 

Далее производится запуск ANSYS CFX программой cfx5.exe, которая 

запускает окно CFX Launcher. В CFX Launcher вызывается окно препроцессора 

, в котором последовательно назначаются границы и условия на них, назначается 

рабочее тело, модель турбулентности, точность выхода на установившееся решение 

и управление расчетом (рис.2).; генерируется и сохраняется файл задания с 

расширением *.def.  
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Рис.2 

 

После формирования файла задания вызывается солвер, в котором запускается 

 , и выполняется расчет до получения установившегося решения по заданной 

точности. На рис.3 показан процесс сходимости решения на протяжении 40 итераций 

до выхода всех невязок по остаточным членам уравнений на точность 10е-4 при 

использовании k-eps  модели турбулентности. Также показан график расхода (кг/сек) 

и дисбаланса расходов между входом и выходом канала в процентах. 

Завершающая фаза исследования течения в канале – постпроцессинг, 

 в окне CFX Launcher и вызовом файла результата с расширением *.res . 
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Рис.3 

Прежде всего, проверяем безразмерный параметр пограничного слоя Y+ на 

стенках канала, и в случае его значений выше 2, модель турбулентности перестает 

быть низкорейнольдсовой. При этом Пользователь выбирает приближение 

турбулентности: либо соглашается, либо сетка требует перестройки и измельчения в 

пограничном слое и повторного расчета (рис.4). Замечание. Расчет и продувка каналов 

требуют подготовки потока на входе, особенно в пограничном слое. Обычно это достигается 

организацией предвключенного конфузорного участка, в котором поток разгоняется. В учебном 

примере такого участка нет, и поток принужден на входе  в пограничном слое иметь  скорость 1м/с, 

что приводит к повышенным значениям Y+ вблизи входного сечения и увеличению потерь. 
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Далее выбираем плоскости визуализации параметра течения, например, поля 

скорости, линий тока, поля векторов скорости (рис.5,6,7). Рисунки сохраняем в 

директории для последующего приложения в отчет.  

В калькуляторе FunctionCalculator вычисляем интегральные параметры 

полного давления, статического давления, скорости, плотности в сечениях входа, 

выхода и результаты сводим в EXCEL таблицу. В табл.2 даны наименования 

параметров, их значения, и эквивалентные выражения на языке Perl, использованные 

при вычислении в FunctionCalculator.  Формула вычисления потерь полного 

давления имеет вид 

2( ) (0.5 )total inlet staticoutlet inletP P C     

 

 на стенке трубки;  

входной участок трубы не показан 
 

 

 

Рис.5 Развитие вихря скорости от поворота и точки отрыва вдоль канала  



141 

 

 

 
 

Рис.6 Поле скорости в плоскости симметрии канала и интерфейс пользователя 

 

 
 

Рис.7 Проекции линий тока на плоскость симметрии  



142 

 

 

Таблица 2.  

Значения расчетных гидродинамических параметров течения в канале 

PARAMETER VALUE FUNCTION 

Ptot/inlet 7.091e+02[Pa] massFlowAveAbs(Total Pressure)@inlet 

Pstat/outlet -1.735e-01 [Pa] massFlowAveAbs(Pressure)@outlet 

Velocity/inlet  9.998e-01  

[m s^-1] 

massFlowAveAbs(Velocity)@inlet 

Density/inlet  9.970e+02  

[kg m^-3] 

massFlowAveAbs(Density)@inlet 

DynamicPressure 4.983e+02 [Pa] 0.5*massFlowAveAbs(Density)@inlet* 

massFlowAveAbs(Velocity)@inlet* 

massFlowAveAbs(Velocity)@inlet 

DeltaPinl/out 7.093e+02[Pa] massFlowAveAbs(Total Pressure)@inlet- 

massFlowAveAbs(Pressure)@outlet 

TotalPressureLoss  Dzeta 1.42E+00 (massFlowAveAbs(Total Pressure)@inlet- 

massFlowAveAbs(Pressure)@outlet)/ 

(0.5*massFlowAveAbs(Density)@inlet* 

massFlowAveAbs(Velocity)@inlet* 

massFlowAveAbs(Velocity)@inlet) 

massFlow/inlet 3.130e-01  

[kg s^-1] 

massFlow()@inlet 

 

Расчетная работа выполняется на листах формата А4 и сопровождается 

титульным листом 
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ПРИЛОЖЕНИЕ 2 
 

Пример построения гексагональной сетки в трубе (d=40мм)  

с криволинейной осью 
 

 

Увеличение толщины основных криволинейных обводов 
 

 

Построение основного охватывающего  блока 
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Разбиение основного охватывающего  блока на подблоки 
 

 

Выделение (черным цветом) подблоков для последующего уничтожения 
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Подблоки вырезаны. В области различаем 5 подобластей, с которыми должны 

быть ассоциированы блоки 
 

 

Границы подблоков ассоциируем с окружностями входа и выхода.  

Подблоки разбиваем на части 
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Движением вершин подблоков согласуем подобласти с границами подблоков 
 

 

Совмещаем ребра подблоков с кривыми геометрии подобластей 
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Строим блоки О-сетки: 1)Выделяем блоки; 2)Выделяем грани; 3)Применяем 

выбор 
 

 

Связываем ребра подблоков с ребрами О-блоков (голубые линии) 
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Выравниваем грани блоков О-сетки движением вершин 
 

 

Визуализируем  блоки О-сетки 
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Строим О-сетку, используя построенную блоковую структуру. 

Задаем максимальный элемент, применяем данные к построению, разбиваем 

ребра О-сетки по следующему алгоритму: 

- задаем число узлов; 

- задаем первую ячейку ребра; 

- задаем параметр сгущения; 

- задаем последнюю ячейку ребра; 

- задаем параметр сгущения ~1.3; 

- копируем параметры на аналогичные ребра 

- проверяем качество сетки 

Далее необходимо проверить качество сетки, деструктурировать сетку, 

выбрать солвер, сформировать формат сеточного файла (*.cfx5), и передать в 

препроцессор CFX. После формирования задания на расчет файл с расширением 

*.def передается в солвер, выполняется расчет, и далее выполняется обработка 

результата. 
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ПРИЛОЖЕНИЕ 3. 

Краткое описание рабочей среды ANSYS Workbench ([24]) 
 

1. Общая структура среды ANSYS Workbench 

 

Расчеты в рамках ANSYS могут проводиться как пакетном (Batch) так и в 

интерактивном (Interactive) режимах. Интерактивный режим осуществляется либо с 

помощью графического интерфейса пользователя с непосредственным применением 

модулей ANSYS, либо на платформе Workbench. 

Изначально платформа ANSYS Workbench, как и весь ANSYS, была создана 

для расчетов задач структурного анализа и постепенно расширялась с подключением 

модулей для решения задач динамики жидкостей газов, плазмы и т.п. Поэтому в 

ANSYS присутствует модуль Design Modeler для твердотельного моделирования, 

модуль сеточного построителя со специфическим интерфейсом, другие особенности. 

Впоследствии компания ANSYS приобретала программные продукты, такие как 

мощный сеточный генератор ICEM CFD, мощные CFD солверы различного 

назначения CFX, FLUENT и др. с отличающимся интерфейсом, которые постепенно 

становились стандартом отрасли.  

Программная платформа ANSYS Workbench (верстак) позволяет в единой 

информационной среде интегрировать различные модули программного комплекса 

для проведения связанного многодисциплинарного анализа.  

С применением Workbench возможно, например, произвести 

гидродинамический расчёт теплообменника с учетом теплообмена с окружающей 

средой, колес гидротрансформатора с передачей полей давления на поверхности 

лопаток в модуль структурного анализа для расчета напряжений и деформаций и т.п.  

Подобные операции возможно выполнять вручную, вызывая модули 

поочередно, однако в рамках ANSYS Workbench схема таких расчетов 

автоматизирована. Ниже кратко рассматриваются основные элементы программной 

платформы ANSYS Workbench. 

Основой ANSYS Workbench является проект, составленный из набора 

геометрических, физических и конечно-элементных моделей тел рассматриваемой 

задачи. 

Проект допускает использование одного или нескольких блоков, которые 

реализуют отдельные виды инженерного анализа. Основные этапы проведения 

инженерного анализа состоят в следующем. 

1. Препроцессинг, который включает создание геометрической модели, 

задание свойств материала, определение нагрузок, связей.  

2. Настройки солвера и задание параметров, обеспечивающих сходимость 

итерационного процесса, запуск солвера. Результатом является численное решение, 

полученное с заданной точностью; 
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3. Постпроцессинг, включающий обработку результатов и создание отчета. 

При этом выполняется визуализации полей необходимых физических величин 

(напряжений, деформаций, температур и др.), вывод графиков, анимаций, массивов 

значений. 
 

2. Графический интерфейс Workbench 
 

Запуск ANSYS Workbench выполняется через стартовое меню Window, либо 

через стартовое меню Ansys Launcher. После загрузки выводится основное окно 

программы, состоящее из нескольких окон, имена которых даются в заголовках 

(рис.1). Ниже приводится перечень окон. 

Окно Project Schematic - центральное окно проекта, содержащее структурные 

блоки и связи между ними для наглядного представления частей проекта и 

управления связями между отдельными блоками. 

 
Рис. 1. Окно платформы Workbench 

 

Окно Toolbox - окно инструментов проекта для проведения 

мультидисциплинарного анализа. Окно инструментов содержит несколько разделов, 

представленных в виде раскрывающихся списков: 

Analysis Systems - содержит все виды инженерного анализа, выполняемые в 

ANSYS. 

Component Systems - содержит отдельные компоненты инженерного анализа: 

геометрическая модель, конечно-элементная сетка и др. 

Custom Systems - содержит шаблоны для связанных инженерных расчетов. 
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Design Exploration - содержит инструменты для оптимизации моделей в 

зависимости от набора геометрических или физических параметров и построения их 

корреляционных матриц. 

Окно Properties отображает свойства выбранного в Project Schematic объекта 

в виде таблицы, в первом столбце которой записано наименование параметра, а во 

втором дано его значение, либо стоит флажок активации свойства. 

Окно Messages, расположенное в нижней части экрана, предназначено для 

отображения служебных сообщений, или предупреждений об ошибках. 

Окно Progress отображает процесс выполнения текущих операций. 

В верхней части основного окна расположены кнопки для стандартных 

операций с проектом (рис. 2.). 

 
Рис. 2. Кнопки стандартных операций по проекту 

 

Кроме операций создания, открытия и сохранения есть возможность импорта 

проекта из других CAD/CAE-систем. Команда Refresh Project обновляет входные 

данные проекта, Update Project считывает обновленные входные данные и повторно 

выполняет расчет проекта для получения новых результатов. 

Исходные настройки Workbench можно изменить в меню Tools/Options. 

Возврат к исходным настройкам выполняет команда Restore Defaults в нижней 

части окна настроек. 

Меню Units задает систему единиц измерений для всех расчетов в проекте. 

Текущая система единиц отмечена слева галочкой и в любой момент может 

быть изменена. Справка ANSYS Workbench вызывается в меню Help и содержит 

сведения по работе с программой и ее командами. 

В дереве проекта организованы все этапы расчета: геометрическая модель, 

материалы, сетка, нагружения, связи результаты расчета (Рис. 3) 

Здесь Geometry – геометрическая модель; Contact – контактные условия 

(связи); Mesh – сетка; Environment – нагружения; Solution – расчетные результаты; 

Engineering Data – свойства материалов и граничные условия.  
 

3. Основы работы в среде Workbench 
 

Для создания проекта применяем команду New на верхней панели. Из окна 

Toolbox, в разделе Component Systems выделяем позицию Mesh, и при нажатой ЛК 
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переносим Mesh в окно схемы проекта, как показано на рис. 4, и выбираем для него 

имя.  

Далее из окна Toolbox, в разделе Analysis Systems выделяем Fluid flow (CFX) 

и аналогично переносим в окно проекта.  
 

 

 
а) 

 
б) 

 

Рис. 3 Дерево проекта Рис. 4. а) создание нового проекта. 

б) создание связи между компонентами 
 

Компонент Mesh содержит два пункта Geometry и Mesh; Fluid Flow (CFX) 

содержит пункты: Geometry, Mesh, Setup (набор данных), Solution  и Results 

(анализ результатов). Для установления связи необходимо соединить компоненты 

Mesh1 и Fluid Flow (CFX) так, чтобы сетка, созданная в компоненте Mesh1, 

использовалась в компоненте Fluid Flow (CFX). Это выполняется с помощью 

нажатой ЛК переносом пункта Mesh из компонента Mesh1 в Setup для компонента 

Fluid Flow (CFX). Сохраняется проект командой Save на верхней панели.  

Решение задачи о течении сплошной среды требует выполнения следующих 

шагов: 1) трансляция геометрической модели из CAD системы, либо ее создание 

средствами Design Modeler либо ICEM CFD; 2) определение свойств среды; 3) 

построение сетки; 4) задание граничных и начальных условий; 5) выбор модели 

турбулентности; 6) определение параметров солвера; 7) выполнение расчета; 8) 

обработка расчетных результатов и составление отчета. 

Решение задачи структурного анализа подразумевает следующие шаги: 1) 

трансляция геометрической модели из CAD системы, либо ее создание средствами 
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Design Modeler; 2) определение свойств материалов конструкции; 3) построение 

сетки; 4) закрепление модели; 5) приложение нагрузок на модель; 6) определение 

параметров солвера; 7) задание списка расчетных результатов и выполнение расчета; 

8) обработка расчетных результатов и составление отчета. 

 

3.1. Знакомство с ANSYS Design Modeler 

 

В качестве основного CAD в пакете ANSYS выступает редактор ANSYS 

Design Modeler. Запуск Design Modeler, выполняется двойным щёлчком ЛК по 

закладке Geometry в компоненте Mesh1. При запуске выбираются единицы 

измерения длины. Структура основного окна Design Modeler дана на рис. 5.  

 
Рис. 5  Структура окна ANSYS Design Modeler 
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Область 1 представляет собой дерево построения с последовательным 

отображением всех выполненных операций с моделью. Область 2 – область 

построения с видом модели. Область 3 содержит панель инструментов. Область 4 

содержит основные свойства компонентов из дерева построения.  

Панель инструментов по умолчанию состоит из следующих блоков (рис.6).  
 

 
 

Рис. 6 Содержание панели инструментов ANSYS Design Modeler 
 

Блок 1 содержит кнопки: - Start over– очищает рабочее пространство для начала 

построения модели; - Save Project - сохранение проекта; - Export - экспорт 

геометрии в различных форматах; - Image capture – снимок области построения и 

сохранение его в графическом формате.  

Блок 2 содержит стандартные команды Undo, Redo (отмена, повтор).  

Блок 3 содержит различные фильтры выделения, позволяющие установить тип 

элемента (точки, ребра, поверхности, тела), который необходимо выделить с 

помощью курсора в области построения.  

Блок 4 содержит команды в области построения - вращение, панорамирование, 

масштабирование и т.д.  

Блок 5 содержит команды управления видом линий модели в области построения.  

Блок 6 обеспечивает выбор текущей плоскости; - создание новой плоскости; - выбор 

текущего эскиза; - создание нового эскиза.  

Блок 7 содержит кнопку Generate – ключевую кнопку ANSYS Workbench, которая 

запускает команду исполнения после задания всех параметров геометрии; кнопка 

Share topology строит сетки в сборках, если модель содержит несколько тел.  

Блок 8 содержит стандартные для CAD программ команды построения модели: - 

Extrude – вытягивание; - Revolve – вращение; - Sweep – протягивание вдоль кривой; 

- Skin/Loft – построение тела по сечениям; - Thin/Surface - создание поверхности 

или тонкостенной оболочки; - Blend – скругление; - Chamfer – фаска; - Point – 

создание точки; - Parameters – задание параметрических размеров с помощью 

командной строки.  

Дополнительные инструменты для построения модели находятся в разделах 

Create, Concept, Tools. 
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Этим заканчивается краткое знакомство с интерфейсом ANSYS Design 

Modeler. Следует отметить, что изложение материала в данном пособии 

предполагает, что читатель знаком с общими принципами трёхмерного 

моделирования и поэтому подробно эти вопросы не рассматриваются. Кроме того, 

специализированные программные продукты, например, Solid Works, Unigraphics 

(NX) выполняют трехмерное моделирование более удобным образом, и построенные 

модели можно передать в ANSYS Workbench, например, в формате Parasolid. 

 

3.2. Построение сеток в ANSYS Meshing 

 

Ниже рассматриваются общие принципы работы с модулем ANSYS Meshing 

для автоматической генерации неструктурированных сеток с минимальным 

участием пользователя. 

ANSYS Meshing запускается в среде Workbench через раздел Mesh.  

 

 
Рис 7 Общее представление окна ANSYS Meshing 

 

Рассмотрим структуру рабочей среды ANSYS Meshing (рис 7).  

Область 1 представляет собой дерево построения, где по разделам 

отображаются операции, связанные с построением сетки.  
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Область 2 – область построения, где изображается импортированная из Design 

Modeler геометрия и построенная на её основе сетка. Область 3 содержит панель 

инструментов. 

Область 4 отображает основные свойства компонентов дерева построения. 

Область 5 служит для отображения предупреждений и системных сообщений. 

Панель инструментов (рис. 8) по умолчанию состоит из 5 основных блоков. 

Блок 1 содержит стандартное меню, в котором можно найти команды сохранения 

файлов, экспорта сетки, импорта геометрии и т.п. 

Блок 2 содержит следующий набор команд. Команда Generate Mesh - 

генерирует сетку после задания всех необходимых параметров; New Section Plane–

создает секущую плоскость для визуализации элементов в объёме сетки; Graphics 

annotation – создает надписи на теле модели; New comment - создает текстовую 

заметку; New figure or image – создает картинку; Worksheet – специфицирует 

применяемые к модели настройки, проверяет статус настроек. 

 

 
1                                                 2 

 
3 

 
4 

 
5 

Рис. 8 Структура панели инструментов ANSYS Meshing 

 

Блок 3 содержит различные фильтры выделения. Команды блока позволяют 

установить тип элементов (точки, ребра, поверхности, тела), для выделения 

курсором в области построения. В блоке содержатся команды для манипулирования 

изображением (вращение, панорамирование, масштабирование и т.п.).  

Блок 4 содержит команды по управлению видом линий и точек модели. 

Блок 5 содержит группы команд по управлению параметрами построения сетки. 

В блок входят: Update - команда, фиксирующая новые настройки в сеточной 

модели. Все изменения в модель вносятся только после нажатия кнопок Generate 

Mesh и Updatе. По команде Generate Mesh сетка строится заново, с помощью 

команды Update вносятся изменения в существующую сетку без полного её 

перестроения. 

Группа команд Mesh включает команду Preview Surface Mesh, которая 

выполняет предварительный просмотр поверхностной сетки; при построении сетки 

методом вытягивания команда Preview Source and Target Mesh, выполняет 

предварительный просмотр сетки поверхностей источника и цели. 
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Группа команд Mesh control включает команды управления процессом 

построения сетки. Сюда входят следующие команды.  

Method - выбор метода построения сетки. Опционально предлагается 

автоматический метод – Automatic; тетрасетка – Tetrahedrons; сетка с 

преобладанием гексаэдрический элементов – HexDominant; построение сетки 

методом вытягивания – Sweep; построение мультизонной сетки - Multizone, (тип 

сетки изменяется для разных зон области); обеспечивается установка размеров 

элементов для различных областей – Sizing. Сюда относятся 1) установка размера 

элемента в области контакта двух деталей; измельчение сетки в указанных областях 

Refinement; построение поверхностной структурированной сетки - Mapped face 

meshing; контроль совпадения расположения узлов периодичности на границах - 

Match control; полуавтоматическое устранение мелких деталей геометрии – Pinch; 

создание сетки для пограничного слоя в жидкости - Inflation. 

В целом, методы и команды в модуле ANSYS Meshing напоминают аналоги от 

ICEM CFD и подробно описаны в предыдущих разделах. Кроме того, при 

выполнении связанных расчетов, например, гидравлических расчетов, в таблицу 

проекта может быть приглашен модуль ICEM CFD, построение сетки в котором 

более удобно. 

Окно основных свойств модели Options содержит следующие разделы: 

физический тип задачи Physics Рreference, в зависимости от которого будут 

установлены особые настройки построения сетки - вычислительная гидродинамика 

CFD; явный расчёт механических задач Explicit, включая физику удара и взрыва; 

расчёт прочности Mechanical; расчёт электромагнетизма Electromagnetic. 

 

3.3. Управление выбором материалов и их свойств 

 
Важной составляющей работы с моделью является выбор материала для 

созданных тел и описание их свойств. Для этих целей в Workbench существует 

модуль управления материалами, представленный вкладкой Engineering Data. 

Модуль управления материалами может быть использован как хранилище 

библиотечных свойств. Изменить материал  или его свойства можно на любом этапе 

моделирования. 

Панель свойств Properties Pane - отображает свойства избранного элемента на 

панели структуры данных Outline Pane; панель таблиц Table Pane отображает 

табличные данные элемента на панели Properties Pane; панель диаграмм Chart Pane 

- отображает диаграмму свойства элемента. На панели инструментов существует 

кнопка фильтрации, отображающая строки, которые могут быть использованы для 

текущего выбора. По умолчанию эта кнопка активирована. 

Окно свойств Toolbox содержит команды управления свойствами и 

физическими моделями материалов. При нажатой кнопке, модуль управления 
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материалами фильтрует содержимое окна таким образом, что видны лишь элементы, 

которые применимы для текущего выбора. 

Панель диаграмм Chart Раnе отображает диаграмму избранного в панели 

свойств элемента. Шкалы осей диаграммы можно изменить, щелкнув по выбранной 

оси правой кнопкой мыши, выбрав из контекстного меню пункт Edit Properties и 

проставив нужные значения в появившейся панели Properties of Chart.  

Материалы из текущего набора или библиотеки отображаются в панели 

структуры данных Outline Раnе. В этой панели можно выполнять следующие 

действия: 1) создать новый материал; 2) удалить материал; 3) переименовать 

материал; 4) исключить материал из текущего набора Suppress; 5) добавить 

описание материала; 6) добавить материал в систему с внешнего источника данных; 

7) выбрать материал по умолчанию для твердых и/или жидких частей модели. 

Содержание библиотеки показывает имя материала, содержащегося в 

выбранном источнике данных. Тип и состояние материала показывается 

пиктограммой слева от имени и характеризуется следующими параметрами: 1) 

допустимые данные в этом материале; 2) некорректно определенные данные. 

Исключение материала Suppression отмечается знаком и показывает статус 

элемента. В новом проекте материалом по умолчанию для твердых частей модели 

является конструкционная сталь (Structural Steel), а для жидких - воздух (Air). 

Также можно запретить использовать материал по умолчанию, убрав 

соответствующую отметку в контекстном меню. Установка материала, 

используемого по умолчанию для модели или запрет такой установки, 

распространяется на все блоки анализа, созданные в проекте. Свойства материалов 

могут задаваться физическими константами либо набором табличных данных. Для 

новых материалов набор свойств определяется самостоятельно при переносе их из 

окна Toolbox в панель свойств Properties. Изменение свойств созданных материалов 

возможно, если источник данных находится в режиме редактирования. 

Модификация констант производится путем изменения значений Value и/или 

единиц измерения этих данных Unit в панели свойств Properties Рапе. При переходе 

к новой единице измерения текущее значение автоматически преобразуется. При 

вводе недопустимого значения поле окрашивается желтым цветом. Если данные, 

характеризующие свойство материала, представлены в табличной форме, то это 

появляется в столбце значений Tabular.  

 

3.4. Задание внешних воздействий 

 

Задание внешних воздействий (механических, тепловых и т.д.) на 

конструкцию является важным этапом подготовки к проведению расчета и 

получения результатов. Обычно внешние воздействия определяются на границах 

созданной модели и означают различного рода ограничения и нагрузки на 

поверхностях тела, и в отдельных точках внутри тела. В частности, это могут быть 
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закрепления, то есть ограничения перемещений и поворотов в структурном анализе, 

или задания температуры при решении задач теплообмена, граничные условия на 

входе/выходе канала в CFD задачах. В качестве нагрузок - добавление 

сосредоточенных или распределенных сил или тепловых потоков.  

Задание нагрузок и добавления ограничений выполняется в Workbench в 

модуле симуляции, либо в подключенных препроцессорных модулях моделирования 

течений. Основное окно модуля симуляции включает следующие элементы: главное 

меню и панели инструментов, содержащие все команды для задания нагрузок и 

ограничений.  

В частности, дерево проекта Outline в панели инструментов состоит из 

последовательности команд задания нагрузок и ограничений; окно детализации 

(Details of ...). содержит различные настройки и параметры команд задания нагрузок 

и ограничений. При выделении того или иного элемента в дереве проекта заголовок 

окна детализации изменяется. Например, при выделении группы Mesh окно 

детализации получает название Details оf Mesh); графическое окно Geometry 

отражает нагрузки и ограничения, приложенные к модели; Graph - окно 

графического отображения нагрузок по шагам отображает график изменения 

величины нагрузки при задании количества шагов нагрузки. 

Графическое окно модуля симуляции в процессе расчета отражает 

информацию о характере нагрузок, их величине, в том числе и по компонентам по 

осям координат, направления действия, единицах измерения величины, точки их 

приложения или области действия. Направление нагрузок показывается цветными 

стрелками со специальными обозначениями. Буква латинского алфавита в значке 

позволяет определить по тексту в левом верхнем углу графического окна, нагрузку 

или ограничение, обозначенное стрелкой. При этом цветом выделяются 

поверхности, к которым приложены различные нагрузки. 

Отображения текстовой информации по заданным нагрузкам и ограничениях 

может быть отключено. Для этого в окне детализации соответствующей нагрузки 

выбирается раздел Definition и в пункте Suppressed включается настройка Yes. 

  

3.5. Типы нагрузок и особенности их задания 

  

Выбор типа нагрузок в расчетном модуле происходит в панели Environment, 

расположенной в верхней части экрана. Эта панель становится доступной при 

выделении раздела Static Structural в дереве проекта. В меню Environment 

возможен выбор следующих типов нагрузок, соответствующих конструкционному 

анализу: 

• Inertial - инерционные нагрузки, действующие на всю конструкцию; 

• Loads - конструкционные нагрузки - силы и моменты, действуют на части 

конструкции; 
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• Supports - закрепление, то есть ограничение степеней свободы, исключающее 

движение объектов; 

• Condition - условия, при которых будет выполнено решение; 

• Direct FE - условия приложения нагрузок. 

При выборе любого типа в меню панели Environment заданная нагрузка будет 

добавлена в дерево проекта в раздел Static Structural. Направление нагрузок и 

ограничений может совпадать с направлением осей глобальной системы координат 

Global Coordinate System. Для корректировки направлений нагрузок и ограничений 

в дереве проекта необходимо выбрать опцию Coordinate System. По умолчанию 

предлагается глобальная координатная система. 

Практически при всех нагрузках появляется параметр Geometry, который 

указывает на объект приложения: точку, ребро, грань, тело. Для задания этого 

параметра нужно выделить необходимый объект и, кликнув на его поле в окне 

детализации, подтвердить свой выбор нажатием кнопки Apply. Для большинства 

типов нагрузок значение может задаваться тремя способами: в виде фиксированного 

значения Constant; в табличной форме Tabular; функциональной зависимостью 

Function. 

Выбор способа задания нагрузки осуществляется кликом мыши на стрелке в 

правой части окна ввода численного значения и выбором варианта. В этом же 

выпадающем меню присутствуют команды Import... и Export..., позволяющие 

импортировать значения из файла и обратно. 

При выборе способа задания нагрузки в виде таблицы в параметре Magnitude 

появляется опция Tabular Data. Значения нагрузок могут меняться на каждом шагу 

численного решения. Количество шагов задается параметром Number of Steps 

элемента Analysis Settings, содержащего настройки текущего анализа. Заданное 

число шагов формирует количество строк в таблице значений в окне Tabular Data, 

расположенном в правом нижнем углу экрана. 

Таблица состоит из нескольких колонок: 1) порядковый номер строки; 2)номер 

шага; 3)время на этапе; 4) численное значение величины. По мере заполнения 

численными значениями строк таблицы в окне Graph формируется график 

изменения величины нагрузки по шагам. Пошаговое добавление нагрузки позволяет 

постепенно увеличивать ее величину и благоприятствует сходимости решения. 

Инерционные нагрузки, которые задаются в конструкционном анализе 

Workbench, делятся на три типа: 1) Acceleration - ускорение; 2) Standard Earth 

Gravity - гравитация; 3) Rotational Velocity - скорость вращения. Для постановки 

нагрузок этого типа должна быть задана плотность материала модели для 

вычисления массы. При этом возможно задание нагрузки, действующей на точечную 

массу.  

Ускорение Acceleration прикладывается ко всей модели и задается  опцией 

Define By как вектор Vector. В этом случае нужно задать модуль вектора (параметр 

Magnitude) и его направление (параметр Direction). Направление действия вектора 
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определяется стрелками в левом нижнем углу графического окна. Возможно задание 

с помощью компонент (Components) по осям координат. Компоненты вектора 

ускорения могут быть заданы относительно глобальной Global Coordinate System 

или системы координат пользователя (параметр Coordinate System). После задания 

ускорения его величина и направление в виде стрелки желтого цвета отображаются в 

графическом окне. 

 

3.6. Конструкционные нагрузки 
  

Конструкционные нагрузки в Workbench задаются в разделе Loads панели 

инструментов Environment в следующем виде: 

• Pressure - давление; 

• Pipe Pressure - давление в напорном трубопроводе; 

• Hydrostatic Pressure - гидростатическое давление; 

• Force - сила; 

• Remote Force - дистанционное нагрузки; 

• Bearing Load - давление на опоры; 

• Bolt Pretension - натяжение; 

• Moment - момент; 

• Generalized Plane Strain - обобщенная плоская деформация; 

• Line Pressure - давление на линии; 

• Thermal Condition - тепловые нагрузки; 

• Pipe Temperature - температура в трубопроводе; 

• Joint Load - нагрузка в сообщениях; 

• Fluid Solid Interface - взаимодействие жидкостей (газов) и твердых тел; 

• Detonation Point - точка генерации взрывных волн. 

Команда Pressure позволяет задавать давление на поверхности тела. При этом 

в дереве проекта появляется соответствующий пункт; параметры 

задаются в окне детализации, выполняется выбор поверхности, на которую 

действует давление (параметр Geometry), задается величина давления (параметр 

Magnitude) и направление для приложенного давления (опция Define By). 

Направление действия давления задается вектором Define Ву/Vector. 

Положительное значение параметра Magnitude рассматривается как давление на 

поверхность, отрицательное - от поверхности. Приложенное давление отображается 

в графическом окне с указанием его величины и размерности, а поверхность 

приложения давления подсвечивается красным цветом. Величина давления задается 

фиксированной величиной - Constant, или пошагово в табличной форме - Tabular, 

или функциональной зависимостью - Function. Гидростатическое давление задается 

с помощью команды Hydrostatic Pressure. Обязательным параметром для 

определения гидростатического давления является плотность жидкости (параметр 

Fluid Density).  
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Команда Force задает силу. Параметры силы задаются в окне детализации. 

Сила может быть приложена к точке, ребру или поверхности. Объект приложения 

силы задается в параметре Geometry. Сила может быть определена вектором Define 

By/Vector или компонентами в глобальной системе. Величина силы может быть 

задана как константа, а также в виде таблицы или функции. 

Приложенная сила распределяется на все выделенные объекты. Если сила 

приложена к двум одинаковым поверхностям, то на каждую будет действовать 

половина заданной величины. При увеличении площади поверхности приложенная 

сила остается постоянной, но давление уменьшается. 

Команда Bolt Pretension позволяет моделировать нагрузку предварительного 

натяга и прикладывается к цилиндрической поверхности или к телу. Такую нагрузку 

можно использовать только в трехмерных моделях. Для тел следует выбирать 

локальную систему координат с осью OZ, направленной вдоль предварительного 

натяжения.  

Предварительный натяг задается в Workbench двумя способами: как сила 

натяжения, либо как установочный размер (длина) в начальных условиях. Выбор 

способа задания осуществляется в окне детализации (опция Define By). Задается 

момент силы командой Moment, который может быть приложен к точке, к ребру или 

к поверхности; параметры момента силы устанавливаются в окне детализации 

Details Of Moment. Параметр Geometry задает объект приложения момента силы. 

Задавать момент можно вектором Define By/Vector или отдельными компонентами 

вектора по осям заданной системы координат Define By/Components. Направление 

вращательного действия момента силы определяется относительно своего вектора по 

правилу правой резьбы. Величина момента задается параметром Magnitude и может 

быть константой либо функцией, определяемой аналитическим выражением или 

таблично. 

Команда Thermal Condition позволяет задавать температуру на границах 

модели. Если используется двумерная модель, то при указании в параметре 

Geometry одной стороны модели, температура будет задана и для другой стороны. 

Для трехмерных тел температура задается по всей поверхности тела. Величина 

температуры задается параметром Magnitude и по умолчанию равна 22°С. 

 

3.7. Граничные условия (ограничения) 

 

Задание граничных условий, как ограничений перемещения, является 

необходимым условием структурного анализа закрепленного тела. Число граничных 

условий должно быть достаточным для расчета распределений всех искомых 

величин. 

Граничные условия в Workbench задаются в разделе Supports панели 

инструментов Environment. Существуют следующие типы граничных условий: 

• Fixed Support - жесткое закрепление; 



164 

 

• Displacement - перемещение; 

• Remote Displacement - перемещение с поворотом; 

• Velocity - скорость; 

• Impedance Boundary - предельное сопротивление; 

• Frictionless Support - закрепление без трения; 

• Compression Only Support - закрепление сжатием; 

• Cylindrical Support - цилиндрическое закрепления; 

• Simply Supported - простое закрепление; 

• Fixed Rotation - запрет поворотов; 

• Elastic Support - упругое закрепление; 

• Coupling - связывание; 

• Constraint Equation - ограничение, определяемое уравнением. 

Жесткое закрепление Fixed Support исключает все линейные и вращательные 

перемещения выбранных вершин, ребер, поверхностей. Чтобы задать жесткое 

закрепление, необходимо вставить команду Fixed Support в дерево проекта, затем 

выбрать необходимые объекты и в окне Details Of Fixed Support подтвердить выбор 

нажатием Apply в поле параметра Geometry. Жесткое закрепление отображается 

выделением синим цветом закрепленной поверхности, ребра или точки 

Перемещение выбранных вершин, ребер, поверхностей или объемов задается 

командой Displacement. Необходимые геометрические объекты указываются в 

параметре Geometry. Перемещение задается двумя способами (опция Define By): 1) 

компонентами Components относительно глобальной системы координат или 

локальной системы координат; 2) по нормали Normal к выбранной поверхности. 

Знак «минус» для перемещения соответствует отрицательному направлению 

выбранной оси. Значение «0» для компоненты перемещения означает закрепление 

объекта в этом направлении. Незаданное значение компоненты означает свободное 

движение объекта в этом направлении. 

Команда Frictionless Support позволяет задавать закрепление без трения и 

запрещает перемещение по нормали к поверхности. Такое граничное условие может 

быть задано только на поверхности.  

Команда Fixed Rotation аналогична предыдущей команде и применяется для 

запрета поворотов поверхностей, ребер и вершин плоских или одномерных моделей. 

При использовании команды Fixed Rotation на выделенных геометрических 

объектах запрещается поворот вокруг осей, но разрешается перемещение вдоль них. 

Для указания геометрического объекта необходимо выбрать нужно ребро или 

вершину и подтвердить выбор, нажав Apply в поле параметра Geometry. Запрет 

поворотов может быть установлен по одной или нескольким осям координатной 

системы.  
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3.8. Параметры и опции солвера 
  

Параметры и опции решателя устанавливаются в разделе дерева проекта. Все 

они разделены на группы, количество и состав которых зависит от типа текущего 

инженерного анализа. для прочностного анализа Static Structural настройки решателя 

представлены в следующем перечне: 

1. Step Controls - управление шагами численного решения; тут Number Of Steps - 

количество шагов решения; Current Step Number - номер текущего шага; Step End 

Time - время конца текущего шага; Auto Time Stepping - регулирование пошагового 

времени. 

2. Solver Controls - управление солвером; тут Solver Type - определение типа 

солвера; Weak Springs - добавление пружин малой жесткости 

 

3.9. Файловая структура проекта 

 

В заключение кратко комментируется файловая структура проекта в 

Workbench. Основной файл проекта имеет расширение *wbpj и сохраняет только 

ссылки на модельные файлы и связи между ними. Вместе с основным файлом 

проекта на диске создается одноименная папка. Служебные файлы проекта 

размещаются папке dp0. При решении задач оптимизации, когда необходимо 

варьировать параметры модели, на каждый вариант расчета автоматически создается 

папка dpi, где i - порядковый номер варианта. 

Модельные файлы проекта имеют следующие расширения: 

• файлы геометрической модели *agdb и КЭ-сетки *mechdb; 

• файл результатов решения задачи file.rst; file.res; 

• командный файл ANSYS, автоматически генерируемый Workbench - ds.dat; 

• файл с сообщениями об ошибках file.err; 

• файл с исходной информацией решателя solve.out. 

Входные файлы пользователя, файлы с графиками, диаграммами, 

полученными по результатам численного решения, хранятся в подкаталоге 

user_files. 
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